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Getting Started  About this Manual 

About this Manual 
The Enspire Getting Started manual is designed to introduce you to frequently used features, 
techniques, and procedures. Becoming familiar with the information in this manual will give you 
the skills and knowledge necessary to perform more detailed tasks throughout the Enspire 
software system. 

This manual assumes that you have installed Enspire and that you are familiar with the Microsoft 
Windows operating environment. 

What Is Enspire? 
Enspire is a sophisticated software system designed to increase distributor productivity and 
profitability. Enspire takes advantage of the power of Microsoft Windows 2000 Server and 
Microsoft SQL Server using Windows 2000 Professional or Windows XP Professional clients. 
Only Enspire offers the unique combination of sophisticated, industry-specific software 
functionality and proven computer network technology. 

Enspire Documentation 
The documentation that comes with Enspire includes this Getting Started manual as well as an 
installation guide and online help. 

• Installation Guide – The Enspire Installation Guide covers the requirements for 
preparing your data for the conversion to Enspire. It also provides a complete road map to 
setting up Enspire properly. 

• Online Help – The online help provides detailed instructions on performing Enspire 
procedures as well as a definition of each field in Enspire. 

Starting Enspire 
Installing Enspire placed a shortcut icon on your desktop. To start Enspire, double click this icon. 

 

You can also start Enspire from the Microsoft Windows taskbar. 

1. Click the Start button on the Windows taskbar. 

2. Position the mouse pointer over Programs. 

3. Position the mouse pointer over Dimasys. 

4. Click Enspire. 

Logging On to Enspire 
NOTE Until you set up a user in Enspire, you can log on only as the Enspire 

administrator. For instructions on setting up a user, see Setting Up an 
Enspire User later in this chapter. 
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After you start Enspire, the User Authentication dialog appears. Here, you can log on using 
Microsoft Windows NT domain authentication or you can provide a user ID and password. 

1. If you are logging on using domain authentication, select NT Domain Authentication. 
This option automatically uses your Windows NT user ID and password. Therefore, you 
need to have a network user ID and password. 

2. If you are not using domain authentication, type a User ID and Password. 

3. Enspire System Server and Enspire Company Database display the default options 
assigned to the user. 

4. In most cases, you will have only one Enspire system server. However, if you have more 
than one Enspire system server and you need to change it, you must have the proper 
security. To select a different server, click the globe icon ( ) then select the name of the 
new system server. 

5. If you need to change the Enspire Company Database, make your selection from the 
grid. When you select a company, all the transactions processed are for that company 
only. 

 

On the Login screen the Company list defaults to showing companies sorted by 
ascending alphabetic order using the company field.  You can resort by any shown field.  

6. Click OK to log on to Enspire. 

Setting Up an Enspire User 
Setting up Enspire users determines the level of access each user has to Enspire. Setting up a user 
involves the procedures listed below. 

You perform these procedures in the Enspire Security dialog (Administration>System 
Control>Security). To access this dialog, you must log on as the Enspire administrator. 

• assigning your Microsoft NT network users to Enspire 

• assigning Enspire users to a company 

• creating Enspire roles 

• assigning Enspire roles to a company 

• assigning commands to company roles 

• assigning users to company roles 

• assigning events to company roles 

Version 7.3.2.0 Getting Started  1-3 



Getting Started  Setting Up an Enspire User 

Assigning Microsoft NT Network Users to Enspire 
The NT Users displayed in the Enspire Security dialog are generated from the network domain of 
the company network during the installation process.  This procedure allows you to identify which 
of those users will be allowed access to Enspire.  To grant NT Users access to Enspire: 

1. In the Enspire Security dialog, click the Enspire Users tab. 

 

2. In the NT Users grid, click and hold the mouse button down on the NT Account of the 
user you want to add as an Enspire user. 

3. Drag the NT Account to the Enspire Users grid. 

4. Release the mouse button. 

To remove a user assigned to Enspire, drag the user from the Enspire Users grid back to 
the NT Users grid. 

5. Complete the Enspire User Properties as follows: 

First Name is the user’s first name. 

Last Name is the user’s last name. 

Comment allows you to provide additional information about the user. 

Language Code is the language assigned to the user. 

Password is the user’s password to log on to the Windows NT network. 

NT Security ID displays the user’s security ID on the NT network. 

6. Continue to the next procedure, which is Assigning Enspire Users to a Company. 
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Assigning Enspire Users to a Company 
The company that was selected at sign on is displayed at the top of this window.  To assign 
Enspire users to this company: 

1. Click the Company Users tab. 

 

2. In the Available Users grid, click and hold the mouse button down on the NT Account of 
the user you want to add as a company user.  To add all users as company users, click the 
Select All Users function. 

3. Drag the NT Account to the Selected Users grid. 

4. Release the mouse button. 

To remove a user assigned to the company, drag the user from the Selected Users grid 
back to the Available Users grid.  To remove all users as company users, click the De-
Select All Users function. 

5. Continue to the next procedure, which is Creating Enspire Roles. 

Creating Enspire Roles 
Enspire roles are linked to users. They are also linked with commands that can be selected from 
the menu tree and also events that occur within Enspire.  Thus, Enspire users  are indirectly linked 
to the commands and the events through the company role. To create an Enspire role: 
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1. Click the Enspire Roles tab. 

 

2. Click in the Enspire Roles grid. 

3. Press the INSERT key on your keyboard. 

4. In Role Name, type the code that identifies the role. 

5. In Description, type the description of the role. 

6. Continue to the next procedure, which is Assigning Enspire Roles to a Company. 

Assigning Enspire Roles to a Company 
Enspire provides the ability to have multiple companies in separate databases.  This procedure 
assigns the roles created for Enspire to the specific company selected at sign on.  To assign a role 
to a company: 

1. Click the Company Roles tab. 

 

2. In the Available Roles grid, click and hold the mouse button down on the Role Name 
you want to assign to this company. 

The Available Roles grid contains the Enspire roles. 

3. Drag the Role Name to the Selected Roles grid. 

4. Release the mouse button. 
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To remove a role assigned to the company, drag the role from the Selected Roles grid 
back to the Available Roles grid. 

5. Continue to the next procedure, which is Assigning Commands to Company Roles. 

Assigning Commands to Company Roles 
The commands you assign to a company role determine the level of access that users who are 
assigned to that role have in Enspire. To assign a command to a company role: 

1. Click the Company Role Commands tab. 

 

2. Select the role you want to assign commands to. 

To select a role, click the arrows until the desired Role Name is displayed. 

 

3. Select the commands you want to assign to the role. 

To select commands, click the box (  ) next to the command level you want to assign. A 
check mark appears in the box. To display the commands within a command level, click 
the plus sign (+) next to the level. To hide the commands within a command level, click 
the minus sign (-) next to the level. When you select a command level, all commands 
within that level are assigned to the selected Role Name. For example, if you select 
Enspire System Commands, the role has access to all Enspire commands. If you select 
File Maintenance, the role has access only to commands within File Maintenance. If you 
select Customer within File Maintenance, the role has access only to customer commands 
within File Maintenance. 
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4. Repeat step 2 and step 3 for each role you want to assign commands to. 

5. Continue to the next procedure, which is Assigning Users to Company Roles. 

Assigning Users to Company Roles 
The users you assign to a company role have access to the commands (assigned in the previous 
procedure) to that role. To assign a user to a company role: 

1. Click the Company Role Users tab. 

 

2. Select the role you want to assign users to. 

To select a role, click the arrows until the desired Role Name is displayed. 

 

3. In the Available Users grid, click and hold the mouse button down on the NT Account of 
the user you want to assign to this company role. 

4. Drag the NT Account to the Selected Users grid. 

5. Release the mouse button. 

6. To remove a user assigned to a role, drag the user from the Selected Users grid back to 
the Available Users grid. 

7. Continue to the next procedure, which is Assigning Events to Company Roles. 

Assigning Events to Company Roles 
An event is an Enspire-generated message that appears when certain processes occur. For 
example, if an order is placed on hold, Enspire generates an event. Only users assigned to roles to 
which the event is also assigned receive the event. To assign an event to a company role: 
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1. Click the Company Role Events tab. 

 

2. Select the company role you want to assign the events to. 

To select a company role, click the arrows until the desired Role Name is displayed. 

 

3. In the Available Events grid, click and hold the mouse button down on the Event Name 
you want to assign to the company role. 

4. Drag the Event Name to the Selected Events grid. 

5. Release the mouse button. 
 
To remove an event assigned to a role, drag the event from the Selected Events grid back 
to the Available Events grid. 

The initial Enspire User and Company User set up is now complete. 

 

Field Colors 
In Enspire, the color identifies the type of field. Yellow indicates a required field. You must 
complete a required field before you can save or post. White identifies an optional field. And Gray 
identifies a display-only field. The example below is from the Order Entry dialog. Purchase 
Order is one of the optional fields. Terms and Source are required. Currency and Exchange 
Rate are read only. 

 

NOTE Terms and Source can be optional fields, depending on your selections 
in the Company Miscellaneous Control File dialog. 
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Data Entry Techniques 
In Enspire, different types of fields require specific methods of entering or selecting data. In some 
cases, more than one technique is available. 

• Calculator – The calculator gives you the option of figuring an amount, then inserting it 
into the field. For example, the Price field in the Order Entry Items grid allows you to 
accept the given price, type a new price, or calculate a new price. 

Clicking the  icon displays the calculator. 

  

• Check Boxes – Check Boxes allow you to select one or more options from a list. They 
are also used to select a record for printing or releasing. A check mark indicates the 
option is selected. Clicking a check box or pressing the SPACE BAR on your keyboard 
toggles the check box between selected and unselected. In the example below from the 
Document Print dialog, document 2593 will be printed but 2594 will not be printed.  

 

• Dates – Any field that requires a date gives you the option of typing the date directly into 
the field or selecting the date from the Calendar dialog. Clicking the  icon displays the 
Calendar dialog. 

 

• Drop-down Lists – A drop-down list contains a list of available options. To select from a 
drop-down list, click the down arrow, then click the option you want to select. You can 
also begin typing and the list will display partial matches. In the example below from the 
Family Maintenance dialog, you select the discount level you want to apply. 
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• LookUps – Lookups enable you to search for specific records based on the criteria you 
provide. LookUps are discussed in the Enspire Environment chapter later in this manual. 

• Radio Buttons – Radio buttons allow you to select only one option from a set of available 
options. The options are mutually exclusive. The example below is from the Inventory 
Cost Price Updates dialog. The currently selected option is Margin % of List Price. If 
you selected a different option, Margin % of List Price becomes unselected. 

 

• Text Fields – To enter information in a text field, you activate it then type the 
information. To activate a text field, you can click it or press the TAB key to navigate 
through the dialog until the field becomes active. The example below is from the Item 
Master dialog. 

 

Keyboard Shortcuts 
Enspire gives you the choice of using the keyboard or the mouse to navigate through the 
application. To use the mouse, you simply point and click to select an option or perform a 
function. If you prefer the keyboard, you can use the shortcuts listed below. 

• ALT – The ALT key plus an underlined letter opens a menu or displays a section of an 
Enspire dialog. For example, in the Item Master dialog, ALT+F displays the File menu 
and ALT+C displays the Codes section. You hold down the ALT key as you press the 
letter, then release both keys simultaneously. 

• ALT+ ~ (ALT TILDE) – This key combination cycles through all Enspire dialogs that 
are currently open. For example, while you are in Order Entry, you can open Item Master 
and Customer Master, then use ALT+ ~ to move among those screens. ALT+ ~ functions 
in a manner similar to the ALT+TAB combination in Microsoft Windows. 

• CTRL – The CTRL key activates a menu command. For example, CTRL+O executes the 
Open command on the File menu. Therefore, pressing CTRL+O in Item Master displays 
the Item LookUp dialog and allows you to select the item you want to open. You hold 
down the CTRL key as you press the letter, then release both keys simultaneously. Other 
CTRL key combinations are: CTRL+N (New), CTRL+D (Delete), and CTRL+S (Save). 

• ENTER – The ENTER key moves the cursor to the next field in Enspire grids. If the 
cursor is in the last field of a row, pressing ENTER moves the cursor to the next row. If 
you are in the last field of the last row, pressing ENTER creates a new row. 

• INSERT – The INSERT key creates a new row in an Enspire grid. 
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• TAB – The TAB key moves the cursor to the next field in Enspire grids. If the cursor is 
in the last field of a row, pressing TAB moves the cursor to the next row. If you are in the 
last field of the last row, pressing TAB creates a new row. TAB also moves the cursor 
from one field or button to the next in any Enspire dialog. 
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About this Chapter 
This chapter covers the Enspire operating environment and describes functionality that is standard 
throughout the application. 

Main Window 
When you first open Enspire, the Main Window appears. Through menus and the Outlook Bar, the 
Main Window provides access to all programs within Enspire and also contains the 
Communications Area. 

Menus 
The menus appear across the top of the Main Window. To choose a command from a menu, you 
can use either the keyboard or the mouse. For example, to open Item Master with the keyboard, 
press ALT M to display the File Maintenance menu, press I to display the Inventory programs, 
then press M for Item Master. To open Item Master with a mouse, click the File Maintenance 
menu, position the mouse pointer over Inventory, then click Item Master. 

• The File menu contains the Exit command. Choose Exit to close Enspire. 

• The Administration menu provides access to system controls that establish default 
settings and operating parameters throughout Enspire. 

• The Closings menu provides access to the Closing Module. From here, you can close the 
day, month, or year. 

• The File Maintenance menu provides access to the Enspire setup programs, such as Item 
Master and Vendor Maintenance. 

• The Reports menu provides access to the Enspire Report Explorer. 

• The Transactions menu provides access to Enspire transactions, such as Order Entry and 
Replenishment. 

• The Utilities menu provides access to Enspire utility programs, such as mass changes and 
setting the beginning balance of each GL account. 

• The Help menu provides access to the Enspire online help. 
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Links Panel 
The Links Panel provides shortcuts to Enspire programs. It is divided into groups and is located 
along the left side of the Main Window.  A Links Panel group contains shortcuts to designated 
areas of Enspire. To display the shortcuts within a group, click the group name. The Links Panel 
comes configured with several groups and you can add your own groups. In the example below, 
the Links Panel groups are Enspire, Reports, System, and Misc and the shortcuts for the Misc, 
group are Utilities and Snap Ons. 

 

Adding a Links Panel Group 
1. Right click in the Links Panel. 

2. From the menu that appears, select Add Group. A new group appears at the bottom of 
the Links Panel. 

3. Type the name you want to assign to the new group. 

Renaming a Links Panel Group 
1. Right click the group you want to rename. 

2. From the menu that appears, select Rename Group. 

3. Type the new name. 

Deleting a Links Panel Group 
1. Right click the group you want to delete. 

2. From the menu that appears, select Remove Group. 

Adding a Shortcut to a Links Panel Group 
1. Right click the group you want to add the shortcut to. 

2. From the menu that appears, select Customize. 

3. In the Customize dialog, drag the shortcut you want to add to the group. 
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To drag a shortcut, click the shortcut and hold the mouse button down. Move the mouse 
pointer to the group then release the mouse button. 

Renaming a Shortcut 
1. Right click the shortcut you want to rename. 

2. Click Rename Shortcut. 

3. Type the new name. 

Deleting a Shortcut from a Links Panel Group 
1. Right click the shortcut you want to delete. 

2. Click Remove Shortcut. 

Communications Area 
The communications area allows you to create and receive messages, view events, chat, and set up 
reminders. This screen is a customizable grid that includes Company ID, IP Address, Logon ID, 
Machine Name, Port, and User ID in addition to the User Name, NT Account, Company, and 
Logged On Time displayed below. The communications area appears at the bottom of the Main 
Window. 

 

• Current Logged On Users displays the names of current Enspire users and the times they 
logged on. You can right click on a user to chat with or send a message to that user.  

 

• The Messages section displays the messages you have received.  

• Network Chat allows you to initiate or join an interactive chat with other Enspire users. 
To chat with only one user, right click that user in the Current Logged On Users section. 

• Events are Enspire-related messages generated automatically by the software when 
certain processes occur. For example, if an order is placed on hold, Enspire generates an 
event. Only those users designated to view the event will receive it. 

 

• The Reminders section allows you to create reminders and schedule when they will 
appear. 
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Sending a Message 
1. In the Current Logged On Users section, right click the user or users you want to send the 

message to. 

For instructions on selecting multiple users, see the Grids chapter. 

2. From the menu that appears, select Send Message to Selected User(s). 

3. In the Send Message dialog, type the message in Message Text. 

 

4. Click OK to send the message. 

If you do not want to send the message, click Cancel. 

5. The messages you receive appear in the Messages section. 

Chatting with a Single User 
1. In the Current Logged On Users section, right click the user you want to chat with. 

2. From the menu that appears, select Private Chat. 

3. In the Private Chat dialog, type the text you want to send, then press the ENTER key on 
your keyboard. Pressing ENTER sends the text to the selected user. 
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Chatting with all Currently Logged On Users 
1. In the Network Chat section, type your message, then click Send. 

 

Standard Toolbar 
The Standard toolbar appears at the top of many Enspire dialogs. The current dialog determines 
the available tools. The commonly used tools are described below. 

New creates a new record or batch. For example, in Item Master, choosing 
New allows you to add an item. In Order Confirmation, New creates a new 
confirmation batch.  When you see this icon displayed, you can also use 
keyboard shortcuts of (CTRL + N) to open the New dialog. 

Open opens an existing batch or record. When you click Open, a LookUp 
dialog appears. LookUps are discussed later in this chapter.  
When you see the magnifying glass icon displayed in maintenance and 
transaction programs, you can also use keyboard shortcuts of (CTRL + O) 
to open the Open dialog. 

Save saves the current information, but does not post it to the database. 
When you see this icon displayed, you can also use keyboard shortcuts of 
(CTRL + S) to save your work. 

Cancel allows you to undo your changes since the last time you saved. If 
you are working in a grid and move to a different record, you can no longer 
cancel changes to a previous record. 

Delete deletes the selected record. Based on your setup, Enspire may 
prohibit you from deleting certain records. Also, you cannot delete records 
that are in use in other areas of Enspire. For example, you cannot delete an 
item if it is currently included on a transaction, such as an order or transfer, 
or if it is in a batch, such as a PO receipt batch. 

Post updates all affected records in the database with the current 
information. When you see this icon displayed, you can also use keyboard 
shortcuts of (CTRL + P) to post the transactions. 

Fetch retrieves records that match your selection criteria. When you see 
this icon displayed, you can also use keyboard shortcuts of (CTRL + F) to 
launch the Fetch dialog. 

 Memo opens the Memo Link Maintenance dialog, which allows you to 
include messages with transactions that include the selected customer, 
vendor, item, or salesperson. 

 Select Customer accesses the Select Customer dialog, where you can 
select a group of customers for orders, rebates and customer returns 
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processing. 

 Select Maintenance accesses the appropriate maintenance program to 
allow you to edit maintenance records from a different calling program.   
For example you can select this icon from the Ship To tab of the Customer 
Master Maintenance program to access the Ship To Locations dialog. 

 Mandatory Memo displays Memo Link for mandatory memos in the 
Customer Master, Vendor Master and Item Master dialogs. 

 Non mandatory Memo displays Memo Link for non mandatory memos in 
the Customer Master, Vendor Master and Item Master dialogs. 

Adding Commands to the Toolbar 
1. Click the down arrow at the end of the toolbar, then click Add or Remove Buttons. 

 

2. Click Customize. 

3. In the Customize dialog, click the Commands tab. 

4. In Categories list, click the menu that contains the command you want to add. 

5. In the Commands list, drag the command you want to add to the toolbar. 

To drag a command, click and hold the mouse button down on the command. Move the 
mouse pointer to a valid position on the toolbar then release the mouse button. As you 
drag the command, an X indicates that you are not in a valid position. A + indicates that 
you are in a valid position. 

Removing Commands from the Toolbar 
1. Click the down arrow at the end of the toolbar, then click Add or Remove Buttons. 

 

2. On the list of commands that appears, click the command you want to remove. 

To add the command back to the toolbar, click the command again. 

LookUps 
Enspire lookups enable you to search for specific records based on the criteria you provide. For 
example, you can search for items based on item number, description, UPC code, and a variety of 
other information. 

Depending on the type of record and the process from which the lookup is initiated, one or two 
methods can be used to perform the lookup:  
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• First method – From the File menu, choose Open or you can use the open icon available 
in the menu toolbar. For example, in the Item Master dialog, choosing Open allows you 
to use the Item LookUp to search for the item you want to open. 

• Second method – Click the  magnifying glass or  (ellipse) icon in a field that 
supports lookups.  
For example: 
In the Order Entry dialog, you can perform a lookup to open the customer that is placing 
the order. 

 
 
Inside edit dialog boxes or grids, you can also perform a lookup for the field containing 
the ellipse icon, such as Vendor or GL account rebate number as seen below. 
 

 

Performing a LookUp 
The examples in this section use the Item LookUp dialog. 
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This example shows the default settings. Therefore, the lookup is based on item number and the 
Filter Type is set to Like. 

To perform an item lookup: 

1. Open the Item LookUp dialog. 

2. You can enter optional search criteria in the fields on the left side of the screen: 
 
The System Default Field for the lookup is display only. 
 
Selected Field is the field to use when performing the lookup. 
 
You can select the Make Selected Default checkbox to make the field you selected for the 
lookup be the default lookup field when you access this screen. 
 
The Default Field is the field currently used for the lookup.  
 
The Filter Type determines the comparison method for the lookup. 

3. In Selected Records for Filter, type the text for the lookup. You can also leave this field 
blank. 

4. (Optional) Some lookups have specific filter fields based on the type of lookup you are 
performing. 

The Item Lookup screen contains additional filter fields: 

Warehouse allows you to enter a warehouse to use to limit the lookup. 

Filter out 'X' Items With No Quantity On Hand allows you to filter the items that are 
marked with X as the Item Status and there no Quantity On hand.  Note that this filter 
only applies to the Items that are marked as X Status and not for any other item status.    

The Document Lookup screen contains additional filter fields.   

In the Status box, you can select to limit the lookup information by the available statuses: 
Entered, Printed, Shipped or Closed. 

In the Type box, you can select to limit the lookup information by the available types of 
documents:  Basic, Drop Ship, Future, Recurring, Vendor Direct, Quote, Invoice, 
Direct Invoice, RMA, Credit and Direct Credit.   

Different document type check boxes are available depending on the type of document 
lookup you are performing. Select the checkboxes for the document type you want to 
include in the lookup. 

5. Click the Fetch button ( ). 
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The lookup retrieves records based on the settings for Selected Field and Filter Type and the text 
you type in Selected Records for Filter and any available filter fields. The lookup in this example 
retrieves all items with an item number that begins with A. 

 

In the example below, Selected Field has been changed from Item No to List Price. The Filter 
Type is now Less Than (<) and Selected Records for Filter is 5. Now, when you click Fetch, the 
lookup retrieves items that have a list price less than $5.00. 

x` 
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In the example below, Selected Field has been changed from List Price to Last Sale Date. The 
Filter Type is now Equals (=) and Selected Records for Filter is 02/11/06. Now, when you click 
Fetch, the lookup retrieves items that were last sold on February 11, 2006. 

 

Currently, the Last Sale Date column is not included in the lookup grid. To include it, you can 
click Customize ( ), or right mouse click in any grid column header to present dialog used to 
manipulate data in the grid. For more information, see the Grids chapter. 

Setting LookUp Defaults 
You establish default settings for lookups in the Server LookUp Maintenance dialog. 

1. Open the Server LookUp Maintenance dialog (Administration>System Control>Lookup 
Control). 

2. Select the lookup you are setting the defaults for. 

The lookups appear in a list on the left side of the dialog. To select a lookup, click it. 
After you select a lookup, it appears in the read-only LookUp field. 

3. In Default Field, select the field used to perform the lookup. 

For example, if the default field is Item Number, the lookup retrieves only those items 
with an item number that is at least a partial match to the information you type. In a 
lookup dialog, you can select a field other than the default to perform a lookup. 

The options available in Default Field depend on the lookup you select.  

4. In Records Per Page, type the maximum number of records you want to display at a 
time. 

5. In Filter Type, set the filter used to determine the records retrieved by the lookup. 

For example, if you select Equals, the data in a record must match exactly the value you 
type for the lookup. Otherwise, the record will be excluded from the lookup. In a lookup 
dialog, you can select a filter other than the default to perform a lookup. 
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6. Click OK. 

Quick Keys 
Quick keys expand Enspire’s lookup capabilities by allowing you to override the Selected Field 
and perform the search based on the quick key you use. Hot Keys are user-defined quick keys that 
allow you to set up keyboard shortcuts. 

Quick keys consist of a letter followed by a closing bracket. For example: you are creating an 
order for a customer named JDB Enterprises. If you click the lookup in the Customer field, the 
Customer LookUp dialog appears and you search for customers based on the current Selected 
Field option. 

However, because you know the customer name, you can use the customer name quick key, as in 
the example below. This example limits the lookup to only those customers that begin with JDB. 
You can also use wildcards in combination with quick keys. For information on wildcards, see the 
Wildcards section later in this chapter. 

 

Quick keys are available in all lookup dialogs as well as any lookup field. To see the quick keys 
that are available for a given lookup, type a ? (question mark) in the lookup field, then click the 
LookUp button or press ENTER.  

 

Each type of lookup has its own unique quick keys.  

Listed below are the quick keys for the Customer lookup in the Sales Order Entry dialog. 
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Listed below are the quick keys for the Item lookup, which is accessed throughout Enspire. 

 

Wildcards 
Wildcards are characters that you can use in place of the actual characters. Wildcards allow you to 
enter partial information and still display the record or records you want to see. The wildcards are 
as follows: 

• The % (percent sign) wildcard can represent a single character or multiple characters. For 
example, to match on vendors whose names begin with ABC, type ABC%. To match on 
vendors that end in ABC, type %ABC. To match on vendors who have ABC somewhere 
in their names, type %ABC%. 

• The _ (underscore) wildcard represents a single character. For example, to match on 
vendors with the name ANDERSON or ANDERSEN, type ANDERS_N. Typing A_ 
matches on only those vendors whose names begin with A and are exactly two characters 
long. 

You can also combine the wildcards. For example, to match on item numbers AB1100, CD1110, 
EF1120, and GH1130, type %11_0. Because the item number can begin with any number of 
characters, %11_0 would include other numbers, such as ABCD1170. However, it would exclude 
item numbers such as AB11220 because only one character can fall between the 1 and the 0. 

Documents 
An Enspire document is a printable record generated by the application.  Documents include 
customer returns, inventory documents (transfers, requisitions, or work orders), invoices and 
credits, purchase order documents (purchase orders, vendor return authorizations (VRA), or 
quotes) and sales order documents (sales orders, backorders, will call orders, vendor direct orders, 
future orders, recurring orders, and quotes). 

Printer Groups 
Printer groups identify the default printer for each Enspire document and determine the printer 
assignments for your users and/or warehouses. 

For warehouse documents, printing in Enspire follows the hierarchy listed below. 

• If the warehouse has a printer group assigned, Enspire uses that printer group. 
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• If the warehouse does not have a printer group assigned, Enspire uses the printer group 
assigned to the user. 

• If you do not have any printer groups defined, Enspire prints to the users default printer. 

Setting Up a Printer Group with a Single Printer 
1. Open the Document Printer Groups dialog (Administration>System Control>Printer 

Groups). 

2. Click the New Printer Group button (  ). 

 

3. In Printer Group, type the name of the new printer group. 

4. In Printer Name, click the printer button (  ) then select the default printer for the 
printer group. 

This default is automatically assigned to all documents. 

5. In Paper Tray, click the printer button (  ) then select a paper tray. 

The selected printer determines the paper tray options that are available. If you are unsure 
of which paper tray to select, select Default.  

6. Click OK. 

Setting Up a Printer Group with Multiple Printers 
When you first create a printer group, you select a default printer that applies to all documents. To 
assign a different printer to an individual document, follow the steps below. 

1. Open the Document Printer Groups dialog (Administration>System Control>Printer 
Groups). 

2. In Printer Group, select a printer group. 

3. In the Document grid, select the Document Class you want to assign a different printer 
to. 
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4. Click the Edit Selected Document Classes button (  ). 

 

5. In Printer Name, click the printer button (  ) then select the printer you want to assign 
to the document class. 

6. In Paper Tray, click the printer button (  ) then select a paper tray. 

The selected printer determines the paper tray options that are available. If you are unsure 
of which paper tray to select, select Default. 

7. Click OK. 

Assigning a Printer Group to the Current User 
1. Open the User Profile Maintenance dialog (File Maintenance>System>User Profile). 

2. Click the Enspire System tab. 

3. In Printer Group, select the printer group you want to assign to the currently signed on 
user.user. 

The printer group you select is assigned to the user who is currently logged on. 

4. Click OK. 

Assigning a Printer Group to a Warehouse 
1. Open the Warehouse Maintenance dialog (File Maintenance>Inventory> Warehouse). 
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2. Click the Information tab. 

 

3. In the Warehouse grid, select a warehouse. 

4. In Printer Group, select the printer group you want to assign to the warehouse. 

5. Choose Save. 
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About this Chapter 
This chapter provides instructions on working with Enspire grids, including customizing, 
exporting, and printing. 

Grids 
Much of the information in Enspire is contained in grids. Grids provide a flexible means for 
displaying and working with Enspire information. A grid consists of columns, rows, and cells. In 
the example below, the first three columns are Print, Document, and Created. A row is a horizontal 
line of data within the grid. A cell is the point at which a column and row intersect. For example, 
in the third row under Document, the cell contains the document number 77942. 

 

The commands used to print, customize, and export grids are available when you right click within 
a grid column header. When you right click, a menu appears. To access a command on the menu, 
click the menu option that contains the command you want to use, then click the command. The 
example below displays the Export commands. 

 

Entering Information into a Blank Grid 
The steps below use the Brackets grid as an example. 

 

1. Click in the Brackets grid then press the INSERT key on your keyboard. A new row is 
added to the grid. 
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2. To move from cell to cell in a grid, you can press the TAB key or the ENTER key on 
your keyboard, or you can click in a cell. 

Creating a New Row in a Grid 
If the cursor is in the last field of the last row, pressing the ENTER key or TAB key on your 
keyboard creates a new row. 

If all required fields in a grid contain valid values, you can press the INSERT key on your 
keyboard to create a new row. In the Brackets grid example below, pressing INSERT creates a 
new row because PO Amount contains a value for each existing record. 

 

Sorting and Grouping Information in a Grid 
Enspire gives you the ability to sort information based on any column currently in the grid. You 
simply click the column you want to sort by. The first time you click a column, the information is 
sorted in ascending order. Click the column again to sort in descending order. 

An arrow pointing up indicates the information is sorted by that column in ascending order. 

 

An arrow pointing down indicates the information is sorted by that column in descending order. 

 

To group information in a grid, you drag the column header you want to group by into the Group 
Panel. To display or hide the Group Panel, right click within the grid. On the menu that appears, 
click Options, then click Show Group Panel. 

In the example below, the Group Panel is displayed. 

 

In the example below, the Group Panel is not displayed. 

 

To group by a single column: 

1. Click and hold the mouse button down on the column header you want to group by. 

2. Drag the column to the Group Panel. 

To drag a column header, move the mouse pointer to the Group Panel then release the 
mouse button. 
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The examples below use the Documents grid in the Document Print dialog (Transactions>Order 
Entry>Document Print). In the first example, the information is not grouped. 

 

In the example below, the information is grouped by customer. You can click the plus sign (+) 
next to a customer to display each record belonging to that customer. Click the minus sign (-) to 
hide those records. 

 

To group by multiple column headers, drag each column header to the Group Panel. In the 
example below, the information is grouped by customer and the date the document was created. 
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The example below places the latest ship date in front of the other grouping levels. Now, Latest is 
the first grouping level. 

 

Ungrouping a Grid 
To ungroup: simply drag the column you no longer want to group by from the Group Panel back 
to the grid columns and release 

Customizing a Grid 
In some cases you may want to see more or less information than the default data for a particular 
grid, or you may wish to present the data in a different sequence.  Therefore, Enspire gives you the 
ability to customize the grid and configure it to contain the information you want to see in the 
order you want to see it. The current grid parameters selected determine the information that is 
available. 

Customizing a grid includes the following procedures: 

• Adding a Column 

• Removing a Column 

• Rearranging Columns 

• Resizing a Column 

The examples in this section use the Documents grid in the Customer Docuscope. To begin with, it contains 
the columns shown below. 
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Adding a Column to a Grid 
1. Right click within the grid column header. 

2. On the menu that appears, click Options, then click Customize. 

 

 

3. In the Customize dialog, click and hold the mouse button down on the column you want 
to add. This dialog contains the columns available to the grid but not currently included 
in the grid. In the example above, you can select from the column choices in the image 

4. Drag the column to the grid, then release the mouse button. 

In the example below, Customer Name is being dragged to the grid. When you release the mouse 
button, this column is placed between Latest and Customer based on the location of the down 
arrow. 
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Removing a Column from a Grid 
Adding the Customer Name column in the procedure above gives you both the customer name and 
number in the grid. 

 

The example in this procedure removes the Customer column from the grid. 

To remove a column: 

1. Make sure the Customize dialog is displayed. 

To display this dialog, right click within the grid column header. From the menu that 
appears, click Options, then click Customize. 

2. In the grid column header, right mouse click on a column header, select Remove This 
Column from the presented dialog or select Field Chooser from the presented dialog,  

3. When the customization dialog appears, you may click and hold the mouse button down 
on the column you want to remove and drag it to the customization dialog and then 
release it. 

The Customer column is removed from the grid and placed back in the Customize dialog. 

 

Rearranging Columns in a Grid 
If you want to see the current information in a grid, but in a different order, you can move column 
headers to different positions in the grid. The example in this procedure moves the Customer 
Name column between the Print and Document columns. 

1. Click and hold the mouse button down on the column header you want to move. 

2. Drag the column to its new position, then release the mouse button. 
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When you release the mouse button, Customer Name is placed between Print and Document. 

 

Resizing a Column 
Enspire allows you to increase or decrease the width of a column. If the column is too narrow to 
display the full column heading, you can position the mouse pointer over the column heading to 
display its full name. 

To resize a column 

1. Position the mouse pointer between two column headers. The pointer changes to a double 
arrow. 

 

2. Click and hold the mouse button down, then drag in the direction you want to resize. In 
the example below, dragging to the left decreases the size of the Customer Name column. 
Dragging to the right increases the size of the Customer Name column. 

 

3. When the column header reaches the desired size, release the mouse button. 

Selecting Records in a Grid 
Selecting a record makes it the active row in the grid. If the Row Indicator is displayed, it 
identifies the selected row. If the Row Indicator is not displayed, the highlighted cell indicates the 
selected record. 

In the first example below, the Row Indicator (►) is displayed. In the second example, it is not 
displayed. In both examples, the second record is selected. 

 

 

Selecting records in a grid includes the following procedures: 

• Selecting a Single Record 

• Selecting Multiple Records  

3-8 Getting Started  Version 7.3.2.0 



Grids  Deleting Records from a Grid 

Selecting a Single Record in a Grid 
To select a single record with the mouse, click the record you want to select. To select a single 
record with the keyboard, press the TAB key until the grid becomes active. You can then use 
TAB, ENTER, or the arrow keys on your keyboard to move through the grid.  

Selecting Multiple Records in a Grid 
Some grids allow you to select more than one record at a time. You can select them consecutively 
or individually. 

To select multiple records consecutively: 

• Using the mouse, click the first record you want to select. Hold down the SHIFT key on 
your keyboard then click the last record you want to select. If the grid allows multiple 
selections, the first record, the last record, and all records in between are selected. 

• Using the keyboard, position the cursor within the first record you want to select. Hold 
down the SHIFT key on your keyboard then press the down arrow until you have selected 
all the records you want to select. 

To select multiple records individually, you must use the mouse: 

• Hold down the CTRL key on your keyboard then click each record you want to select. 

Deleting Records from a Grid 
1. Select the record you want to delete. 

2. Press the CTRL key and the DELETE key on your keyboard. 

Some grids do not allow you to delete records. For example, in the Document Print dialog, you 
cannot delete records from the Documents grid. Instead, you can select not to print the document 
associated with the record or you can set the filters to exclude the record. 

Printing a Grid 
1. Right click in the grid you want to print. 

2. On the menu that appears, click Printing then click Print.  

Page Setup, Print Preview, and Design Report are discussed in the Enspire online help. 

Exporting a Grid 
You can export the information in an Enspire grid in a variety of formats, including tab or comma-
separated text file, HTML, XML, or a Microsoft Excel spreadsheet. 

To export a grid: 

1. Right click in the grid column header you want to export. 

2. On the menu that appears, click Export then click the format you want to use for the 
export. 

3. In the Save dialog, type the file name then select where you want to save the file. 

4. Click Save. 
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About this Chapter 
The information in this chapter is intended to show you how the general ledger works in Enspire. 
It is not meant to replace the advice of your accountant. It is recommended that you consult your 
accountant if you have any questions regarding your account structure, including the use of profit 
centers, departments, and subaccounts. 

General Ledger Overview 
To record financial information, Enspire uses the principles of double entry accounting. This 
method of accounting creates balancing debit and credit entries for every financial transaction. 
These transactions give you the ability to track where your money comes from and where it goes. 

Setting up your general ledger in Enspire must follow the sequence listed below. 

• Determine your account format 

• Set up a profit center 

• Create a chart of accounts 

• Set up account sets 

Determining the Format of Your General Ledger Accounts 
The general ledger account structure must include an account number. Optionally, it can also 
include a subaccount. 

When you post transactions that affect the general ledger, Enspire automatically creates the 
relationship between the account/subaccount and the profit center/department. Therefore, you do 
not need to manually create or copy a chart of accounts for each profit center. To determine the 
format of your general ledger accounts: 

1. Open the Miscellaneous Control File dialog (File Maintenance>System>Misc Control). 
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2. Click the General Ledger tab. 

 

NOTE There are other settings in this dialog that affect your general ledger, 
but this procedure discusses only the fields involved in formatting your 
accounts. For information on other fields, see the Enspire online help. 

3. If you use departments, select Use GL Department Codes. Leave this option unselected 
if you do not use departments. 

4. In GL Account # Length, type the number of characters in your general ledger account 
numbers, excluding the subaccount. The maximum number is 8. 

5. In GL Subaccount # Length, type the number of characters in your general ledger 
subaccount numbers. The maximum number is 4. Set this option to 0 (zero) if you do not 
use subaccounts. 

6. From the File menu, choose Save. 

Sample Format 
In the example below, the account number is 6000 and the sub account is 20. 

• 6000-20  SALARIES 

The examples below use the profit centers set up later in this chapter. 

• Using account number 6000-20, posting transactions to the WEST location with 
department codes will result in the following account numbers: 

WEST-OFF-6000-20  SALARIES 

WEST-SALE-6000-20  SALARIES 
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WEST-WHSE-6000-20  SALARIES 

• Using account number 6000-20, posting transactions to the EAST location with 
department codes will result in the following account numbers: 

EAST-OFF-6000-20  SALARIES 

EAST-SALE-6000-20  SALARIES 

EAST-WHSE-6000-20  SALARIES 

• Using account number 6000-20, posting transactions to the EAST location without 
department codes will result in the following account numbers: 

EAST-6000-20  SALARIES 

WEST-6000-20  SALARIES 

 

Consolidating Balance Sheets 
A consolidated balance sheet combines your balance sheet accounts for all profit centers into one 
profit center. You select to consolidate your balance sheets, as well as the profit center that 
consolidates them, in the CO Miscellaneous Control File dialog.  

 

• Use Consolidated Balance Sheet determines whether your company uses a consolidated 
balance sheet. Leave this option selected if you use consolidated balance sheets. Unselect 
this option if you do not use consolidated balance sheets. If Use Consolidated Balance 
Sheet is selected, you must select a Balance Sheet Profit Center. 

• Balance Sheet Profit Center identifies the profit center that the balance sheet accounts 
are consolidated under. If Use Consolidated Balance Sheet is not selected, leave 
Balance Sheet Profit Center blank. 

If you do not consolidate your balance sheets, you have separate balance sheet accounts for each 
profit center. The example below uses the profit centers set up earlier in this chapter and the 
Accounts Receivable account, which is number 1110. 

• If you do not consolidate your balance sheet accounts, the Accounts Receivable accounts 
appear as follows and you have separate amounts for each account. 

ACME-1110  ACCOUNTS RECEIVABLE 

EAST-OFF-1110  ACCOUNTS RECEIVABLE 

EAST-SALE-1110  ACCOUNTS RECEIVABLE 

EAST-WHSE-1110  ACCOUNTS RECEIVABLE 

WEST-OFF-1110  ACCOUNTS RECEIVABLE 

WEST-SALE-1110  ACCOUNTS RECEIVABLE 

WEST-WHSE-1110  ACCOUNTS RECEIVABLE 
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• If you do consolidate your balance sheet accounts, the Accounts Receivable account 
appears as follows and the amounts for each profit center are totaled under the balance 
sheet profit center. In this case that profit center is ACME. 

ACME-1110  ACCOUNTS RECEIVABLE 

 

Setting Up a Profit Center 
A profit center is a location within your business, such as a warehouse, for which general ledger 
accounts are tracked separately. If you do not use departments, the profit center is only the 
location. If you do use departments, the profit center is a combination of the location and 
department. Departments allow you to track revenue and expenses for each department. 
Departments are used for profit and loss accounts, but not for balance sheet accounts. 

To set up a profit center: 

1. Open the Profit Center Maintenance dialog (File Maintenance>General Ledger>Profit 
Centers). 

 

2. From the File menu, choose New. 

3. In Location, type a code that identifies this profit center. 

This code can be up to eight characters long and is alphanumeric. 

4. In Description, type a description of the profit center. 
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5. If you use departments, click in the Department grid then press the INSERT key on your 
keyboard. 

6. In Dept Code, type a code that identifies a department within the profit center.  

This code can be up to four characters long and is alphanumeric. 

7. In Description, type a description of the department. 

8. From the File menu, choose Save. 

Creating the Chart of Accounts 
General ledger accounts are specific categories for which separate financial activity is recorded. 
The chart of accounts defines and maintains all of the general ledger accounts in Enspire. When 
you add general ledger accounts to your chart of accounts, you must make sure that all of your 
balance sheet accounts come before your profit and loss accounts. In a typical structure, the 
balance sheet accounts are numbered 1000, 2000, or 3000. The profit and loss accounts are 
numbered 4000, 5000, 6000, and 7000. 

Balance Sheet Accounts: 

• The 1000 series accounts are assets. 

• The 2000 series accounts are liabilities. 

• The 3000 accounts are capital. 

Profit and Loss Accounts: 

• The 4000 series accounts are sales or revenues. 

• The 5000 series accounts are cost of goods sold. 

• The 6000 series accounts are expenses. 

• The 7000 series accounts are miscellaneous. 

Before setting up your Chart of Accounts, you must define your profit centers and determine the 
formats of the accounts, as discussed earlier in this chapter. Note that once the chart of accounts is 
keyed, the GL account number and subaccount field lengths cannot be changed so be certain your 
choices are accurate before you begin creating your chart of accounts.   
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To create your chart of accounts: 

1. Open the Chart of Accounts Maintenance dialog (File Maintenance>General 
Ledger>Chart of Accounts). 

 

2. From the File menu, choose New. 

3. In Acct No, type an account number. 

4. If you use subaccounts for the current account, type a subaccount number in Subacct. If 
you do not use subaccounts, leave Subacct set to 0 (zero). 

5. In Description, type the description of the account. 

6. In Acct Type, select an account type. The options are Balance Sheet, Memo, and Profit 
& Loss. A Memo account type allows you to include a note or a divider. For example, if 
you want to show the logical division of your chart of accounts, you can use a Memo to 
create a heading for each division. 

7. In Ratio Code, select the ratio code that applies to the account. 

8. From the File menu, choose Save. 
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Assigning Company General Ledger Accounts 
Your company general ledger accounts are accounts that are required in Enspire. They identify the 
account to use when posting transactions to a specific area of the software. In the Company GL 
Account dialog below, transactions involving sales commissions payable are automatically posted 
to account 2335-0 which is a balance sheet account type. 

Note that once you begin keying accounts on this window, you must complete an account number 
for every Description provided so your Chart of Accounts will need to have all of the displayed 
values created.   

 

To assign company general ledger accounts: 

1. Open the Company GL Account dialog (File Maintenance>Company>GL Accounts). 

2. In GL Acct #, select a general ledger account for each Description and Acct Type 
combination. The Open icon is provided to access the Lookup dialog for GL Accounts. 

3. In Dept, assign a department for each of your profit and loss accounts. If you do not use 
departments, Dept is inactive. 

4. From the File menu, choose Save. 

Setting Up Account Sets 
Account sets are groups of general ledger accounts that record item transactions. The number of 
account sets you have depends on the level of detail you want in your general ledger reporting. 
The fewer account sets you have, the less detailed your general ledger reporting capability. 
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The account types within an account set depend on the type of item. The item set types are as 
follows: 

• C) Consignment Item – This type is used for consignment items, which are items you 
stock but do not pay for until you sell them. Consignment Item account sets include some 
of the same accounts as Standard Item account sets and also include a consignment costs 
payable account, which is credited when you sell consignment items. Consignment Item 
account sets do not include inventory-related accounts because consignment items are not 
valued as inventory. 

• F) Free Good Item – This type is used for items that you give away. Free Good Item 
account sets include one inventory account and an expense account. 

• M) Misc Debit/Credit – This type is used for miscellaneous debit or credit items. 

• N) Non-Stock Item – This type is used for items that you sell but do not stock. 

• S) Standard – This type is used for typical items, which are the items you purchase from a 
vendor and sell to a customer. Standard Item account sets include accounts for sales, sales 
discounts, family discounts, cost of sales, inventory on hand, inventory transfers, and 
inventory adjustments. Kits also include labor, packaging, and overhead accounts. 

• V) Service Item – This type is typically used for labor and other services. 

• X) StockAid Item – This type is used for items in StockAid. 

The table below lists the accounts within each of the item set types: 

Item Set Type GL Accounts 

Standard Item 
Type 

• Cost of Sales: Physical Inventory - Records the dollar variance, if any, when 
you perform a physical inventory count. 

• Cost of Sales: Price Variance - During AP invoice matching, records the 
variance, if any, between the dollar amount you were charged and the dollar 
amount you received. 

• Cost of Sales: Product - Debited when you post an invoice. Credited when 
you post a credit memo. Cost of sales is determined by your company's 
inventory costing method. 

• Cost of Sales: Qty Variance - During AP invoice matching, records the 
variance, if any, between the quantity you were charged for and the quantity 
you received. 

• Inventory: Clearing Account - Maintains the value of received inventory 
before the vendor invoice is processed. 

• Inventory Clearing Account Vendor Direct - Maintains the value of received 
inventory before the vendor invoice is processed. Applies to vendor direct 
purchase orders. 

• Inventory: Stocked Items - Debited when you receive items. Credited when 
you ship items. The cost of inventory on hand is determined by your 
company's inventory costing method. 

• Inventory: Transfers In-transit - Credited when the item ships from the 
sending warehouse. Debited when the item arrives at the shipping 
warehouse. This account records the cost of inventory items transferred from 
this warehouse. In most cases, this account is a temporary clearing account. 
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Item Set Type GL Accounts 

• Inventory: Vendor Direct - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the amount included on 
a vendor direct purchase order. 

• Kit Credit Account: Labor - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of labor 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Kit Credit Account: Overhead - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of overhead 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Kit Credit Account: Packaging - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of packaging 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Kit Credit Account: Setup Cost- Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of setup 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Line-level Family Discount - Debited when you post an invoice. Credited 
when you post a credit memo. This account records the amount of family 
discounts at the line level only. 

• Line-level Sales Discount - Debited when you post an invoice. Credited 
when you post a credit memo. This account records the amount of family 
discounts at the line level only. 

• Sales - Credited when you post an invoice. Debited when you post a credit 
memo. This account records the sales amount. 

StockAid Item 
Type 

• Cost of Sales: Physical Inventory - Records the dollar variance, if any, when 
you perform a physical inventory count. 

• Cost of Sales: Price Variance - During AP invoice matching, records the 
variance, if any, between the dollar amount you were charged and the dollar 
amount you received. 

• Cost of Sales: Product - Debited when you post an invoice. Credited when 
you post a credit memo. Cost of sales is determined by your company's 
inventory costing method. 

• Cost of Sales: Qty Variance - During AP invoice matching, records the 
variance, if any, between the quantity you were charged for and the quantity 
you received. 

• Inventory: Clearing Account - Maintains the value of received inventory 
before the vendor invoice is processed. 

• Inventory: Stocked Items - Debited when you receive items. Credited when 
you ship items. The cost of inventory on hand is determined by your 
company's inventory costing method. 
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Item Set Type GL Accounts 

• Inventory: Transfers In-transit - Credited when the item ships from the 
sending warehouse. Debited when the item arrives at the shipping 
warehouse. This account records the cost of inventory items transferred from 
this warehouse. In most cases, this account is a temporary clearing account. 

• Line-level Family Discount - Debited when you post an invoice. Credited 
when you post a credit memo. This account records the amount of family 
discounts at the line level only. 

• Line-level Sales Discount - Debited when you post an invoice. Credited 
when you post a credit memo. This account records the amount of family 
discounts at the line level only. 

• Sales - Credited when you post an invoice. Debited when you post a credit 
memo. This account records the sales amount. 

Service Item Type • Clearing for Service Cost Expense -  
• Cost of Sales: Price Variance - During AP invoice matching, records the 

variance, if any, between the dollar amount you were charged and the dollar 
amount you received. 

• Cost of Sales: Product - Debited when you post an invoice. Credited when 
you post a credit memo. Cost of sales is determined by your company's 
inventory costing method. 

• Cost of Sales: Qty Variance - During AP invoice matching, records the 
variance, if any, between the quantity you were charged for and the quantity 
you received. 

• Inventory Clearing Account Vendor Direct - Maintains the value of received 
inventory before the vendor invoice is processed. Applies to vendor direct 
purchase orders. 

• Inventory: Vendor Direct - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the amount included on 
a vendor direct purchase order. 

• Kit Credit Account: Labor - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of labor 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Kit Credit Account: Overhead - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of overhead 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Kit Credit Account: Packaging - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of packaging 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Line-level Family Discount - Debited when you post an invoice. Credited 
when you post a credit memo. This account records the amount of family 
discounts at the line level only. 

• Line-level Sales Discount - Debited when you post an invoice. Credited 
when you post a credit memo. This account records the amount of family 
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Item Set Type GL Accounts 

discounts at the line level only. 
• Sales - Credited when you post an invoice. Debited when you post a credit 

memo. This account records the sales amount. 
• Service Cost Expense - Credited when you post an invoice. Debited when 

you post a credit memo. This account is an expense account that records 
your cost for the service. 

Non-Stock Item 
Type 

• Cost of Sales: Price Variance - During AP invoice matching, records the 
variance, if any, between the dollar amount you were charged and the dollar 
amount you received. 

• Cost of Sales: Product - Debited when you post an invoice. Credited when 
you post a credit memo. Cost of sales is determined by your company's 
inventory costing method. 

• Cost of Sales: Qty Variance - During AP invoice matching, records the 
variance, if any, between the quantity you were charged for and the quantity 
you received. 

• Inventory: Clearing Account - Maintains the value of received inventory 
before the vendor invoice is processed. 

• Inventory Clearing Account Vendor Direct - Maintains the value of received 
inventory before the vendor invoice is processed. Applies to vendor direct 
purchase orders. 

• Inventory: Stocked Items - Debited when you receive items. Credited when 
you ship items. The cost of inventory on hand is determined by your 
company's inventory costing method. 

• Inventory: Transfers In-transit - Credited when the item ships from the 
sending warehouse. Debited when the item arrives at the shipping 
warehouse. This account records the cost of inventory items transferred from 
this warehouse. In most cases, this account is a temporary clearing account. 

• Inventory: Vendor Direct - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the amount included on 
a vendor direct purchase order. 

• Kit Credit Account: Labor - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of labor 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Kit Credit Account: Overhead - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of overhead 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Kit Credit Account: Packaging - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of packaging 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Kit Credit Account: Setup Cost- Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of setup 
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Item Set Type GL Accounts 

associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Line-level Family Discount - Debited when you post an invoice. Credited 
when you post a credit memo. This account records the amount of family 
discounts at the line level only. 

• Line-level Sales Discount - Debited when you post an invoice. Credited 
when you post a credit memo. This account records the amount of family 
discounts at the line level only. 

• Sales - Credited when you post an invoice. Debited when you post a credit 
memo. This account records the sales amount. 

Misc Debit/Credit 
Item Type 

• Credited when you post an invoice. Debited when you post a credit memo. 
This account records the sales amount. 

Free Good Item 
Type 

• Free Goods Expense Account - Debited when you post an invoice. Credited 
when you post a credit memo. This account is an expense account and can be 
a regular cost-of-sales type of an account, a special marketing account, or 
another type of account. 

• Inventory: Clearing Account - Maintains the value of received inventory 
before the vendor invoice is processed. 

• Inventory Clearing Account Vendor Direct - Maintains the value of received 
inventory before the vendor invoice is processed. Applies to vendor direct 
purchase orders. 

• Inventory: Stocked Items - Debited when you receive items. Credited when 
you ship items. The cost of inventory on hand is determined by your 
company's inventory costing method. 

• Inventory: Transfers In-transit - Credited when the item ships from the 
sending warehouse. Debited when the item arrives at the shipping 
warehouse. This account records the cost of inventory items transferred from 
this warehouse. In most cases, this account is a temporary clearing account. 

• Inventory: Vendor Direct - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the amount included on 
a vendor direct purchase order. 

Consignment Item 
Type 

• Consignments Payable - Credited when you post an invoice. Debited when 
you post a credit memo. This account records the cost of consignment items 
when they are sold. 

• Cost of Sales: Product - Debited when you post an invoice. Credited when 
you post a credit memo. Cost of sales is determined by your company's 
inventory costing method. 

• Kit Credit Account: Labor - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of labor 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Kit Credit Account: Overhead - Credited when you post an invoice. Debited 
when you post a credit memo. This account records the cost of overhead 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
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Item Set Type GL Accounts 

can use a cost-of-sales type of an account. 
• Kit Credit Account: Packaging - Credited when you post an invoice. Debited 

when you post a credit memo. This account records the cost of packaging 
associated with a kit. When you set up a kit, you have the option of defining 
this cost. If you do not want to identify a specific account for this cost, you 
can use a cost-of-sales type of an account. 

• Line-level Family Discount - Debited when you post an invoice. Credited 
when you post a credit memo. This account records the amount of family 
discounts at the line level only. 

• Line-level Sales Discount - Debited when you post an invoice. Credited 
when you post a credit memo. This account records the amount of family 
discounts at the line level only. 

• Sales - Credited when you post an invoice. Debited when you post a credit 
memo. This account records the sales amount. 

 

To set up an account set: 

1. Open the Account Set Maintenance dialog (File Maintenance>General Ledger> Account 
Sets). 

 

2. From the File menu, choose New. 
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3. In Set Code, type a code for the account set. 

This code is alphanumeric and can be up to four characters long. 

4. In Description, type a description of the account set. 

5. Select a Set Type.  The item type assigned to an account set determines the types of 
accounts you must provide an account number for and the general ledger accounts that 
are affected during transactions that involve items belonging to that account set. The 
valid selections are: 

• C) Consignment Item - Consignment items are items that are added to inventory, 
but you do not pay the vendor until they are sold.  

• F) Free Good Item - Free goods are items that you ship to customers at no 
charge.  

• M) Misc Debit/Credit - Miscellaneous debit and credit items allow you to add 
credits or debits to an order.  

• N) Non-Stock Item - Non-Stock items are items that you sell but do not stock.  
• S) Standard Item - Standard items are items that you stock and sell.  
• V) Service Item - Service items are services your company provides, such as 

labor.  
• X) StockAid Item - StockAid items do not fit the typical sales, purchasing, and 

inventory management processes.  

6. If you want to assign a StockAid set code, select it in StockAid GL Set Code. StockAid 
GL Set Code is not active if you selected a Set Type of Misc Debit/Credit Item, Service 
Item, or StockAid Item. 

The StockAid GL Set Code determines the account set assigned to items within the 
selected Set Type if those items are received into StockAid. If you do not select a 
StockAid GL Set Code, Enspire uses the default account set selected in the StockAid 
Items field in the General Ledger section of the CO Miscellaneous Control File dialog. 

7. For each Account Type and Account Type Description, select a general ledger account 
number in Account #. 

Account Type displays the account types within the selected Set Code. 

Account Type Description displays the description of the account type. 

Account # is the general ledger account number assigned to the Account Type for the 
selected Set Code. 

8. In Dept, assign a department for each of your profit and loss accounts. If you do not use 
departments, Dept is inactive. 

9. From the File menu, choose Save. 

Assigning an Account Set to an Item 
1. Open the Item Master dialog (File Maintenance>Inventory>Item Master). 

2. Open the item you want to assign the account set to. To open an item, choose Open from 
the File menu then use the lookup to search for the item. 
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3. Click the Codes tab. 
 

 

4. In GL Set, select an account set. 

5. From the File menu, choose Save. 

Adding a Bank 
When you add a bank, you identify it as a checking bank or a credit card bank. Enspire requires 
bank records for checking and credit cards because of reconciliation issues. Checks and cash can 
be deposited immediately; however, you may have to wait several days or longer before you 
receive payment from a credit company. 

To add a bank: 

1. Open the Bank Account Maintenance dialog (File Maintenance>General Ledger>Banks). 
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2. From the File menu, choose New. 

3. Complete the Bank grid as follows: 

Type is the type of account. The options are: B-Bank Checking identifies the bank as the 
bank you use for checks and cash or C-Credit Card Bank identifies the bank as the bank 
you use for credit cards. 

Acct Code is the code that identifies the bank in Enspire. This code is alphanumeric and 
can be up to four characters long. 

Name is the full name of the bank. 

ABA Number allows you to include the bank’s American Bankers Association number. 

4. On the Bank Information tab, double click in the Demographics area to display the Bank 
Address dialog. In this dialog, type the general bank information including address, 
phone and fax numbers, email address and web address. After you type this information, 
click OK to close the Bank Address dialog. 

5. Click the Account tab and complete that information as described below. The example 
below applies to a Type of Bank Checking. 

 

Account Number is your account number assigned by the bank. 

Currency is the bank’s currency. You define currencies in the Currency Maintenance 
dialog, located on the menu under File Maintenance>System>Currencies. 

Max Check Amount is the maximum amount for which you can write a check on this 
account. 

If you selected a Type of Credit Card, Credit Limit is your credit limit for the card. 
Card Type identifies the card as a Mastercard, Visa, or other type of credit card. 
Expiration Date is the date the credit card expires. 

If you use departments, Dept is the department assigned to the fee account and the 
interest account. 

Cash Acct # is the general ledger account to which deposits made to the bank are posted. 
Select  to access the Lookup dialog for GL Accounts. 

If you selected a Type of Credit Card, Credit Card Acct # is the general ledger account 
to which deposits made to the bank are posted. Select  to access the Lookup dialog for 
GL Accounts. 
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Fee Acct # is the general ledger account to which fees paid to the bank are posted. Select 
 to access the Lookup dialog for GL Accounts. 

Interest Acct # is the general ledger account to which interest earned from the bank is 
posted. Select  to access the Lookup dialog for GL Accounts. 

6. If you selected a Type of Bank Checking, click the Check Form tab and complete the 
check information as described below. 

 

In the Automatic Checks group box: Begin Check # is the first check number assigned to 
your automatic checks. End Check # is the last check number assigned to your automatic 
checks. Next Check # is the number assigned to the next check written on this account. 
This number increases by one automatically each time a check is posted to this account. 
Qty Available displays the quantity of automatic checks still available. 

In the Blank Checks group box: Begin Check # is the first check number assigned to 
your manual checks. End Check # is the last check number assigned to your manual 
checks. Next Check # is the number assigned to the next check written on this account. 
This number increases by one automatically each time a check is posted to this account. 
Qty Available displays the quantity of manual checks still available. 

Check Stub Invoice Qty is the number of invoices that will fit on the check stub. For 
example, if this quantity is set to 10, then 10 invoices will be identified on the stub. Any 
quantity above 10 is included on a continuation stub, which you can then mail to the 
vendor along with the check and stub. 

The Check Information group box allows you to type the Company and Bank 
information that will appear on your blank checks. 

Number of Spaces Prior to the Account Number is the number of spaces you must pad 
the account number if the account number is fewer than 12 digits. For example, if your 
account number is 10 digits, set this option to 2. You type the account number in the 
Account section. 

7. If you selected a Type of Credit Card, click the Credit Card Users tab then press the 
INSERT key on your keyboard. Complete the information as described below. 

 

User Name is the user assigned to the credit card. 
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Account Number is the credit card’s account number. 

Credit Limit is the credit limit for the selected user. 

Expiration Date is the date the credit card expires. 

8. From the File menu, choose Save. 

Bank Account Manager 

The Enspire Bank Account Manager allows you to keep your company's bank accounts in order. You can 
make manual entries for bank fees and interest income, transfer funds from one account to another, and 
reconcile the accounts. You can also use the Bank Account Manager to track credit card transactions, 
including purchases, payments, balances, and available credit. 

The Transaction Editor in the Bank Account Manager allows you to create a new Bank Fee, Interest 
Income, or Miscellaneous Adjustment transaction for the account selected in the Account List section of 
the Bank Account Manager. You can also transfer funds from one account to another. 

NOTE: You can also enter bank fees, charges, and interest income transactions in the Reconcile section of 
the Bank Account Manager. If you enter these transactions in the Reconcile section, do not enter the same 
transactions in the Transaction Editor. 

Creating a new bank transaction 
1. Open the Bank Account Manager (Transactions>General Ledger>Bank Account Manager). 

2. In the Account List tab section, select the bank or credit card in the grid that you are creating the 
new transaction for.  

3. Click the Register tab to display the Register section. 

4. Select Transaction Editor located on the right side above the transaction grid. The New 
Transaction section appears at the bottom of the Register section. If the Transfer section is 
displayed instead, click New Transaction. 

5. If you prefer to create the new transaction in a table format, click Table Format. Clicking Table 
Format displays the Bank Account Manager Transactions dialog. The steps below apply to the 
New Transaction section and the Bank Account Manager Transactions dialog. 

6. Select the Type of transaction you are creating. The types are: 
 
F) Bank Fee - The fees charged your company for this account. 
 
I) Interest Income - The interest you earn on this account. 
 
M) Misc Adjustment - For example, if the bank incorrectly assesses you a fee or finance charge, 
you can create a miscellaneous adjustment to correct the error. 
  

7. In Acct #, select the general ledger account affected by the new transaction. 

8. In Profit Center, select your location associated with this transaction. 

9. In Bank Location, select the profit center associated with the bank. 

10. In Ref #, type a reference number for this transaction. 
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11. Enter the Date this transaction was created. 

12. In Amount, enter the amount of the transaction. Net Change displays the amount the account has 
changed. If this amount appears in parentheses, it is subtracted from the account. Otherwise, it is 
added to the account. 

13. In Payee, enter the person or company you are paying with the transaction. 

14. In Memo, type additional information about the transaction. 

15. When you are ready to post, click Post. If you are in the Bank Account Manager Transactions 
dialog, choose Post from the Actions menu.  When you select Post the system displays a message 
indicating the post transaction is in progress. 
 
If you want delete the transaction information instead of post it, click Clear. 

Transferring Funds 

The Bank Account Manager allows you to moves funds from one bank account to another. 

To transfer funds: 

1. Open the Bank Account Manager (Transactions>General Ledger>Bank Account Manager) then 
click the Register tab to display the Register section. 

2. Select Transaction Editor. 

3. At the bottom of the Register section, click Transfer to display the Transfer section. 

4. Complete the From Account group box as follows: 
 
Bank # is the bank that the funds are being transferred from. After you select a bank, its currency 
is displayed. 
 
Profit Ctr is the profit center associated with the bank that is transferring the funds. 
  

5. Complete the To Account group box as follows: 
 
Bank # is the bank you are transferring the funds to. 
 
Profit Ctr is the profit center associated with the bank that is receiving the transfer. 
  

6. Enter the Date of the transfer. 

7. Enter the Amount of the transfer. 

8. If you want to include additional information, type it in Memo. 

9. When you are ready to post, click Post. 
 
If you want delete the transfer information instead of post it, click Clear. 
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General Ledger Journals 
In Enspire, a journal is a record of current transactions. General ledger journals allow you to group 
specific types of Enspire transactions. For example, all payments are recorded in the APCK (A/P 
Payments) Journal. All inventory adjustments are recorded in the IVAJ (I/V Adjustments) Journal. 
Grouping like transactions in the same journal makes it easy to analyze specific information and 
generate meaningful reports. 

General ledger journals fall into two categories: reserved and manual. Reserved journals are 
provided with Enspire and cannot be modified or deleted. They are reserved for automatic journal 
entries created automatically by posting transactions within the application. 

Manual journals are journals you create to handle specific transactions not covered by the reserved 
journals. You must create at least one manual journal before you can set up a recurring journal 
entry. Recurring journals are based on a selected manual journal. 

Creating a Manual Journal 
1. Open the Journal Type Maintenance dialog (File Maintenance>General Ledger> 

Journals). This dialog contains both reserved and manual journals. 

 

2. From the File menu, choose New. 

3. In Journal, type the code that identifies the journal. This code is alphanumeric and can 
be up to four characters long. 

4. In Description, type the description of the journal. 

Is Reserved and Is Batch Journal are not available to the manual journals you create. 

5. From the File menu, choose Save. 

Setting Up a Recurring Journal Entry 
A recurring journal entry is a journal entry that you make on a regular basis, such as monthly, bi-
monthly, quarterly, semi-annually, or annually. Each period, Enspire automatically records the 
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recurring journal entries in the appropriate journal. You can add a recurring journal entry only to 
manual journals. You cannot add a recurring journal entry to a reserved journal. 

To set up a recurring journal entry: 

1. Open the Recurring Journal Entry Maintenance dialog (File Maintenance> General 
Ledger>Recurring Journal Entries). 

 

2. From the File menu, choose New. 

3. In the Journal Type group box, select a type. The type you select determines the fields 
that are available. This procedure used the Fixed type. The types are: 

Allocation uses fixed percentages and variable amounts. When the recurring journal 
entry is released, you provide the total amount to be allocated. The appropriate accounts 
are debited or credited a pre-determined portion of the allocated amount. 

Fixed uses the same debit or credit amount each time the journal entry is released. 

Variable uses a variable amount. When the recurring journal entry is released, you 
provide the amount. 

4. In Recur Set, type the code that identifies the recurring journal entry. This code is 
alphanumeric and can be up to eight characters long. 

5. In Recur Description, type the description of the recurring journal entry. 

6. In Journal, select the manual journal where the entry will be made. 

7. In Source Code, type a source code for this entry. This code is used for informational 
and reporting purposes. It is alphanumeric and can be up to eight characters long. 
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8. If the entry is a reversing entry, select Is Reversed then type a Reverse Description and 
a Reverse Source Code. 

Is Reversed determines whether the recurring journal entry is reversed when the month 
is closed. Reversed entries are typically used for revenues, expenses, and liabilities that 
partially accrue during the current accounting period, but are not fully accounted for until 
the next period. Entries are automatically reversed when the month is closed. 

9. In Location, select the location that the recurring journal applies to. 

10. In Acct No, select the number of the account debited or credited by the recurring journal 
entry. 

11. In Debit Amt, type the amount that the account is debited. 

12. In Credit Amt, type the amount that the account is credited. 

13. Set the release parameters. 

In the Property View, Release 1 – Release 13 determine whether the recurring journal 
entry will be released during that period. Select Y if the entry will be released during that 
period. Select N if the entry will not be released during that period. D indicates that the 
entry has already been released for the period. 

14. When Total Balance equals $0.00, you can save the entry. To save it, choose Save from 
the File menu. 

Releasing a Recurring Journal Entry 
When you release a recurring journal entry, Enspire credits or debits the general ledger accounts 
affected by the entry. You release recurring journal entries by type. The procedure below releases 
recurring journal entries that have a type of Fixed. For information on releasing Allocation and 
Variable recurring journal entries, see the Enspire online help. 

To release Fixed recurring journal entries: 

1. Open the Recurring Journal Entry Release dialog (Transactions>General 
Ledger>Recurring Release). 

2. In the Journal Type group box, select Fixed. 

3. Click Post. 

4. In the Post dialog, select whether you want to post only the selected entry or all entries of 
the selected journal type. 

 

5. Click OK. 
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Distributing payroll amounts 

If you use a payroll service to pay your employees, Payroll allows you to identify and distribute to your 
general ledger the amount you paid each employee. To use Payroll, you must have your employees set up 
in Enspire. 

1. Open the GL Payroll dialog (Transactions>General Ledger>Payroll). 

2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. If 
necessary, type a different Batch Description, then click OK. 

3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. Select 
the batch you want to open, then click OK. 

4. In Bank # select the bank that processes your payroll check. 
 
Account # displays your account number at the bank. 
 
Name displays the full name of the selected bank. 
  

5. Select a Profit Center. The cash account associated with this profit center will be credited the 
amount of the payroll check. 

6. Select the Frequency of the payroll checks you are distributing. For example, if you are 
distributing checks to employees you pay every week, select Weekly. 

7. Enter a Payment Date. This is the date you distribute the payroll check. 

8. If you want to define the pay period, enter a Pay Period Begin Date and a Pay Period End Date. 
 
Pay Period Begin Date is the first date included in this pay period. Pay Period End Date is the 
last date included in this period. 
  

9. From the Actions menu, choose Load Employees to retrieve employees into the GL Transactions 
grid. 

10. Complete the grid as follows. 
 
Acct # is the general ledger account affected by this payroll transaction. 
 
Description displays the description of the account. 
 
Profit Center is the profit center that will be debited the specified Amount. 
 
Description allows you to type a description of this transaction. 
 
Amount is the amount of the payroll check to be distributed to the selected account and profit 
center. 
  

11. Click in the Payroll Checks grid then press the INSERT key on your keyboard. Complete the 
Payroll Checks grid as follows: 
 
Check # is the number of the check you are distributing. This number is not the number of the 
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payroll check that the employee receives. 
 
Employee # is the number of the employee included in the payroll distribution. 
 
Last Name and First Name display the name of the selected employee. 
 
Profit Center is the location where the employee works. 
 
Pay Freq displays the frequency with which you pay the employee. 
 
Check Amount is the net amount paid to the employee. This amount does not include any 
deductions, such as tax, 401k, and insurance, withheld from the employee's pay. 
  

12. When you have finished creating payroll entries, you can save the batch or choose Post to post it. 
If you save the batch without posting it, you can modify it at a later time. 
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Setting up a budget 

Budgets give you the ability to compare the projected budgets to actual account balances for any or all of 
your profit centers. In Enspire, you have several different options for creating budgets. You can type in 
separate amounts for each period, use the same amount for all periods, base the current budget on the 
previous year's actuals, or change an existing budget by a specified amount or percentage. 

To set up a budget 

1. Open the Budget Maintenance dialog (File Maintenance>General Ledger>Budgets). 

2. To create a new budget, choose New from the File menu. Complete the New Budget dialog as 
follows: 
 
Budget Code is the code that identifies the budget. This code is alphanumeric and can be up to 
eight characters long. 
 
Description is the description of the new budget. 
 
Profit Center is the profit center you are creating the budget for. 
 
Account Type determines the type of account you are creating the budget for. For example, if you 
select Profit & Loss, the budget you create applies only to profit and loss accounts. 
 
Acctg Year is the accounting year you are creating the budget for. 
 
Click OK to accept the settings and close the New Budget dialog. 
  

3. To open an existing budget, select the Budget Code you want to open. 

4. Click the tab that represents the type of budget you want to set up, then complete the information 
in that section. Steps for completing each section are described below. 

5. After you create a budget, choose Save from the File menu. 

Change by Specified Amount  

This type allows you to increase or decrease the amount of each period's budget for the selected account by 
the same amount. To create this type of budget: 

1. Click the Change by Specified Amount tab. 

2. In the Budget grid, select the Location and Account combination you are changing the budget 
amount for. 

3. In Amount, type the amount by which you want to change each period's budget. To increase the 
amount, simply type the amount. To decrease the amount, type a negative sign (-) in front of the 
amount. 

4. Click Execute to calculate the budget. 

Change by Specified Percentage  
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This type allows you to increase or decrease the amount of each period's budget for the selected account by 
the same percentage. To create this type of budget: 

1. Click the Change by Specified Percentage tab. 

2. In the Budget grid, select the Location and Account combination you are changing the budget 
amount for. 

3. In Percentage, type the percentage by which you want to change each period's budget. To 
increase the percentage, simply type the percentage. To decrease the percentage, type a negative 
sign (-) in front of the percentage. 

4. Click Execute to calculate the budget. 

Specify Annual Budget 

This type allows you to type a specific amount for each period and have that amount deducted from the 
annual budget. To create this type of budget: 

1. Click the Specify Annual Budget tab. 

2. In Amount, type the amount of the annual budget. 

3. Under 1, type the budget for the first period. Under 2, type the budget for the second period, and 
so on. As you type each period's budget, Enspire keeps a running total of the remaining annual 
budget. 

4. Click Execute to calculate the budget. 

Equal Amount Inserted Each Month 

This type assigns the same amount to each period. To create this type of budget: 

1. Click the Equal Amount Inserted Each Period tab. 

2. In the Budget grid, select the Location and Account combination you are changing the budget 
amount for. 

3. In Amount, type the budget amount you want to assign to each period. 

4. Click Execute to calculate the budget. 

Import Last Year's Actuals 

This type imports the previous year's amounts, per period per G/L account, and uses that as the current 
budget. To create this type of budget: 

1. Click the Import Last Year's Actuals tab. 

2. Click Execute Import of Last Year's Actuals to import the information. 

Import Current Year's Actuals 

This type imports the current amounts so far this year, per period per G/L account, and uses that as the 
current budget. To create this type of budget: 

Version 7.3.2.0 Getting Started  4-27 



General Ledger  Setting up a budget 

1. Click the Import Current Year's Actuals tab. 

2. Click Execute Import of Current Year Actuals to import the information. 

Manual Entry 

This type allows you to enter the budget amount for each period's budget for the selected account. To create 
this type of budget: 

1. Click the Manual Entry tab. 

2. In the Budget grid, select the Location and Account combination you are creating the budget for. 

3. In Period 1, type the budget amount for the first period. In Period 2, type the budget amount for 
the second period, and so on. 
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About this Chapter 
This chapter covers the basics for setting up your warehouses and items. It also includes 
information on the Enspire inventory costing methods, units of measure, and pricing hierarchy. 

Inventory Costing Methods 
The inventory costing method you use determines how Enspire figures the value of your inventory 
for accounting purposes, invoices, and calculating margins. The selected method is also used as 
the basis for calculating an item’s actual cost. 

The inventory costing methods are: 

FIFO (First-In-First-Out) 

LIFO (Last-In-First-Out) 

Weighted Average 

FIFO (First-In-First-Out) 
This method uses the incoming unit cost of the oldest quantity on hand. If the quantity in the 
transaction exceeds the oldest on-hand quantity, Enspire uses the cost of the next oldest item for 
the remainder of the stock required to fill the transaction. For example: Two weeks ago you 
purchased 100 items for a cost of $1.00 each. One week later you purchased an additional 100 of 
the same item for $.90 each. Now, you have an order for 150. Using FIFO, the cost per unit for the 
first 100 items is $1.00 and the cost per unit for the other 50 is $.90. 

LIFO (Last-In-First-Out) 
This method uses the incoming unit cost of the most recent purchase of an item. If the quantity in 
the transaction exceeds the quantity of your most recent purchase, Enspire uses the cost of the next 
oldest item for the remainder of the stock required to fill the transaction. For example: Two weeks 
ago you purchased 100 items for a cost of $1.00 each. One week later you purchased an additional 
100 of the same item for $.90 each. Now, you have an order for 150. Using LIFO, the cost per unit 
for the first 100 items is $.90 and the cost per unit for the other 50 is $1.00. 

Weighted Average 
This method uses the average unit costs of existing inventory. Each time an item’s on-hand 
quantity increases, Enspire recalculates the weighted average. Enspire starts with the value of the 
existing on-hand quantity (quantity * cost), adds the value of the incoming quantity, then divides 
by the new on-hand quantity. The resulting weighted average cost is assigned to each item. For 
example: Two weeks ago you purchased 100 items for a cost of $1.00 each. One week later you 
purchased an additional 100 of the same item for $.90 each. Now, you have an order for 150. 
Using Weighted Average, the cost per unit for the 150 items is $.95. (100 * $1.00) + (100 * $.90) 
= $190.00. $190.00 (total cost) / 200 (on-hand quantity) = $.95 (average unit cost). 

Units of Measure 
An item’s unit of measure identifies how it is stocked, purchased, and sold. Enspire includes the 
following units of measure. 

SKU UM – The SKU unit of measure is typically the lowest unit of measure for the item. If 
you allow fractional quantities for an item, it may have a unit of measure smaller than its 
SKU. The SKU unit of measure is extremely important. Enspire uses it when you enter 
physical counts and to display all inventory quantities. Enspire also uses the SKU unit of 
measure to store all costs, prices, and quantities for the item. All other units of measure 
are defined based on the SKU unit of measure. 
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Amount UM – The Amount unit of measure (AUM) is used to display an item’s unit prices 
and costs.  

Quantity UM – The Quantity unit of measure (QUM) is the unit of measure in which you 
order and/or sell an item. 

In the example below from Order Entry, the quantity unit of measure (QUM) for the first item is 
feet (FT) and its amount unit of measure (AUM) is C, which stands for 100 feet. Therefore, the 
order quantity is 14,500 feet at a price of $12.98 per 100 feet. If the QUM were C and the AUM 
were FT, the order would be 1,450,000 feet (14,500 X 100) at a price of $12.98 per foot. 

 

Converting Units of Measure 
When you convert units of measure, you identify the number of SKU units in a single amount unit 
of measure and the number of SKU units in a single quantity unit of measure. For example, if the 
SKU unit of measure is Ounce and the QUM is Pound, the conversion rate is 16 (16 ounces in a 
pound). If the SKU unit of measure is Each and the AUM is Case, the conversion rate is the 
number of Eaches per Case. If a Case contains 10 Eaches, the conversion rate is 10. The 
conversion rate is 1 if the AUM or the QUM equals the SKU unit of measure. You convert units 
of measure in the Pricing section of the Item Master dialog and the Controls section of the Item 
Vendor Maintenance dialog. For information on these dialogs, see the Enspire online help. 

Pricing Hierarchy 
The pricing hierarchy in Enspire determines the price charged a given customer for a given item. 
Enspire applies item prices in the order listed below. Information on setting up each of these 
pricing capabilities is available in the Enspire online help. 

1. Promotional Pricing – If no promotions exist for an item, Enspire searches for a contract 
price. 

2. Contract Priority – Enspire searches all contracts associated with the customer based on 
the priority assigned to each contract. 

3. Quantity Price – This method uses the price in the appropriate quantity price bracket. 

4. Product Group – This method calculates the price based on the item’s product group. 

5. Price Column – This method uses the price from the appropriate price column. 

6. List Price – This method uses the list price as set in the Item Master dialog. 

Enspire searches the hierarchy and stops when a price is found. For example, if an item has 
promotional pricing, Enspire applies that price and does not search further, even though a price 
later in the hierarchy may be lower. However, in the Codes section of the ShipTo Locations 
dialog, Auto Select Best Price Applicable to this Location ensures that a customer always 
receives the lowest price, no matter where it appears in the hierarchy. See the online help for more 
information on this option. 

Replenishment Paths  

Replenishment paths allow you to identify the primary source of replenishment for stocked items. If a 
source for replenishment is one of your warehouses, the replenishment path can help prevent inefficient 
inventory movement related to non-recurring transfers between warehouses. You select a replenishment 
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path for an item in the Reorder section of the Warehouse Item Master dialog. A replenishment path can be 
either a vendor, a different warehouse, or an assembly. 

• Vendor - Selecting a vendor as the replenishment path identifies that vendor as your typical source 
of replenishment for the item. 

• Warehouse - You should create a replenishment path for each warehouse that serves as a 
supplying warehouse for one or more other warehouses. For example, you have a central 
warehouse that purchases items and transfers them to several branch warehouses when necessary. 
Assigning the central warehouse as the replenishment path allows the replenishment process to 
build transfers instead of purchase orders for those items. 

• Assembly - An assembly replenishment path is used for stocked kits to indicate that they are 
assembled from other inventory items, not replenished from an external source. To create an 
assembly replenishment path, select your home warehouse as both the destination warehouse and 
source warehouse. 

To add a replenishment path: 

1. Open the Replenishment Path Maintenance dialog (File Maintenance>Inventory>Replenishment 
Paths). 

2. From the File menu, choose New. 

3. In Path Code, type a code that identifies the replenishment path. This code is alphanumeric and 
can be up to eight characters long. 

4. In Description, type a description of the replenishment path. 

5. If you are adding a vendor as the replenishment path, select a Vendor. If a warehouse is the 
replenishment path, leave Vendor blank. 
 
Vendor Name displays the name of the selected vendor. 
  

6. If you are adding a transfer warehouse as the replenishment path, enter a Transfer Markup. This 
markup is the percentage applied to the cost of the item to determine the cost of transferring it 
from the source warehouse to the destination warehouse. Specifying a markup percentage creates 
income for the source warehouse and results in a higher capitalized cost for the destination 
warehouse. If you do not want to specify a markup, leave Transfer Markup blank. 

7. If you are adding a transfer warehouse as the replenishment path and you want to maintain lead 
time statistics, select Track Transfer. Leave this option unselected if you want to maintain the 
lead times manually. 

8. If you are adding a transfer warehouse as the replenishment path, enter the number of Transfer 
Lead Days. This option is the number of days required to transfer the item from the source 
warehouse to the destination warehouse. 

9. If you are adding a transfer warehouse as the replenishment path, select a Source Warehouse. 
This warehouse is the one that supplies the item to the destination warehouse selected in Dest 
Warehouse. If a vendor supplies the item, do not select a Source Warehouse. 

10. Select a Dest Warehouse. This warehouse is the one that receives the item or items associated 
with the replenishment path. If you are setting up an assembly replenishment path, the destination 
warehouse must be the same as the source warehouse. 
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11. From the File menu, choose Save.  

 Service Oriented Replenishment  

On the Inventory tab of the CO Miscellaneous Control File program, the Use 
Service Oriented Replenishment checkbox enables Service Oriented 
Replenishment at the company level. This option will be disabled by default. 

Service Oriented Replenishment, now allows calculating the suggested order 
quantity based on a formula to keep the suggested quantity to an optimal value, 
which will avoid either ordering too much or ordering not enough quantities. 

The Service Oriented Replenishment option: 

• applies for the warehouse Items with reorder method as ‘C’ – Class or ‘Q’ – EOQ.  
• will not validate for the item class to be within class 4, rather it will consider 

items from class 1 to class 12. 
• will always override the existing line point based calculations for the items with 

reorder method as C or Q. 

The Service Oriented Replenishment logic to calculate the suggested order 
quantity is as follows:  

When the value of the Line Point Quantity minus the Net Available Quantity is 
greater than the Enspire Order Quantity then the system will consider the 
Suggested Order Quantity as the Line Point Quantity minus the Net Available 
Quantity.  Otherwise it will use the Enspire Order Quantity as the Suggested 
Order Quantity.  

Note that the System will not perform any modifications to the Order Quantity on 
the following conditions: 

1. The order quantity is increased by the current backlog for stock orders (S lines). 
Since X number of items are already committed, it makes sense to increase the 
purchase amount by this quantity so that your available stock can be roughly as 
intended after the immediate fills of open orders during receiving. This also 
ensures that the order quantity is always at least enough to fill the current backlog. 

2. The order quantity is decreased by the quantity currently on order for stock 
purchases (S lines). Since X numbers of items are already on order, the system 
decreases the order quantity by that amount to ensure that double-ordering. 

The following built-in “common sense” checks will not be performed on every 
order quantity calculated. The order quantity will not be automatically adjusted 
accordingly if any of the following conditions are encountered. 

1. The recommended order quantity will not exceed the Line Point + Order 
Quantity.  
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2. If the item does not have a defined shelf life, the order quantity never exceeds a 1 
year supply. If there is a shelf life, the maximum order quantity is the expected 
amount that will be sold within the shelf life of the product. 

3. The order quantity must be at least enough to last for one review cycle based on 
expected usage. 

4. The order quantity must be at least a two weeks' supply based on expected usage. 
5. The order quantity must be at least equivalent to one “standard pack” as defined 

in the Item/Vendor record. 
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Usage Formulas 

Inventory usage formulas match your buying habits to replenishment calculations for each item that you 
stock. Enspire includes separate formulas for seasonal and nonseasonal items. During replenishment, 
Enspire applies each of the formulas to an item and then determines the best replenishment amount based 
on the accuracy of each formula's past performance when calculating replenishment for the item. Enspire 
automatically uses the formula with the smallest average variance between the recommended 
replenishment quantity and your actual usage for the item.  

Each of the formula descriptions in this topic refer to the table below. Period 1 is the most recently 
completed period, period 2 is the next most recently completed period, and so on. 

Period 1 2 3 4 5 6 
Usage 80 84 76 58 54 49 

  

Some of the formulas described below use a nonseasonal or a seasonal trend factor. 

• Nonseasonal Trend Factor - The average increase or decrease in usage during the previous 
inventory periods as specified in Trend Months. For example, if Trend Months is 4 and usage 
increased by 20 percent during the previous four periods, Enspire adds 20 percent to the 
calculation. Therefore, if the replenishment calculation is 200 before applying the trend, the actual 
replenishment including the trend is 240 (20 percent of 200 is 40). If usage decreased by 20 
percent, Enspire subtracts 20 percent from the calculation. 

• Seasonal Trend Factor - The difference in usage between the previous inventory periods of this 
year, as specified in Trend Months, and the same inventory periods last year. For example, if 
Trend Months is 3 and you sold 20 more items this year than during the same three periods last 
year, Enspire adds 20 to the calculation. If you sold 20 fewer items this year than during the same 
three periods last year, Enspire subtracts 20 from the calculation. 

The formulas are as follows: 

• 3-WT-0   Weighted Std 5.0/2.0/1.0 - This formula applies to nonseasonal items. It calculates a 
weighted average usage for the previous three periods. The usage in period 1 is multiplied by 5. 
The usage in period 2 is multiplied by 2. The usage in period 3 is multiplied by 1. These amounts 
are then added together and the sum is divided by the total weight used in the calculation, which is 
8 (5+2+1). Periods 4, 5, and 6 are ignored. Using the table above, the replenishment calculated by 
this formula is 80.5, which is rounded to 81. (80x5=400. 84x2=168. 76x1=76. 400+168+76=644. 
644/8=80.5.) 

• 3-EVEN-3   Weighted Sea 1.0/1.0/1.0 + Sea Trend - This formula applies to seasonal items. It 
averages the usage recorded the previous year in the period you are calculating replenishment for 
and the following two periods. The weight applied to each of those three periods is 1. Therefore, 
the actual usage is used in the calculation. After calculating the average, Enspire applies the 
Seasonal Trend Factor. 

• 5-WT-4   Weighted Std 3.0/2.5/2.0/1.5/1.0 + Trend - This formula applies to nonseasonal items. 
It calculates a weighted average usage for the previous five periods then adds the Nonseasonal 
Trend Factor. The usage in period 1 is multiplied by 3. The usage in period 2 is multiplied by 2.5. 
The usage in period 3 is multiplied by 2. The usage in period 4 is multiplied by 1.5. The usage in 
period 5 is multiplied by 1. The usage in period 3 is multiplied by 1. These amounts are then 
added together and the sum is divided by the total weight used in the calculation, which is 10 
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(3+2.5+2+1.5+1). Period 6 is ignored. Using the table above, the replenishment calculated by this 
formula is 74.3, which is rounded to 75. (80x3=240. 84x2.5=210. 76x2=152. 58x1.5=87. 
54x1=54. 240+210+152+87+54=743. 743/10=74.3.) The Nonseasonal Trend Factor is added to 
75. 

• 3-EVEN-0   Year Ago Upcoming 3 Months - This formula applies to seasonal items. It averages 
the usage recorded the previous year in the period you are calculating replenishment for and the 
following two periods. That average is used as the replenishment quantity. No seasonal trend is 
applied. 

• 1-EVEN-3   Weighted Sea 1.0 + Sea Trend - This formula applies to seasonal items. It applies 
the Seasonal Trend Factor to the usage recorded the previous year during the period you are 
calculating replenishment for. 

• 2-WT-2   Weighted Sea 2.0/1.0 - This formula applies to seasonal items. It calculates a weighted 
average of the usage recorded the previous year in the period you are calculating replenishment for 
and the following period. The usage in period 1 is multiplied by 2. The usage in period 2 is 
multiplied by 1. These amounts are then added together and the sum is divided by the total weight 
used in the calculation, which is 3 (2+1). Using the table above, the replenishment calculated by 
this formula is 81.3, which is rounded to 82. (80x2=160. 84x1=84. 160+84=244. 244/3=81.3.) No 
seasonal trend is applied. 

• 6-EVEN-0   Six Month Rolling Average - This formula applies to nonseasonal items. It 
calculates the average usage recorded during the previous six periods. Using the table above, the 
replenishment calculated by this formula is 66.83, which is rounded to 67. 
(80+84+76+58+54+49=401. 401/6=66.83.) 

• 6-EVEN-4   Six Month Rolling Average w/4 Trend - This formula applies to nonseasonal items. 
It calculates the average usage recorded during the previous six periods then adds the Nonseasonal 
Trend Factor. Using the table above, the six month rolling average is 66.83, which is rounded to 
67. (80+84+76+58+54+49=401. 401/6=66.83.) The Nonseasonal Trend Factor is added to 67. 

• 3-EVEN-4   Three Month Rolling Avg w/4 Trend - This formula applies to nonseasonal items. 
It calculates the average usage recorded during the previous three periods then adds the 
Nonseasonal Trend Factor. Using the table above, the three month rolling average is 80. 
(80+84+76=240. 240/3=80.) The Nonseasonal Trend Factor is added to 80. 

• 3-EVEN-0   Three Month Rolling Average - This formula applies to nonseasonal items. It 
calculates the average usage recorded during the previous three periods. Using the table above, the 
replenishment calculated by this formula is 80. (80+84+76=240. 240/3=80.) 

• 2-WT-3   Weighted Sea 2.0/1.0 + Sea Trend - This formula applies to seasonal items.  It 
calculates a weighted average of the usage recorded the previous year in the period you are 
calculating replenishment for and the following period. The usage in period 1 is multiplied by 2. 
The usage in period 2 is multiplied by 1. These amounts are then added together and the sum is 
divided by the total weight used in the calculation, which is 3 (2+1). Using the table above, the 
replenishment calculated by this formula is 81.3, which is rounded to 82. (80x2=160. 84x1=84. 
160+84=244. 244/3=81.3.) The Seasonal Trend Factor is then added to 82. 

• 2-WT2-3   Weighted Sea 4.0/1.0 + Sea Trend - This formula applies to seasonal items.  It 
calculates a weighted average of the usage recorded the previous year in the period you are 
calculating replenishment for and the following period. The usage in period 1 is multiplied by 4. 
The usage in period 2 is multiplied by 1. These amounts are then added together and the sum is 
divided by the total weight used in the calculation, which is 5 (4+1). Using the table above, the 
replenishment calculated by this formula is 80.8, which is rounded to 81. (80x4=320. 84x1=84. 
320+84=404. 404/5=80.8.) The Seasonal Trend Factor is then added to 81. 
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• 5-WT-0   Weighted Std 3.0/2.5/2.0/1.5/1.0 - This formula applies to nonseasonal items. It 
calculates a weighted average usage for the previous five periods. The usage in period 1 is 
multiplied by 3. The usage in period 2 is multiplied by 2.5. The usage in period 3 is multiplied by 
2. The usage in period 4 is multiplied by 1.5. The usage in period 5 is multiplied by 1. The usage 
in period 3 is multiplied by 1. These amounts are then added together and the sum is divided by 
the total weight used in the calculation, which is 10 (3+2.5+2+1.5+1). Period 6 is ignored. Using 
the table above, the replenishment calculated by this formula is 74.3, which is rounded to 75. 
(80x3=240. 84x2.5=210. 76x2=152. 58x1.5=87. 54x1=54. 240+210+152+87+54=743. 
743/10=74.3.) 

Adding a Usage Formula 

The usage formulas provided with Enspire are sufficient to calculate accurate replenishment levels. 
However, if you want to add a usage formula of your own, follow the steps below. 

1. Open the Usage Formula dialog (File Maintenance>Inventory>Usage Formulas). 

2. From the File menu, choose New. 

3. Type a Code that identifies the formula. This code is alphanumeric and can be up to eight 
characters long. 

4. In Item Type, select whether the formula applies to Seasonal or Nonseasonal items. 

5. Type a Description of the code. 

6. System remains unselected because this usage formula is user-defined. 

7. In Trend Months, enter the number of months included in trend calculations. For more 
information, see the Seasonal Trend Factor and Nonseasonal Trend Factor definitions in the Usage 
Formula topic. 

8. In Month 1 through Month 6, enter the weight you want to apply to each month. A weight of 0 
(zero) indicates that month is not included in the replenishment calculation. For information on 
weights that are applied, see the definitions of the formulas in the Usage Formula topic. 

9. From the File menu, choose Save. 

To create a usage adjustment: 

1. Open the Usage & Freeze Adjustments dialog (Transactions>Inventory>Usage Freeze 
Adjustments). 

2. In the Filters group box, select the filter or filters that you want to apply.  
3. From the Actions menu, choose Fetch. After you choose Fetch, the Items grid contains the items 

that met your filtering criteria. 
4. In the Items grid, select Sel for the item that you want to create a usage adjustment for.  
5. In the Usage grid, type an Adjusted Amount and select a Adjust Code. If Usage grid is not 

displayed, click the Usage tab.  
 
Adjusted is the quantity that you are adjusting the usage to. For example, if the actual usage is 10 
and you want to adjust the usage to 25, you type 25 in Adjusted. 
 
Adjust Code is the reason for the usage adjustment. 
  

6. Repeat step 4 and step 5 for each item you want to create a usage adjustment for. 
7. From the File menu, choose Save (CTRL+S). 
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Frozen Items 

When an item is frozen, Enspire does not calculate reordering controls for that item. The item will appear 
on replenishment worksheets and all purchasing functionality applies. However, you must set the 
reordering controls manually. The Usage & Freeze Adjustments dialog allows you to view the items that 
are frozen for the current month or the previous month. You can also change the reason for freezing the 
item as well as reset the item's reordering controls. 

To view frozen items and change the freeze code if necessary: 

1. Open the Usage & Freeze Adjustments dialog (Transactions>Inventory>Usage Freeze 
Adjustments). 

2. In the Filters group box, select the filter or filters that you want to apply.  
3. From the Actions menu, choose Fetch. After you choose Fetch, the Items grid contains the items 

that met your filtering criteria. 
4. If necessary, make any changes to an item in the Items grid.  
5. From the File menu, choose Save. 

Disabling Item Freezes in Reorder Control Calculation 

When Enspire finds a sporadic usage of an item it sets the item to freeze code of ‘P’ – permanent freeze and 
the reorder method of the item will be modified to ‘M’ Min/Max from any other reorder types (Will not 
modify the ‘D’ Do not re order types). 

Item Freezes can be disabled during the reorder control calculations during the month end process or during 
the manual reorder control calculation process. 

On the Inventory tab of the CO Miscellaneous Control File program, the Disable Item Freezes in Reorder 
Control Calculation checkbox is available to disable item freezes during the reorder control calculations 
during the month end process or during the manual reorder control calculation process at the company 
level. This option will be disabled by default. 

The system will not perform the above operation when the new option “Disable Item Freezes in Reorder 
Control Calculation” is set to true since there is no sporadic freeze conditions check with this option. 

Enspire will perform the following actions on the reorder control calculation only when there is no manual 
freeze, Permanent freeze or new item Freeze: 

• Update the optimized usage formula based if the option “Auto Set Usage Formula” is set to true and if the 
item is non seasonal. 

• Monthly usage based on the usage forecast. 

• Daily usage based on the above monthly usage and business days in the forecast period. 

• Calculate Lead time, Line Point, Order Point and EOQ for item with reorder method in 'C', 'M', 'Q' and 
'S'  without any of Item class restrictions. 
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Setting Up a Warehouse 
In Enspire, a warehouse refers to each of your company’s stocking and shipping locations. For 
example, if you have one main warehouse that feeds two branch warehouses, you need to set up 
three warehouse in Enspire. 

NOTE The sample dialog in step 1 below displays Not Home Warehouse. 
This message indicates that the warehouse selected in the Warehouse 
grid is not the default warehouse assigned to the current user. You 
assign a home warehouse to a user in Whse Code in the User Profile 
dialog (File Maintenance>System>User Profile). 

To set up a warehouse: 

1. Open the Warehouse Maintenance dialog (File Maintenance>Inventory> Warehouse). 

 

2. From the File menu, choose New. 

3. Complete the Warehouse grid as follows: 

Warehouse is the code that identifies the warehouse in Enspire. This code is 
alphanumeric and can be up to eight characters long. 

Warehouse Name is the full name of the warehouse. 

Customer No allows you to assign a customer to the warehouse. 

ShipTo allows you to assign one of the selected customer’s ship-to locations to the 
warehouse. If you leave ShipTo blank, all of the selected customer’s ship-to locations are 
assigned to the warehouse. 

4. In the Address section, double click in the Demographics area to display the Warehouse 
Address dialog. In this dialog, type the general warehouse information including address, 
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phone and fax numbers, email address and web address. After you type this information, 
click OK to close the Warehouse Address dialog. 

5. Click the Information tab and complete that information as described below. 

 

Manager is the name of the warehouse manager. Whenever manual fills must be 
performed, Enspire automatically sends an email to the user selected here. 

Credit Manager is the name of the credit manager at the warehouse. Whenever orders 
are placed on a credit hold, Enspire automatically sends an email to the user selected 
here. 

Dun and Bradstreet is the Dun and Bradstreet number for the warehouse. 

Profit Center is the profit center where transactions involving this warehouse are posted. 

Buyer is the default buyer for the warehouse. During replenishment, the buyer selected 
here is used if no buyer is assigned to the item being replenished or to that item’s vendor. 

Markup is the markup percentage applied when this warehouse receives a transfer from 
a different warehouse. For example, if the markup is 1, this warehouse is charged an extra 
1 percent per unit cost for the items being transferred. The markup percentage of an 
applicable warehouse-to-warehouse replenishment path overrides the markup percentage 
specified here. 

Work Schedule identifies the work week for the warehouse. You create work schedules 
in the Workday Schedules dialog (File Maintenance> Company>Workday Schedules). 

Bank is the bank where point-of-sale receipts are deposited. 

The Commit Level Times group box determines the time of day when orders are 
considered commit level One or commit level Two. An order taken between the time of 
day established in One and the time of day established in Two is considered a commit 
level 1. An order taken after the time established in Two is considered a commit level 2. 
For example: The time in One is 6:00 AM. The time in Two is 5:00 PM. An order taken 
between 6:00 AM and 5:00 PM is a level 1. An order taken between 5:01 PM and 5:59 
AM is a level 2. 

Printer Group is the printer group assigned to this warehouse. For information on 
printer groups, see the Enspire Environment chapter. 
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6. Click the Balance Sheet Accounts tab and complete that information as described below. 
 
These accounts are used in the automatic journal entries and therefore the account 
selection made here needs to be accurate. Consult with your accountant to ensure that you 
are selecting the appropriate GL account. 

 

Intra-Company Receivables identifies the balance sheet account where transfer 
accounts receivable are debited.  Select  to access the the GL Master Account 
Lookup. 

Intra-Company Payables identifies the balance sheet account where transfer accounts 
payable are credited. Select  to access the the GL Master Account Lookup. 

7. Click the Profit & Loss Accounts tab and complete that information as described below. 
 
These accounts are used in the automatic journal entries and therefore the account 
selection made here needs to be accurate. Consult with your accountant to ensure that you 
are selecting the appropriate GL account. 

 

Income identifies the profit and loss account where income, typically handling fees, from 
transfers is credited. Select  to access the the GL Master Account Lookup. 

Expense identifies the profit and loss account where expenses, typically handling fees, 
generated by transfers are debited. Select  to access the the GL Master Account 
Lookup. 

Freight identifies the profit and loss account where freight income generated by transfers 
is credited and freight expenses are debited. Select  to access the the GL Master 
Account Lookup. 

8. From the File menu, choose Save. 
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Setting Up a Family Discount 
A family allows you to grant discounts based on the price, units, weight, or volume of items on an 
order that belong to the same family. Family discounts are applied after any other pricing method 
for an individual item, such as quantity tables, price columns, and group pricing. To avoid double 
discounting when items are priced using promotions and/or contracts, you can disable family 
discounts. The family discount code is then assigned to an item master. 

To set up a family discount: 

1. Open the Family Maintenance dialog (File Maintenance>Inventory>Families). 

 

2. From the File menu, choose New. 

3. Complete the Family grid as follows: 

Family is the code that identifies the family discount pricing table. This code is 
alphanumeric and can be up to four characters long. 

Description is the description of the family. 

Min Buy is the lowest amount that can be purchased to qualify for a discount associated 
with the selected family. 

Level determines whether Enspire applies the discount to the bottom line or includes the 
discount in the line price. The options are as follows: B) Bottom Line - This option 
applies the family discount to all items within the family and displays the amount of the 
discount on the invoice. The prices of individual items do not reflect the family discount. 
L) Line Level - This option figures the amount of the family discount into the unit price 
and displays the adjusted price for each item. The options are as follows:  

B) Bottom Line - This option applies the family discount to all items within the family 
and displays the amount of the discount on the invoice. The prices of individual items do 
not reflect the family discount.  

L) Line Level - This option figures the amount of the family discount into the unit price 
and displays the adjusted price for each item. 

Basis determines how Enspire calculates the discounts for the selected family. 
Calculating Family Discounts: 
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When you create a family discount table, you select a Basis option. This option 
determines the basis used for calculating the discount. The options are: 

D) Cumulative Dollars - This option bases the discount on the total dollar amount of 
items within the family that are included on the order.  

N) None - This option indicates that the family has no discounts associated with it. Select 
None when you want to disable the family pricing discount but not delete the Family 
Code. 

Q) Quantity Table for Item - This option uses the item’s quantity table to determine the 
discount. However, the Bracket is still determined by the total number of items 
within the family that are on the order. You establish an item’s quantity discounts in 
the Quantity Price Brackets section of the Item Master dialog. You can also establish 
quantity discounts that apply to a specific warehouse in the Quantity Price Brackets 
section of the Warehouse Item Maintenance dialog. 

U) Units - This option bases the discount on the total number of items within the family 
that are on the order. 

V) Volume - This option bases the discount on the total volume of the items within the 
family that are on the order. 

W) Weight - This option bases the discount on the total weight of the items within the 
family that are on the order. 

Rounding determines whether you round the price after applying the family discount to 
2, 3, or 4 decimal places. For example, the price is $1.3472. Selecting 4 leaves the price 
as is. Selecting 3 changes the price to $1.347. Selecting 2 changes the price to $1.35. 

Single Item Discount determines whether Enspire calculates the family discount if an 
order includes only one item within the family. Select this option to apply the appropriate 
family discount to single item orders. Leave this option unselected if you do not want to 
apply single item discounts. 

Use Customer Bracket determines whether the customer’s minimum quantity bracket 
also applies to the family pricing table. You determine the minimum quantity bracket in 
the Pricing section of the Customer ShipTo Locations dialog. For example: Use 
Customer Bracket is selected. Bracket number 2 of a family discount requires that the 
customer purchase 100 items to receive the associated family discount. A customer has a 
minimum quantity bracket of 2 and orders 10 items. The customer receives the discount 
associated 100 items, as determined by bracket 2, because of the minimum quantity 
bracket. If Use Customer Bracket is unselected, the customer receives the family 
discount associated with 10 items. 

4. In the Brackets grid, create a bracket for each discount level within the family. To create 
a bracket, select a Family in the Family grid. Click in the Brackets grid then press the 
INSERT key on your keyboard. Complete the Brackets grid as follows: 

Bracket identifies each of the levels used to calculate the discounts for the current 
family. 

Amount, Units, Weight, or Volume determine the dollar amount, quantity, weight, or 
volume a customer must purchase to receive the discount associated with the bracket. The 
Basis option you select in the Family grid determines the column that appears here. 

Discount Rate % is the discount percentage for the bracket. To calculate the discount, 
this percentage is multiplied by the purchase amount. 
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5. From the File menu, choose Save. 

Setting Up a Product Group 
Product groups allow you to group items for sales analysis and give you the ability to simplify 
various functions in Enspire, such as item pricing and creating contracts. For example, if you have 
an item that varies in color but not in price, you can assign each of the items to the same product 
group and create one pricing scheme for the entire group. Assigning prices at the group level 
ensures consistency among the items in the group and makes maintaining prices much easier. You 
can also assign the same account set to all items in the group. 

To further refine the product group sales analysis, you can create subgroups, which are groups 
within a product group. For example, you have a product group called Pool Cleaners. This product 
group contains the following subgroups: Gallons per Minute, Pump Size, and Type. The Pump 
Size subgroup contains the following values: 1 horsepower, 1.5 horsepower, and 2 horsepower. 
Now, when you assign the Pool Cleaners product group to an item, you can assign it a value from 
each of the subgroups. 

To set up a product group: 

1. Open the Product Group Maintenance dialog (File Maintenance>Inventory> Product 
Groups). 

 

2. From the File menu, choose New. 

3. Complete the Group grid as follows: 

Version 7.3.2.0 Getting Started  5-17 



Inventory  Setting Up a Product Group 

Group Code is the code that identifies the product group. This code is alphanumeric and 
can be up to eight characters long. 

Description is the description of the product group. 

4. In Method, select how the prices for items in the group are calculated. If you do not want 
to create pricing for items in the group, leave Method blank. For a description of each 
Method option, see Calculating Product Group Pricing below. 
 
Calculating Product Group Pricing 

When you create a product group, you have the option of setting up a pricing table that 
applies to all items assigned to that group. The Method you assign to the group 
determines how Enspire calculates the prices. The Method options are: 

C) Cost Up - This option increases the item’s cost by the specified percentage to 
calculate the pricing. The selected Cost Basis determines the cost used in the 
calculation. The Bracket into which the item falls determines the percentage.  

D) Dollar Amount - This option assigns a specific dollar amount to each item within 
the group. The Bracket into which the item falls determines the amount. 

L) List Down - This option decreases the item’s list price by the specified percentage 
to calculate the pricing. The Bracket into which the item falls determines the 
percentage. You establish the list price for an item when you add it to Enspire. 

M) Margin Percentage - This option increases or decreases the item’s cost to achieve 
the specified margin percentage. The selected Cost Basis determines the cost used in 
the calculation. The Bracket into which the item falls determines the percentage. 

R) Reference Price Down - This option increases the reference price by the specified 
percentage to calculate the pricing. The Bracket into which the item falls determines 
the percentage. You determine the reference price in the Cost section of the Item 
Vendor Maintenance dialog. 

U) Up Charge - This option increases the item’s list price by the specified percentage 
to calculate the pricing. The Bracket into which the item falls determines the 
percentage. You establish the list price for an item when you add it to Enspire. 

X) List Multiplier - This option uses the specified percentage of the list price to 
calculate the pricing. The Bracket into which the item falls determines the 
percentage.  

5. If you want to assign the same account set to all items in the selected product group, 
including subgroups, select it in Account Set. If necessary, you can select a different 
account set for an item in the Item Master dialog. 

6. The Cost Basis is required when the method field is selected. 

Cost Basis determines the cost used to calculate the price for the items within the groups. 
The options are as follows: A) Actual Cost - This option uses the cost determined by your 
company’s inventory costing method, LIFO, FIFO, or weighted average. R) Next Cost - 
This option uses the cost of the item when you last purchased it. S) Standard Cost - This 
option uses the item’s standard cost, as established in the Pricing section of the Item 
Maintenance dialog. 

7. In Round, select how you want to round the price for items in this group. Round 
determines whether you round the item’s price to 2, 3, or 4 decimal places. For example, 
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the price of an item is $1.93626. Selecting 4 changes the price to $1.9363. Selecting 3 
changes the price to $1.936. Selecting 2 changes the price to $1.94. 

8. If you want to add subgroups, click in the Sub Groups grid then press the INSERT key on 
your keyboard. In Code, type the code that identifies this subgroup. This code is 
alphanumeric and can be up to eight characters long. In Description, type the description 
of the subgroup. 

9. If you want to add values to the subgroup, verify that the sub group tab is selected and 
click in the sub group grid then press the INSERT key on your keyboard. In Code, type 
the code that identifies the value. This code is alphanumeric and can be up to eight 
characters long. In Description, type the description of the sub group. 

10. Group Brackets are required when your method field is selected.  To add a group 
pricing bracket, click in the Group Brackets grid then press the INSERT key on your 
keyboard. In Qty, type the quantity of items within the product group an order must 
include to qualify for the pricing in the bracket. In %, type the percentage applied to the 
cost or price of the items within the selected group. The selected Method determines the 
cost or price the percentage applies to. In Add on Amt, type the amount added to the 
price of each item within the group. 

11. From the File menu, choose Save. 

You assign a product group and subgroup values to an item in the Product Groups section of the 
Item Master dialog. If the product group includes subgroups, you must assign a value from each 
subgroup to the item. 

Adding an Item 
Enspire allows you to maintain extensive, detailed records for each of your items. Therefore, you 
have many decisions to make when you add an item. This section of the Getting Started manual 
covers the main procedures and decisions involved when you add an item. For details on the fields 
available when you add an item, see the online help. 

In addition to adding an item, the procedures covered in this section are: 

Establishing a List Price and Units of Measure 

Adding a Warehouse Item Record 

Adding a Vendor Item Record 
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To add an item: 

1. Open the Item Master dialog (File Maintenance>Inventory>Item Master). 

 

2. From the File menu, choose New. 

3. Type an Item Number. 

4. Type a Description. 

After you type an item number and description, you can proceed through the sections of the Item 
Master dialog in the order they appear. If a section is grayed out, it currently does not apply to the 
item. In the sample Item Master dialog above, Commodity is grayed out. Therefore, you cannot 
assign commodities to the item. If you want to enable the Commodity section, you select 
Commodity Priced Item in the Controls section. 
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Item Imaging  
Item Imaging provides Enspire users with the capability to store and display pictures of the 
company’s items. You can include graphic images in a variety of formats, including gif, jpeg, and 
bitmap. The available images appear as thumbnails to the left. When you click a thumbnail, it 
appears in the workspace. Item Imaging is available in Enspire’s Item Master and Order Entry 
dialog.  

 

To make an image available for use in Enspire, it must be saved in a folder within your image library path. 
You identify the image library path in the Company section of the Company Miscellaneous Control File 
dialog. Once this is done, the images are available in Item Master & Order Entry.  
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Item Master - Images Section  
The Item Master Images Section enables you to set up or view item imaging when you are setting 
up or revising an item.  

Creating an Item Image Folder  
After creating a new item or selecting an existing item, click on the Images tab to access the 
Images Section.  

NOTE: If an item includes an image, a camera icon appears in the Item LookUp dialog. You can 
double click the camera to display the image or images associated with the item.  

When this section is initially opened, Enspire creates a folder for the item’s image(s) within the 
Images path identified in the Miscellaneous Control File. This folder name, labeled Item Folder, 
can be found immediately above the “thumbnails” section of the image display. The Item folder 
name is identical to the Item Number unless the item number contains \, /, :, *, ?, “, <, >, or |, 
which are characters prohibited by Windows naming convention. If the prohibited characters are 
contained in the item number, Enspire removes the characters from the item number and names 
the image folder accordingly without the prohibited characters. Should you choose to, you may 
edit the name of the folder in any manner you want. Enspire saves the relationship between the 
folder and the item number within the database.  

 
 

Selecting an Item for Display  
Item Imaging displays the picture contained in the item’s folder in thumbnail format on the left hand 
side of the screen. To display in the image area, simply click on one of the thumbnails.  
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Adding an Object to the Image Area  
You can add objects to the image area only when you are in annotation mode. When you are in this 
mode, the shape tools and the color palette become active. If you are not in annotation mode, click 
the Toggle Annotation Mode tool. This tool and others are discussed in the appendix of this paper.  

1. If necessary, toggle into annotation mode.  
2. Click the thumbnail of an image to display it in the image area.  
3. Click the object you want to add. For information on these tools, see Object Tools below.  
4. Click and hold the mouse button down in the image area.  
5. Drag the mouse until the object is the desired size then release the mouse button. For 
instructions on resizing an object, see below.  

 

Resizing an Object  
1. Click the object you want to resize. When you click the object, a square handle appears at 
each corner of the object.  
2. Click and hold the mouse button down on one of the handles.  
3. Drag in the direction you want to resize.  
4. When the object reaches the desired size, release the mouse button.  

 

Changing the Foreground and Background Colors  
1. Select an object.  
2. To change its foreground color, click the color in the color palette. The current 
foreground color is marked with an FG.  
3. To change its background color, right click the color in the color palette. The current 
background color is marked with a BG.  
4. You can also right click an object, then click Properties and select Foreground Color or 
Background Color. In the Windows Color dialog, select a color then click OK.  

 

Establishing a List Price and Units of Measure 
An item’s list price is the price of the item for each pricing unit of measure. You can use the list 
price as the actual price you charge for an item. You can also use the list price as the starting point 
for calculating prices in contracts, discounts, and promotions. 

The units of measure assigned to an item determine how it is stocked, purchased, and sold. For 
more information, see the Units of Measure section earlier in this chapter. 

WARNING! Carefully consider your SKU unit of measure before 
you assign it to the item. You cannot change the SKU 
unit of measure after it has been assigned. 

To establish an item’s list price and units of measure: 

1. In the Item Master dialog (File Maintenance>Inventory>Item Master), add or open an 
item. 
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2. Click the Pricing tab. 

 

3. In SKU UM, select the SKU unit of measure for the item. This value cannot be changed 
once you save this record.  Choose your value carefully. 

4. In Quantity UM, select the quantity unit of measure for the item. 

5. In Quantity Conversion, type the number of SKU units in one quantity unit of measure. 

6. In Price UM, select the price unit of measure for the item. 

7. In Price Conversion, type the number of SKU units in one price unit of measure. 

8. In List Price, type the item’s list price. 

Adding a Warehouse Item Record 
You create a warehouse item record for each warehouse where you stock the item. If an item does 
not have a warehouse item record, it is considered a nonstocked item. During order entry, if you 
include an item that is not stocked at the selected warehouse, it is considered a nonstocked item for 
that order, even though the item may be stocked at a different warehouse. 

You create warehouse item records in the Warehouse Item Maintenance dialog. If a field in this 
dialog contains a different value than the same field in the Item Master dialog, the value in the 
Warehouse Item Maintenance dialog is used. For example, if an item’s list price in the Item 
Master dialog is $2.95 and in the Warehouse Item Maintenance dialog the list price is $2.85, 
Enspire uses $2.85 as the list price. 

NOTE This procedure covers the general steps for adding a warehouse item 
record. For detailed information on the fields within the Warehouse 
Item Maintenance dialog, see the Enspire online help. 

To add a warehouse item record: 

1. In the Item Master dialog (File Maintenance>Inventory>Item Master), add or open an 
item. 
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2. Click the Warehouses tab, then click the Edit Warehouse Items button. 

 

3. From the File menu in the Warehouse Item Maintenance dialog, choose New. 

4. In the Warehouse grid, select a warehouse in Whse Code. 

5. After you have completed each section within the Warehouse Item Maintenance dialog, 
choose Save. 

6. If you want to add another warehouse item record for the same item, choose New. If you 
are finished, click OK. 

Adding a Vendor Item Record 
A vendor item record maintains information specific to a given item and vendor combination, 
including a vendor’s units of measure and costs for an item. A vendor item record is required for 
the item to be included in Costulator calculations and if you want to replenish the item 
automatically through a vendor. You create vendor item records in the Item Vendor Maintenance 
dialog.  

NOTE This procedure covers the general steps for adding a vendor item 
record. For detailed information on the fields within the Item Vendor 
Maintenance dialog, see the Enspire online help. 

To add a vendor item record: 

1. In the Item Master dialog (File Maintenance>Inventory>Item Master), add or open an 
item. 
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2. Click the Vendors tab, then click the Edit Vendor Items button. 

 

3. From the File menu in the Item Vendor Maintenance dialog, choose New. 

4. In the Vendor grid, use the lookup in Vendor # to select a vendor. 

5. In Vendor Item, type the vendor’s number for the item. 

6. In Vendor Item Description, type the vendor’s description of the item. 

7. After you have completed each section within the Item Vendor Maintenance dialog, 
choose Save. 

8. If you want to add another vendor item record for the same item, choose New. If you are 
finished, click OK. 

Setting Up Promotional Items 
Promotions are temporary price or cost changes on a selected item. Price promotions are your 
price incentives offered to your customers. Cost promotions are incentives offered by a vendor to 
your company. A promotional item can include a price promotion, a cost promotion, or both, if 
you pass some of the cost promotion savings on to your customers. All promotions are given 
unique item numbers and are associated with items currently in Enspire. If an item selected during 
order entry has a promotion associated with it, Enspire gives you the option of using the 
promotional item. 

You can set up promotions for individual items, all items within a product group, or all items 
within a family. 
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To help you assess the impact of a promotion, Enspire tracks a variety of information, including: 
the number of hits and misses, quantity sold, dollar sales and costs, and percentage profit. 

NOTE This procedure covers the general steps for adding a promotional item. 
For detailed information on the fields within the Promotion 
Maintenance dialog, see the Enspire online help. 

To set up a promotion: 

1. Open the Promotion Maintenance dialog (File Maintenance>Inventory> Promotional 
Items). 

 

2. From the File menu, choose New. 

3. Select a Timing Method. The method you select determines the fields in the Timing 
section and also whether the promotion is open-ended or has a definite time frame. The 
options are: D) Predefined Beginning and End Dates - This option assigns a beginning 
date and an ending date to the promotion. O) Open Ended - This option establishes an 
open-ended duration for the promotion. P) Accounting Period - This option sets the 
duration by accounting period. The following fields are associated with a Timing 
Method of D. The options are: 

D) Predefined Beginning and End Dates - This option assigns a beginning date and 
an ending date to the promotion.  

O) Open Ended - This option establishes an open-ended duration for the promotion.  
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P) Accounting Period - This option sets the duration by accounting period.  

Begins is the first date of the promotion. 

Ends is the last date of the promotion. 

First Buy Date is the first date on which customers can buy items through this 
promotion. 

Last Buy Date is the last date on which customers can buy items through this promotion. 

Show Days Before is the number of days before the promotion begins that the 
promotional pricing dialog is displayed during order entry. For example, if you want to 
receive notification of the promotion for ten days prior to the date on which the 
promotion begins, type 10. If you do not want to show the promotional pricing before the 
date it begins, set Show Days Before to 0 (zero). 

Show Days After is the number of days after the promotion ends that the promotional 
pricing dialog is still displayed during order entry. For example, if you want to be able to 
reference the promotional price during order entry for 20 days after the promotion ends, 
type 20. If you do not want to show the promotional pricing after it ends, set Show Days 
After to 0 (zero). 

Purge After Days is the number of days after the promotional pricing ends that it is 
deleted from Enspire. 

4. Click the Details tab then complete the Details grid as follows: 

Item is the item assigned to the promotion. 

Promotional Item is the number assigned to the item for the duration of this promotion. 

Product Group assigns all items in the product group to the promotion. 

Family assigns all items in the family to the promotion. 

5. For each item, product group, or family in the Details grid, complete the appropriate 
section or sections within the Details section. Each section is described below. For 
specific information on the fields in each section, see the Enspire online help. 

The Controls section establishes the pricing method for the promotion and determines 
whether discounts and/or rebates are applied in addition to the promotion. 

The Price Quantity Table section establishes the quantity brackets for promotions you 
offer your customers. This section is active if you select a Price Method of Q) Price/Qty 
Table in the Controls section. 

The Cost Quantity Table section establishes the quantity brackets for promotions your 
vendors offer to you. This section is active if you select a Price Method of Q) Price/Qty 
Table in the Controls section and if you selected a vendor in the Details grid. 

The History section displays the performance history of the promotion. 

6. Click the Customers tab then add customers to the promotion. 

To add a single customer, select it in Cust #. 

5-28 Getting Started  Version 7.3.2.0 



Inventory  Duplicating a Promotion 

To add multiple customers, you can select them individually in Cust # or you can use 
filters to select multiple customers at once. To use filters, click Use Filters. In the Filter 
Customers dialog, select the filters you want to apply then click OK. For a description of 
the Filter Customers dialog, see the Enspire online help. 

To add all customers and their ship-to locations, click Use Filters. Leave the Filter 
Customers dialog blank then click OK. 

7. After you have set up the promotion, choose Save. 

Duplicating a Promotion 

Enspire gives you the ability to copy the items in one promotion and use them in a different promotion. If 
you have promotions that include some of the same items, copying them can save you a lot of setup time. 

NOTE: Duplicating a promotion copies only the items. 

To duplicate a promotion: 

1. In Promotional Items (File Maintenance>Inventory>Promotional Items), open or create a 
promotion. This is the promotion that the items will be copied to. 

2. From the Actions menu, choose Duplicate Promotion. 

3. In the Duplicate Promotion dialog, select a Source Promotion. This is the promotion that contains 
the items you want to copy. 

4. Click OK. 

5. If you want to copy items from more than one promotion, repeat step 2 through step 4. 

 

Using StockAid 
In Enspire, StockAid manages a special category of inventory items and helps you maximize the 
return on these items. StockAid items can include one-of-a-kind items, special purchases, returned 
items, close-outs, unsold special orders, damaged goods, and refurbished items. The items 
received into StockAid do not fit the typical sales, purchasing, and inventory management 
processes. 

Additionally, you can assign a StockAid item the same number as an Item Master number. If the 
numbers are the same, Enspire gives you the option of selecting the StockAid item during order 
entry or when you create a quote. 

You cannot create StockAid items manually. Instead, you have the option of assigning items to 
StockAid automatically during any of the following transactions: 

The sold quantity for an on-order nonstocked item is decreased. 

An RMA assigns some or all returned items to StockAid instead of restocking them. 

When you receive a purchase order or a transfer, you receive some items into StockAid. 

You create a special buy-out purchase order for items to be sold through StockAid. 
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Editing a StockAid item 

Note that the information you enter here does not affect information stored in the Item Master.  

1. Open the Stockaid Maintenance dialog (File Maintenance>Inventory>StockAid Items). 

2. From the File menu, choose Open to display the StockAid LookUp dialog. 

3. Select the StockAid item you want to modify, then click OK. 

4. If you want to change the number of the StockAid item, type the new number in Item #. Typing a 
new number here does not affect the item's number in Item Master. It applies only to the StockAid 
item. 

5. If you want to change the description of the StockAid item, type the new description in 
Description. Typing a new description here does not affect the item's description in Item Master. 
It applies only to the StockAid item. 

6. Click the Information tab and complete the information as follows:   
 
Note:  If the fields under Information are not displayed, click the plus sign (+) to display them. To 
hide them, click the minus sign (-). 

• Warehouse identifies the warehouse where the item is stored. 

• Item # and Description identify the item. If you want to change the number and/or 
description of the StockAid item, type the new information here. Typing a new number or 
description does not affect the item's number or description in Item Master. It applies 
only to the StockAid item. 

• Vendor Item # is the vendor's number for the item. 

• Created is the date the item became a StockAid item. 

• Control Number is the item's lot number or serial number. 

• Bin is the primary bin where the item is stored. 

• Age identifies how long the item has been a StockAid item. The Age is the difference 
between the Created date and the current date. 

7.    In the Controls section, complete the following: 
 
Note:  If the fields under Controls are not displayed, click the plus sign (+) to display them. To 
hide them, click the minus sign (-). 

• Decimal Allowed determines whether you can enter increments less than one, such as .5 or 
2.3, when recording transactions for this item. Select Decimal Allowed to allow increments 
of less than one. Leave this option unselected to require whole numbers. 

• Used identifies whether the item is used or new. Select Used if the item is used. Leave this 
option unselected if the item is new. 

• Apply Customer Rebates determines whether the item is eligible for a customer rebate. 
Select Apply Customer Rebates to apply a customer rebate to the item. Leave this option 
unselected if the item is not eligible for a customer rebate. To be eligible for a customer 
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rebate, the item must first meet the other eligibility requirements, as established in the 
Customer Rebates dialog. 

• Apply Vendor Rebates determines whether the item is eligible for a vendor rebate. Select 
Apply Vendor Rebates to apply a vendor rebate to the item. Leave this option unselected if 
the item is not eligible for a vendor rebate. To be eligible for a vendor rebate, the item must 
first meet the other eligibility requirements, as established in the Vendor Rebate Maintenance 
dialog. 

• Buyer is the buyer associated with the item. 

• GL Set is the general ledger account set used to record transactions for this item.  

• Inside Salesperson identifies the inside salesperson responsible for selling the item. The 
salesperson you select here overrides the salesperson assigned to the customer that purchases 
the item. You can change the salesperson during order entry. 

• Outside Salesperson identifies the outside salesperson responsible for selling the item. The 
salesperson you select here overrides the salesperson assigned to the customer that purchases 
the item. You can change the salesperson during order entry. 

• Price Method determines how Enspire prices the item. The options are as follows: 
 
F) Fixed - This option uses the amount in Customer Price under Price/Cost as the price for 
the item. 
 
S) Standard - This option uses the available pricing methods for the customer and takes into 
consideration the item's product group and/or family, if applicable, as well as the list price and 
unit cost as specified under Price/Cost. 
  

• Commission Method determines how Enspire calculates the commission for this item. The 
options are as follows: 
 
F) Fixed - This option uses the spiff assigned to the item. You set the spiff under Price/Cost. 
 
N) None - This option indicates that no commission is paid for selling this item. 
 
S) Standard - This option bases the commission on an established commission plan. The 
commission is based on the customer price and commission cost, as established under 
Price/Cost.  

8.    In the Price/Cost section, complete the following: 
If the fields under Price/Cost are not displayed, click the plus sign (+) to display them. To hide them, 
click the minus sign (-). 

• List Price is the price of the item. If you selected a Price Method of Standard under Controls, this 
price can be used in list-based or margin-based pricing formulas. 

• Customer Price is the customer price for the item. This price is used if you selected a Price 
Method of Fixed under Controls. 

• Unit Cost is the cost for each unit of the item. 

• Commission Cost is the cost used to calculate the commission paid for the item. This cost applies 
if you selected a Commission Method of Standard under Controls. 
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• Spiff is the fixed amount paid for selling the item. This amount applies if you selected a 
Commission Method of Fixed under Controls. 

• List Value is the total value of the original quantity based on the List Price. 

9.   In the Quantities section, complete the following: 

If the fields under Quantities are not displayed, click the plus sign (+) to display them. To hide them, 
click the minus sign (-).   
 
The quantities are displayed in the item's quantity unit of measure, which is listed in UM. 

• Original Quantity is the quantity originally available for sale when this item became a StockAid 
item. 

• Current Quantity is the quantity of the item currently at the warehouse. 

• Quantity Damaged is the number of items currently considered damaged.  

• Written-off Available is the quantity of the item that has been written off but is available for sale. 

• Written-off Unavailable is the quantity of the item that has been written off and is not available 
for sale. 

• Commit Today is the quantity of the item that is committed today.  

• Commit Later is the quantity of the item that is committed later.  

• Available is the quantity of items currently available for sale. 

• UM is the item's quantity unit of measure. 

10.  In the Reserved For section, complete the following: 

If the fields under Reserved For are not displayed, click the plus sign (+) to display them. To hide 
them, click the minus sign (-). 

• Customer is the customer that the item is reserved for. If you select a customer here, the item 
cannot be sold to a different customer. 

• Customer Name displays the name of the selected customer. 

• ShipTo is the customer's ship-to location that the item is reserved for. If you select a ship-to 
location here, the item cannot be sold to a different location. 

• ShipTo Name displays the name of the selected ship-to location. 

11.   To add an extended description, click the Extended Description tab complete the following: 
 
Click in the Extended Description grid then press the INSERT key on your keyboard. 

• In Language, select the language associated with the extended description. 

• Select a Print Flag. The option you select determines the when the extended descriptions are 
printed. You can create multiple extended descriptions for a StockAid item and print a specific 
message depending on the flag you set. The options are as follows: 
A) All documents - This option prints the extended description on all internal and external 
documents. 
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C) Customer documents only - This option prints the extended description only on documents 
given to the customer, such as invoices. 
 
E) External documents only - This option prints the extended description on vendor and customer 
documents. 
 
I) Internal documents only - This option prints the extended description only on documents used 
internally, such as packing slips and pick tickets. 
 
N) Do not print - This option does not print the extended description. 
 
V) Vendor documents only - This option prints the extended description only on documents given 
to the vendor, such as VRAs. 

Type the extended description in the text area. 
 
If you want to add special formatting, such as a different font or size or bold or italicized text, you can 
use the Enspire Editor. To open the editor, right click in the text area then click Edit.  

12.   To add user defined fields to the stockaid item, click User Defined Fields tab.  A field appears in this 
section if it has a UDF class of StockAid assigned to it in the UDF Field Maintenance dialog. 

13.   After you have completed each section within the Stockaid Maintenance dialog, choose Save. 
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Item Kardex in Enspire  
The Item Kardex in Enspire provides item history for both document-based transactions and 
batch-based transactions. The history includes the date and type of the transaction, the item 
quantity included on the transaction, the available quantity and on-hand quantity at the time of the 
transaction, and a description of the transaction.  

The Item Kardex includes a history of closed document-based transactions for a given item. 
Examples of document-based transactions are:  

• Confirmed orders  

• Confirmed transfers  

• Purchase order receipts  

 
Historical information for batch-based transactions is available through the Historical Inventory 
section of the Warehouse Item Maintenance dialog. Examples of batch-based transactions are:  

• Physical inventory worksheets  

• Quantity Adjustments  

• Assembly work orders  
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About this Chapter 
This chapter covers the basics for setting up your vendors. It also includes information on brokers, 
vendor contracts, vendor families, and reason codes. 

Adding a Vendor 
Vendors identify the companies and individuals from which you purchase goods and/or services. 
Setting up vendors in Enspire gives you the ability to track replenishment, purchasing transactions, 
and accounts payable transactions by vendor. 

NOTE This procedure covers the initial steps for adding a vendor. For 
detailed information on the sections and fields within the Vendor 
Maintenance dialog, see the Enspire online help. 

To add a vendor: 

1. Open the Vendor Maintenance dialog (File Maintenance>Vendor >Vendor Master). 

 

2. From the File menu, choose New. 

3. In Vendor #, type a vendor number. 

4. In Vendor Name, type the complete name of the vendor. 

5. In Status, select the current status of the vendor.  
 
O) Open is the status automatically assigned to new vendors. The status options are as 
follows: 

C) Closed – This option indicates that you no longer use this vendor. You cannot create 
purchase orders or record invoices for a vendor with a status of Closed. 
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H) Hold – This option indicates that you currently do not use this vendor. You cannot 
create purchase orders for a vendor with a status of Hold. However, you can record 
invoices. 

O) Open – This option indicates that the vendor is available for all transactions. 

6. In the Information section, double click in the Vendor Demographics area to display the 
Vendor Address dialog. In this dialog, type the general vendor information including 
address, phone and fax numbers, email address, and web address. After you type this 
information, click OK to close the Vendor Address dialog. 

7. If you know the vendor’s tax number, you can type it in Tax Number. 

8. In 1099, select the type of 1099 vendor this vendor is. If the vendor is not a 1099 vendor, 
select N) None – No 1099 Misc will be prepared. 

9. If you stock and resell the items that this vendor sells to your company, select Item 
Supplier. Leave this option unselected if you do not stock and resell the items this 
vendor supplies. For example, if a vendor provides a service, such as maintenance, leave 
Item Supplier unselected. If you use this vendor only for vendor direct shipments or for 
items your company uses but does not resell, such as office supplies or bottled drinking 
water, leave Item Supplier unselected. 

10. If this vendor is an individual, not a company, select Individual. Leave this option 
unselected if this vendor is not an individual. 

11. If you know the vendor’s customer number for your business, you can type it in Our 
Account. 

12. After you have completed each section within the Vendor Maintenance dialog, choose 
Save. 

If a section of the Vendor Maintenance dialog is grayed out, it currently does not apply to the 
vendor. For example, if the vendor is not an item supplier, several sections, such as Families and 
Landed Cost, are inactive. 

Setting Up a Broker 
Brokers are companies or individuals that serve as go-betweens for your company and foreign 
vendors. Setting up brokers in Enspire allows you to calculate brokerage fees and determine 
whether they are capitalized or expensed. Capitalized brokerage fees adjust the landed cost of each 
item to reflect that item’s share of the fee. 
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To add a broker: 

1. Open the Broker Maintenance dialog (File Maintenance>Vendor>Brokers). 

 

2. From the File menu, choose New. 

3. In Broker, type the code that identifies this broker. This code is alphanumeric and can be 
up to eight characters long. 

4. In Description, type a description of the broker. 

5. In Min Fee, type the minimum fee charged by the broker per order. For example: The 
Min Fee is $50. The fee percentage is 3 percent. The purchase order amount is $1,000. 
Based on the fee percentage, the fee would be $30. However, the Min Fee amount 
increases the fee to $50. 

6. In Max Fee, type the maximum fee charged by the broker per order. For example: The 
Max Fee is $1,500. The fee percentage is 10 percent. The purchase order amount is 
$25,000. Based on the fee percentage, the fee would be $2,500. However, the Max Fee 
amount decreases the fee to $1,500. 

7. In Is Capitalized, select whether the brokerage fees are capitalized. Select this option to 
capitalize brokerage fees. Leave this option unselected if you expense brokerage fees 
instead of capitalize them. 

8. If Is Capitalized is selected, complete the brackets grid for the selected broker as 
follows: 

Bracket identifies the various levels used to calculate brokerage fees when you capitalize 
the fees. 
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PO Amount is the maximum dollar amount of the order for the bracket. For example, if 
the PO Amount for Bracket 1 is $1,000, an order above that amount would fall into a 
subsequent bracket. 

Broker % is the fee percentage for the bracket. To calculate the brokerage fee, this 
percentage is multiplied by the PO Amount. If you want to use a flat amount instead of a 
calculated percentage, leave Broker % set to 0 (zero) and type the dollar amount in 
Broker Amount. If you want to use a flat amount in addition to a calculated percentage, 
type the percentage in Broker % and the dollar amount in Broker Amount. 

Broker Amount is the dollar amount of the brokerage fee. If you want to use a 
calculated percentage instead of a flat dollar amount, leave Broker Amount set to $0.00 
and type the percentage in Broker %. If you want to use a flat amount in addition to a 
calculated percentage, type the percentage in Broker % and the dollar amount in Broker 
Amount. 

9. From the File menu, choose Save. 

Creating a Vendor Contract 
A vendor contract defines special costs for any or all of the items that vendor sells. You can use a 
vendor contract to assign costs to individual items, all items within a vendor family, or all items 
within a product group. Contract costs can be applied in addition to or instead of vendor family 
discounts and vendor rebates. You can also set up vendor contracts that apply only when you sell 
items to a specific customer. 

To create a vendor contract: 

1. In the Vendor Maintenance dialog (File Maintenance>Vendor>Vendor Master), open the 
vendor you want to create the contract for. 
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2. Click the Contracts tab, then click Edit Vendor Contracts. 

 

3. From the File menu in the Vendor Contract Maintenance dialog, choose New. 

4. Complete the Contract grid as follows: 

Contract is the code that identifies the contract. This code is alphanumeric and can be up 
to 10 characters long. 

Description is the description of the contract. 

Begin Date is the date the contract takes effect. If you do not provide a begin date, the 
contract takes effect immediately. 

End Date is the last date the contract is in effect. If you do not provide an end date, the 
contract will remain in effect indefinitely. 

Cust # is the customer the contract applies to. If the vendor contract is not customer-
specific, leave Cust # blank. Selecting a customer means that you receive the contract 
costs from the vendor only when you sell the items to the customer selected here. 

Ship # is the customer’s ship-to location the contract applies to. If you want the contract 
to apply to all of the customer’s ship-to locations, leave Ship # blank. If you did not 
select a customer, Ship # is inactive. 

5. Add items, product groups, and/or vendor families to the contract. Adding items is 
discussed below. For information on adding product groups and vendor families to a 
contract, see the Enspire online help. 
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6. After you have added items, product groups, and/or vendor families to the contract, 
choose Save. 

7. If you want to add another contract for the same vendor, choose New. If you are finished, 
click OK. 

Adding Items to a Vendor Contract 
1. In the Contract grid of the Vendor Contract Maintenance dialog, select the contract you 

want to add items to. A sample Vendor Contract Maintenance dialog is in step 2 of 
Creating a Vendor Contract. 

2. If the Items section is not the current section, click the Items tab. 

3. If the begin date for the item is different than the begin date for the overall contract, type 
the Begin Date in the Items section. If the begin dates are the same, leave Begin Date 
blank in the Items section. 

4. If the end date for the item is different than the end date for the overall contract, type the 
End Date in the Items section. If the end dates are the same, leave End Date blank in the 
Items section. 

5. If vendor rebates are included in addition to this contract, select Rebates. If rebates are 
not included with this contract, leave Rebates unselected. 

6. If family discounts are included in addition to this contract, select Family. If family 
discounts are not included with this contract, leave Family unselected. 

7. Complete the Item grid as follows: 

Item is the item included on the contract. 

Method determines how the item’s cost is calculated for the contract. If you select a 
method of Quantity Table, the Vendor Quantity Contracts Brackets dialog appears. Here, 
you set the quantity discounts for the contracts. For information on this dialog, see the 
Enspire online help.  

Discount Rate % is the percentage discounted from the selected method. Discount Rate 
% is inactive for the Fixed and Quantity Table methods. 

Round determines whether you round the item’s contract price to 2, 3, or 4 decimal 
places. For example, the price of an item is $1.93626. Selecting 4 changes the price to 
$1.9363. Selecting 3 changes the price to $1.936. Selecting 2 changes the price to $1.94. 

Unit Cost is the item’s cost per unit on the contract. Unit Cost is active if you selected a 
Method of Fixed. 

Table Type is the type of quantity table that calculates the contract price for the item. 
Table Type is active only if you selected a method of Quantity Table. 

8. In Comment, you can type additional information for the item. 

9. When you have finished creating the contract, choose Save. 

Setting Up a Vendor Family 
A vendor family is a collection of items that the vendor has grouped together to determine 
quantity discounts. The discount can be based on the cost, units, weight, or volume of items being 
purchased that belong to the same family. 
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To set up a vendor family: 

1. In the Vendor Maintenance dialog (File Maintenance>Vendor>Vendor Master), open the 
vendor you want to set up the family for. 

2. Click the Families tab, then click Edit Vendor Families. 

3. Complete the Families grid as follows: 

Family is the code that identifies the family. This code is alphanumeric and can be up to 
eight characters long. 

Description is the description of the family. 

Min Buy is the lowest amount that can be purchased to qualify for a discount associated 
with the selected family. 

Level determines whether Enspire applies the discount to the bottom line or includes the 
discount in the unit cost. The options are as follows: B) Bottom Line - This option applies 
the family discount to all items within the family and displays the amount of the discount 
on the invoice. The costs of individual items do not reflect the family discount. L) Line 
Level - This option figures the amount of the family discount into the unit cost and 
displays the adjusted cost for each item. 

Table Basis determines the method used to select the appropriate family discount 
Bracket. 

Rounding determines whether you round the cost after applying the family discount to 2, 
3, or 4 decimal places. For example, the cost is $1.3472. Selecting 4 leaves the cost as is. 
Selecting 3 changes the cost to $1.347. Selecting 2 changes the cost to $1.35. 

Single Item Discount determines whether Enspire calculates the family discount if a 
purchase includes only one item within the family. Select this option to apply the 
appropriate family discount to single item orders. Leave this option unselected if you do 
not want to apply single item discounts. 

4. In the Brackets grid, create a bracket for each discount level within the family. To create 
a bracket, select a Family in the Family grid. Click in the Brackets grid then press the 
INSERT key on your keyboard. Complete the Brackets grid as follows: 

Bracket identifies each of the levels used to calculate the discounts for the current 
family. 

Amount, Units, Weight, or Volume determine the dollar amount, quantity, weight, or 
volume a customer must purchase to receive the discount associated with the bracket. The 
Basis option you select in the Family grid determines the column that appears here. 

Discount Rate % is the discount percentage for the bracket. To calculate the discount, 
this percentage is multiplied by the purchase amount. 

5. From the File menu, choose Save. 

Adding an A/P Reason Code 
A/P reason codes allow you to track and analyze the reasons for accounts payable adjustments and 
determine the default general ledger account when you enter adjustments. 
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To add an A/P reason code: 

1. Open the AP Reason Code Maintenance dialog (File Maintenance>Vendor> Reason 
Codes). 

 

2. In Reason Code, type the code that identifies the reason code. This code is alphanumeric 
and can be up to four characters long. 

3. In Description, type the description of the reason code. 

4. In Acct #, select the default general ledger account number associated with the reason 
code. If necessary, you can override this account when using the reason code. 

5. From the File menu, choose Save. 

Setting Up Vendor Payment Classes  

Vendor payment classes are user-defined methods for grouping, sorting, and comparing vendors according 
to the payment terms assigned to them. You assign a class to a vendor in the Vendor Maintenance dialog. 
The terms assigned to a vendor class override the terms assigned to specific vendors belonging to the class, 
with the exception of split proximo and installment type terms. 

To add a vendor payment class: 

1. Open the Vendor Payment Classes dialog (File Maintenance>Vendor>Classes). 

2. From the File menu, choose New. 

3. In Class Code type that identifies the vendor class. This code is alphanumeric and can be up to 
four characters long. 

4. Type a Description of the class. 

5. In Days to Pay, enter the number of days you can take to pay the vendors within this class. For 
example, if you want to create a class where you must pay a vendor withing 30 days, type 30 here. 
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6. If vendors within the class are on hold, select Hold Flag. Leave this option unselected if you do 
not want to place those vendors on hold. The Status option in the Vendor Maintenance dialog 
overrides the vendor class Hold Flag setting. For example, if a vendor has a status of Open, 
assigning that vendor to a class for which you selected Hold Flag does not change the status from 
Open to Hold. 
 
Number of Vendors displays the number of vendors currently assigned to each class. 
  

7. From the File menu, choose Save.  

 

Posting AP Adjustments 

An AP adjustment allows you to make adjustments to vendor invoices. You can adjust invoices only if they 
have a balance less than or greater than zero, and if they are not split invoices. If you select a split invoice 
here, a message appears and asks if you want to delete the split payment plan.  

To create an AP adjustment: 

1. Open the Adjustments dialog (Transactions>Vendor Payables>Adjustments). 

2. In Invoice #, select the invoice being adjusted. The amount of the invoice appears in the Invoice 
Amount group box. This group box is discussed below. 
 
Vendor # is the vendor associated with the invoice. 
 
Profit Center displays the profit center affected by the adjustment. 
  

3. Select the Reason for the adjustment.  
 
Description displays the description of the selected reason. 
 
Curr is the vendor's currency. 
 
XRate is the exchange rate between your currency and the vendor's currency. 
  

4. Complete the Adjustments section as follows: 
 
Acct # is the general ledger account assigned to the selected Reason code. This account is debited 
or credited the amount of the adjustment. If necessary, you can select a different account. 
 
Location is the location affected by the adjustment. 
 
Description displays the description of the selected account. 
 
Dept displays the department, if any, affected by the adjustment. 
  

5. When you are ready to post, choose Post from the Actions menu. 

Invoice Amount Group Box 

• Original Balance is the original amount of the invoice. 
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• Previous Payment/Adj displays the amount of the payments or adjustments involving this 
invoice. This amount is the difference between the original balance and the current balance. 

• Current Balance is the current amount of the invoice. 

• Adjustment Amount is the amount of the adjustments applied to the selected invoice so far. You 
type this amount in Amount in the Adjustments grid. 

• Adjusted Balance is the balance of the invoice after the adjustment. 

Credit Application 

Credit Application allows you to apply credit memos to vendor invoices. 

To apply a credit memo to one or more open items for a vendor: 

1. Open the Credit Application dialog (Transactions>Vendor Payables>Credit Application). 

2. From the File menu, choose Open. 

3. In the Vendor LookUp dialog, select a vendor then click OK. 

4. In the Credit Memo grid, select the credit memo you want to apply.  
The Credit Memo grid contains the credit memos associated with the selected vendor. 
 
Memo lists the available credit memos. 
 
Status ID is the current status of the credit memo. 
 
Date is the date of the invoice to which the credit memo applies. 
 
Original Amt is the original amount of the credit memo. 
 
Current Amt is the amount of the credit memo still available to apply. 
 
After you select a credit memo, Credit Memo displays the one you selected. 
  

5. In the Invoice grid, select the invoice you are applying the credit memo to. The Invoice grid 
contains the invoices to which you can apply a credit memo. 
 
Invoice # lists the available invoices. 
 
Status ID is the current status of the invoice. 
 
Date is the date the invoice was created. 

Original Amount is the amount of the invoice when it was created. 
 
Current Balance is the amount still owed for the invoice. 

6. In Credit Applied, type the amount of the credit memo being applied to the selected 
invoice. 

7. In Disc Applied, type the amount of the discount being applied to the selected invoice. 
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8. From the Actions menu, choose Post. 

Invoice Corrections  

Invoice Corrections allows you to change general information, such as terms, dates, and discounts. 
You can also create or delete split payments. You do not use Invoice Corrections to change the amount 
due for an invoice. To change the amount, you create an AP adjustment. 

To correct an invoice: 

1. Open the Invoice Corrections dialog (Transactions>Vendor Payables>Invoice Corrections). 

2. From the File menu, choose Open. 

3. In the Accounts Payable Open Items LookUp dialog, select the invoice you want to correct 
then click OK. 
 
Invoice # is the number of the invoice being corrected. 
 
PO # is the number of the purchase order, if any, that generated the invoice. 
 
Vendor # and Name identify the vendor associated with the invoice. 
 
Currency is the vendor's currency. 
  

4. The General Information group box allows you to change dates, terms, and/or discount 
information related to the invoice being corrected. 
 
Date Entered is the date the invoice was entered into Enspire. 
 
Terms are your payment terms for this invoice. 
 
Invoice Date is the date on the invoice. 
 
Due Date is the date the next payment is due for the invoice. 
 
Discount Amount is the amount of the discount you are eligible to receive on this invoice. 
 
Discount Date is the date by which you must make the payment to receive the discount. 
 
Status ID displays the current status of the invoice. The options are: 0) Available - This 
option indicates that the invoice is available for payment. 9) Hold - This option indicates 
that the invoice is on hold and should not be paid. 
 
Split Payments identifies whether split payment records have been created for this invoice. 
A check mark indicates that this invoice included split payments. 
 
Credit Memo # identifies the credit memo applied to the invoice. 
  

5. If you want to include additional information about the correction, click in the Comments 
text area and type the information. 

6. If you want to create or modify split payment information, click the Split Payments tab. 
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7. When you are ready to post the corrections, choose Post from the Actions menu. 

History Group Box 

The History group box displays the date and check number of the most recent payment, as well as the date 
of the most recent adjustment. 

• Last Payment Date is the date of the most recent payment. 

• Last Payment Check # is the number of the check used to make the most recent payment on the 
invoice. 

• Last Adjustment Date is the date the invoice was most recently adjusted. This date is 
blank if no adjustments have been made to the invoice. 

Financials Group Box 

The Financials group box displays the original amounts of the invoice and also includes the amounts of 
the adjustments, credits, and payments applied to the invoice. 

• Original Subtotal displays the amount of the invoice's original subtotal. 

• Original Tax displays the amount of the invoice's original tax. 

• Original Freight displays the amount of the invoice's original freight. 

• Current Disc Available displays the amount of the discount that is currently available 
for the corrected invoice. 

• Net Balance is the amount owed on the invoice. 

• Adjustments displays the amount of the adjustments made to the invoice. 

• Payments displays the amount of the payments already applied to the invoice. 

• Credits Applied displays the amount of the credits applied to the invoice. 

• Current Balance displays the amount owed on the invoice. 

Splitting Payments  

The Split Payments section of Invoice Corrections allows you to divide the total amount due for an 
invoice into two or more payments. 

To create a split payment: 

1. In the Invoice Corrections dialog (Transactions>Vendor Payables>Invoice 
Corrections), open an invoice then click the Split Payments tab. 

2. Click in the Split Payments grid then press the INSERT key on your keyboard. 

3. In Split %, type the percentage of the invoice total for this payment. For example, if the 
invoice total is $100.00 and the split percentage is 50, then the amount due for this payment is 
$50.00. 
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4. In Due Date, enter the date the payment is due.  
 
Date Paid is the date payment was actually made. 
 
Current Amt is the amount due for this payment. 
  

5. In Disc Avail, enter the amount of the discount to be applied to this payment. 
 
Net Amt is the amount due after applying the discount, if available. 

Recording Vendor Payments Made Outside of Enspire 

Manual Checks allows you to record payments made outside of Enspire with manual checks, cash, bank 
drafts, or wire transactions. When you record manual checks, you allow Enspire to debit accounts payable, 
credit the proper cash account, flag invoices as paid, and update the necessary system files. 

To record payments: 

1. Open the Manual Checks dialog (Transactions>Vendor Payables>Manual Checks). 

2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. If 
necessary, type a different Batch Description, then click OK. 

3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. 
Select the batch you want to open, then click OK. 

4. In Bank #, select the bank that will process the payment. 

5. In Type, select the type of payment. The options are B) Bank Draft, C) Cash, K) Check, and 
W) Wire. 
 
If you select a Type of check, you must first print a corresponding blank check before you 
can record a manual check in Enspire.  
  

6. In Check #, type the payment number. For example, if you selected a Type of 
Check, you would type the check number here. 
 
Currency is the bank's currency. 
 
XRate is the exchange rate between the bank's currency and your currency.  
  

7. In Vendor #, select the vendor you are paying. 
 
Vendor Name displays the name of the selected vendor. 
 
Currency is the vendor's currency. 
  

8. Enter the Date of the payment. 

9. Is Deposit determines whether you are using the payment as a deposit to the vendor. 
Select Is Deposit if the payment is a deposit. Leave this option unselected if the 
payment is not a deposit. 
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10. If you want to include additional information about the payment, click in the 
Comments text area and type the information. 

11. In Payment Amount, type the amount of the payment. 
 
Amount Allocated displays the amount of the payment you have already distributed. 
 
Balance Available displays the amount of the payment yet to be distributed. 
  

12. Click the Invoices tab and select the invoice or invoices you want to pay. 
 

13. Click in the Invoices grid then press the INSERT key on your keyboard. 
 

14. Select the Invoice to be paid. 
 
Gross is the gross amount of the invoice. 
 

15. In Disc, type the amount of the discount, if any, associated with the invoice. 
 
Net Amount is the amount due after applying the discount, if available. 
 

16. In Payment, type the amount of the payment to apply to the invoice. 
 

17. If you want to print the register for this payment, choose Print Select from the File menu. 
 

18. When you have finished applying the payment to the selected invoice or invoices, choose 
Post Batch from the Actions menu. 

Voiding Vendor Payments Posted in the Current Period 

The Voided Check dialog allows you to void payments posted in the current period. You cannot void 
payments posted in a closed period. 

To void a check: 

1. Open the Voided Check dialog (Transactions>Vendor Payables>Voided Checks). 

2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. If 
necessary, type a different Batch Description, then click OK. 

3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. 
Select the batch you want to open, then click OK. 

4. Click in the Check grid then press the INSERT key on your keyboard. The Check grid is 
discussed below. 

5. In Payment #, select the payment you are voiding. 

6. From the Actions menu, choose Fetch Invoices (CTRL+F). Choosing Fetch Invoices 
displays the invoice or invoices associated with the selected payment. 
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7. In the Invoice grid, select whether you want to reinstate the invoices. 
 
If you select Reinstate, the invoice is reinstated as an open payable. If Reinstate is 
not selected, Enspire debits the Cash account and credits the account or accounts you 
select in the Non-reinstated Invoice Distributions grid. 
  

8. If Reinstate is not selected, select the distribution account or accounts to credit.  
 
To select an account, click in the Non-reinstated Invoice Distributions grid then press 
the INSERT key on your keyboard. Complete the grid as follows: 
 
Acct # is the general ledger account to credit. 
 
Profit Center is the location where the account is being credited. 
 
Amount is the amount to credit the account. 
  

9. Print the Voided Check Register. To print the register, choose Print Select from the 
File menu, then choose AP Voided Check Register (Proof). The register is also 
available for printing after you post. 

10. From the Actions menu, choose Post Batch. 

Matched Invoice Processing 

When you receive an invoice from a vendor and enter it into Enspire, you have the option of using 
Matched Invoice Entry or Service Invoice Entry. Use Matched Invoice Entry when you buy items for 
the purpose of reselling them. Use Service Invoice Entry when you buy services or items that you do 
not intend to resell, such as supplies. 

NOTE: If you enter a cost variance during matched invoice processing, make sure that you save the 
line you entered the variance on. Enspire does not recognize the variance until the line has been saved. 
You can save a line simply by moving to a different line or by choosing Save from the File menu. 

To process matched invoices: 

1. Open the Matched Invoice Entry dialog (Transactions>Vendor Payables>Matched Invoice 
Processing). 

2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. If 
necessary, type a different Batch Description, then click OK. 

3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. Select 
the batch you want to open, then click OK. 

4. Complete the Invoice portion of the Invoice grid as follows: 
 
In Vendor #, select a vendor. 
 
In Invoice #, type the number of the invoice you are matching the line items on the received 
purchase order to. 
 
In Entry Date, enter the date you entered the invoice into Enspire. 
 
In Invoice Date, enter the date on the invoice. 
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Select the vendor's Terms for this invoice. 
 
In Due Date, enter the date payment is due. This date defaults based on the Invoice Date and the 
selected Terms. 
 
1099 identifies the vendor as a 1099 vendor. Leave 1099 unselected if the vendor is not a 1099 
vendor. 
  

5. Complete the Purchase Order portion of the Invoice grid as follows: 
 
Vendor # is the vendor associated with the purchase order. 
 
Receipt # is the purchase order receipt number. 
 
XRate displays the exchange rate between your currency and the vendor's currency. 
 
Curr displays the currency used by the PO vendor. 
 
Doc # allows you to match an invoice to items on a specific purchase order. To use a specific 
purchase order, type that PO number here. If you want to match to all purchase orders for the 
selected PO vendor, leave Doc # blank. 
 

Class allows you to match to a specific element of a purchase order. For example, if you 
want to match to only the freight charges, select F) Freight. If you want to match to 
everything on a purchase order, leave Class blank. The options are: B) Brokerage, D) 
Duty, F) Freight, I) Item, and L) Landed Cost 
 
L/C Code is the landed cost code that identifies the type of landed cost you are receiving. 
You can select an L/C Code if you selected a Class of L) Landed Cost. Selecting an L/C 
Code allows you to match on that specific code. Leave L/C Code blank to match on all 
landed cost codes. 
  

6. In the Invoice group box, type the Invoice Amount. If you capitalize freight charges, the 
invoice amount includes those charges. If you do not capitalize freight charges, they are 
excluded from the invoice amount. 
 
Matched Amount displays the amount you have already matched. 
 
Bal-to-Distribute displays the amount remaining to be matched. 
 
The Totals group box displays information for the purchase order selected in Doc #. 
 
PO displays the amount of the purchase order. 
 
Adjustment displays the amount of the adjustments made to the invoice. 
 
Cost Variance displays the difference between the original cost of the items on the 
purchase order and their adjusted cost. 
 
Qty Cost Variance displays the difference between the original quantity of the items on 
the purchase order and their adjusted quantity. 
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7. If you want to include additional information about the invoice, click in the Comments 
text area and type the information. 

8. If you want to process more than one invoice, click in the Invoice grid then press the 
INSERT key on your keyboard. Complete the steps above for the invoice.   
 
If you want to continuing process the invoices selected, click the Invoice Header tab. 

9. In the Invoice Header section, you provide the invoice amount, including taxes, freight, and 
discounts, and also select whether this invoice is a prepayment to the vendor. 

Payee is the vendor's payee. 

Acct# is vendor's account number for your company. 

Pre-Pay determines whether this invoice is prepaid.   
Select Pre-Pay and complete the following if the invoice is prepaid: 
In Type, select the type of payment. The options are B) Bank Draft, C) Cash, K) Check, and W) 
Wire. 
In Bank #, select the bank that will process the payment. 
Enter the Date the prepayment was made. 
In Ref #, type the payment number. For example, if you selected a Type of Check, you would 
type the check number here. 
Leave the Pre-Pay option unselected if the invoice is not prepaid.  

The Invoice Amount group box displays the matched amount and allows you to included 
discounts and expensed taxes and freight. The amounts appear in both domestic currency and 
foreign currency, if applicable. 
 
Matched Amount displays the amount of the items selected for matching in the PO Items section. 
 
Disc is the discount amount and date by which you must pay the invoice in order to receive the 
discount. 
 
Expensed Taxes is the amount of taxes you are expensing. 
 
Expensed Freight is the amount of the freight you are expensing. 
 
Invoice Total displays the amount due for the invoice. To calculate this amount, Enspire subtracts 
the discount from the matched amount, then adds the expensed taxes and the expensed freight. 

10. In the PO Items section you select the items included on the invoice. To select items, choose 
Fetch (CTRL+F) from the Actions Menu. The items that appear in this section depend on the 
vendor, receipt, purchase order, and/or class selected in the Invoice grid. 

11. In the PO Items grid, select Sel for each item included on the invoice. To select all items at 
once, click the double check mark at the top of the grid. Sel, when selected, includes the item 
in the invoice matching process. A check mark indicates the item is included. Click in the box 
to place the check mark. You can also click the check button at the top of the grid to select the 
current item. If you want to exclude the item, click in the box again to remove the check 
mark. You can also click the eraser button at the top of the grid to unselect the current item. 
 
As long as an item is included in the PO Items grid, it is part of the batch and is unavailable to 
other users and processes in Enspire. To release items that you do not select, choose Clear 
PO Items from the Actions menu. Clearing these items makes them available to other areas 
of Enspire. 
 
Receipt # displays the receipt number Enspire assigned to the purchase order when it was 
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received. 
 
Doc # is the number of the purchase order that includes the item. 
 
Received is the date you received the purchase order into Enspire. 
 
Item lists the items you can include on the invoice. 
 
Class displays the class into which the item falls. The options are: B) Brokerage, D) Duty, F) 
Freight, I) Item, and L) Landed Cost. 
 

12. UM displays the item's amount unit of measure. You can change this unit of measure if 
necessary. 
 
PO displays the item's unit cost when you received it. 
 
AP is the item's unit cost from the invoice. You can change this cost if necessary. 
 

13. If you need to make an adjustment to the item's cost, type the amount in Adjust. Adjust 
allows you to make adjustments to the cost to write off small amounts. This adjustment does 
not affect the unit cost. For example, you might make an adjustment  

of $.01 because of differences in rounding. If you want to update the unit cost, choose Unit Cost 
Adjustment from the Actions menu.  

14. UM displays the item's quantity unit of measure. You can change this unit of measure if necessary. 
 
Rcvd displays the quantity of the item you received. 
 

15. Billed is the quantity of the item the invoice is billing you for. You can change this quantity if 
necessary. 
 

16. If the item is for a job, complete the Job group box as follows: 
 
Code identifies the job. 
 
Category is the type of job. The options are: E) Equipment, L) Labor, M) Material, and O) Overhead. 
 

17. If you are creating split payments or if you want to view or edit the general ledger distribution, 
complete the required information in the appropriate section of the Matched Invoice Entry dialog.  
 

18. You can save the batch or choose Post Batch to post it. If you save the batch without posting it, you 
can modify it at a later time.  

Selecting Invoices for Payment  

After you post invoices, either through Matched Invoice Processing or Service Invoices, you can select 
them for payment. 
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NOTE: If you want to pay multiple vendors from a single bank, you must fetch the invoices after you 
select each vendor. In step 6 below, the Vendor field definition includes an example. 

To select an invoice for payment: 

1. Open the Payment Selection dialog (Transactions>Vendor Payables>Payment Selection). 

2. If you want to create a new batch, choose New to display the AP Payment Batch dialog. 
If necessary, type a different Batch Description, then click OK. 

3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. 
Select the batch you want to open, then click OK. 

4. In Bank #, select the bank to be used to pay the selected invoices. 
 
Currency displays the bank's currency. 
  

5. If the bank's currency is different than your currency, enter the exchange rate in XRate. 

6. In the Vendor Filter Criteria portion of the Bank grid, set the filters to determine the 
vendors whose invoices you can select to pay. 
 
Vendor allows you to pay invoices belonging to a single vendor. If you select a vendor 
here, only invoices that belong to that vendor are available for payment. Leave Vendor 
blank if you do not want to filter by a single vendor. Leaving Vendor blank retrieves 
invoices for all vendors based on your other filter criteria. You can also retrieve invoices 
for multiple vendors individually. For example, if you want to retrieve invoices for 
vendors 100 and 200 and pay them from the same bank, type 100 in Vendor then choose 
Fetch Invoices. After those invoices are displayed, type 200 in Vendor then choose 
Fetch Invoices. Now, invoices for both vendors appear in the Invoices grid. 
 
Include Foreign determines whether you include foreign vendors when selecting 
invoices for payment. Select Include Foreign to include foreign vendors. Leave this 
option unselected to exclude foreign vendors. 
 
Min Balance Due allows you to include invoices at or above the designated minimum 
balance. If you enter a minimum balance, only invoices at or above that minimum will be 
available for payment. Leave Min Balance Due blank to include invoices regardless of 
balance. 
 
Class allows you to include only those invoices for vendors that belong to the selected 
class. If you want to include all invoices regardless of vendor class, leave Class blank. 

Include EFT determines whether you include vendors that allow you to pay electronically when 
selecting invoices for payment. Select Include EFT to include vendors that you pay 
electronically. Leave this option unselected to exclude vendors you pay electronically. 
  

7. In the Invoice Filter Criteria portion of the Bank grid, set the filters to determine the invoices you 
can select to pay. 
 
Discount Date allows you to include invoices based on the discount date you provide. If you 
select a date here, only invoices with that discount date are available for payment. Leave Discount 
Date blank if you do not want to filter by a single discount date. The discount date is the date you 
must pay the invoice by in order to receive the discount. Any payments made after the discount 
date do not receive the discount.  
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Due Date allows you to include invoices based on the due date you provide. If you select a date 
here, only invoices that have a due date on or before the date you select are available for payment. 
Leave Due Date blank if you do not want to filter by due date. 
 
Include Credits determines whether you include credit memos. Select Include Credits to include 
credit memos. Leave this option unselected to exclude credit memos. 
  

8. If you want to use more than one bank to pay invoices, click in the Bank grid then press the 
INSERT key on your keyboard. Complete the steps above for the bank. 
 
If you select more than one bank, invoices retrieved for one bank are not available to a different 
bank. 
  

9. From the Actions menu, choose Fetch Invoices. Choosing Fetch Invoices retrieves invoices 
based on your filtering criteria and places them in the Invoices grid. 
 
The Invoices section allows you to select the invoices to be paid and enter the discount and 
payment amounts. The invoices that appear in the Invoices grid will be paid by the bank selected 
in the Bank grid. The Invoices section allows you to select the invoices to be paid and enter the 
discount and payment amounts. The invoices that appear in the Invoices grid will be paid by the 
bank selected in the Bank grid. 
 

To pay an invoice: 

1. Select Sel for each invoice you want to pay. As long as an invoice is included in the Invoices 
grid, it is part of the payment batch and is unavailable to other users and processes in Enspire. 
If you have invoices that you did not select to pay, you can clear them from the batch and 
make them available. To clear invoices you did not select to pay, select Clear Non-selected 
Invoices from the Actions menu. 

Invoice displays the number of the invoice or credit memo. 
 
Doc Code identifies the document as either a C) Credit Memo or I) Invoice. 
 
Due Date is the date payment is due. 
 
Vendor No is the vendor associated with the invoice. 
 
Disc Date is the date by which you must make the payment to receive the discount. 
 
Gross Amt is the gross amount due for the invoice. 
 
EFT identifies whether the vendor accepts electronic funds transfers for payment. The options 
are Y) Yes and N) No. 
 
Exch Rate is the exchange rate between your currency and the vendor's currency.  

2.   Select the Type of payment. The options are: F) Full Payment, N) No Payment, P) Partial 
Payment, and S) Split Payment. 

3.   In Disc Avail, type the discount associated with the invoice. 

4.   In Payment Amt, type the amount of the payment. 
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5.   After you have typed a payment amount for each of the invoices you want to pay, print the 
Preliminary Check Register. 

6.   To print the Preliminary Check Register, choose Print Select from the File menu. In the 
Document Print Selection dialog, select Preliminary Check Register then click OK. 

7.   To print the checks, choose Print Select from the File menu.  

8.    In the Document Print Selection dialog, select Print Checks then click OK. In the Check Print dialog, 
select Print for each check you want to print.   

9.    Print the Daily Check Register.  To print the Daily Check Register, choose Print Select from the File 
menu. In the Document Print Selection dialog, select Daily Check Register then click OK. A message 
appears and asks if all checks and continuation stubs printed correctly. If they printed correctly, click 
Yes. If they did not print correctly, click No. 
 

10.   From the Actions menu, choose Post Batch. 
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Recurring Invoice Release 

Recurring invoices provide an easy method for handling repetitive expenses such as monthly utilities, rent, 
or service contracts. Using a recurring invoice reduces data entry and helps ensure consistent distributions. 
You can use a recurring invoice when the amount is the same every time or when the amount varies. You 
set up recurring invoices in the Recurring Invoices section of the Vendor Maintenance dialog. 

NOTE: The date you post a recurring invoice release batch does not determine the invoice date. The 
invoice date is determined by the Next Release Date for each invoice included in the batch. You establish 
the Next Release Date when you set up the recurring invoice. This date is displayed in Next Rel in the 
Invoices grid, which is discussed below. 

To release a recurring invoice: 

1. Open the Recurring Invoice Release dialog (Transactions>Vendor Payables>Recurring 
Invoice Release). 

2. Select a Release-Thru Date. Any recurring invoices with a release date on or before the 
date entered here are available for this release. 

3. In the Mode group box, select how you want to release the recurring invoices. The 
options are Manual and Auto (Batch). 
 
When you set up a recurring invoice, Auto Release determines whether the recurring 
invoice is released automatically or manually. If Auto Release is selected, the recurring 
invoice can be released automatically. If Auto Release is not selected, the recurring 
invoice must be released manually. When you release recurring invoices, you have the 
option of selecting Auto or Manual. If you select Auto, recurring invoices that have 
Auto Release selected are released automatically. You do not need to select them for 
release during the recurring invoice release process. If you select Manual, you need to 
retrieve and release recurring invoices manually. Selecting Manual also retrieves 
recurring invoices that have Auto Release selected. You then have the option of releasing 
them manually. You set up recurring invoices in the Recurring Invoices section of the 
Vendor Maintenance dialog (File Maintenance>Vendor>Vendor Master). 
  

4. If you selected a Mode of Auto (Batch), choose Post from the Actions menu. 

5. If you selected a Mode of Manual, complete the following steps. 

6. From the actions menu, choose Fetch Invoices (CTRL+F). 
 
The Invoice Amount group box and the GL Distribution grid display invoice information for the 
invoice selected in the Invoice grid. These features are discussed below. 
  

7. In the Invoices grid, select Rel for each invoice you want to release. 
 
As long as an invoice is included in the Invoice grid, it is unavailable to other users and processes 
in Enspire. If you have invoices that you did not select to release, you can clear them and make 
them available. To clear invoices you did not select to release, choose Clear Unselected Invoices 
from the Actions menu. 

8. From the Actions menu, choose Post. 
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Recurring Invoice Release Screen Details 

Invoice Grid 

The Invoices grid displays invoice and release information for the recurring invoices that you can release. 
This grid appears only if you selected the Manual Mode option. 

• Rel indicates whether an invoice is selected for release. Click the box to place a check and select 
the invoice. If you want to unselect the invoice, click the box again and remove the check. Enspire 
releases the selected invoices when you choose Post. 

• Vendor displays the vendor associated with the invoice. 

• Invoice displays the number of the invoice. 

• PO# is the purchase order number, if any, associated with the invoice. 

• Freq displays the frequency of the recurring invoice. The options are: B) Bi-monthly, M) 
Monthly, and Q) Quarterly. 

• Rel Day displays the day of the month the invoice is scheduled for release. 

• Last Rel displays the most recent date on which the invoice was released. 

• Next Rel displays the invoice's next date of release. 

• Rel Count displays the number of times the invoice has been released so far. 

• Max Rel displays the maximum number of times the invoice can be released. 

• 1099 displays whether this invoice is a 1099 invoice. Y indicates that it is a 1099 invoice. 
N indicates that it is not a 1099 invoice. 

• Terms displays the terms of sale associated with the invoice. 

• Prepaid indicates whether this invoice has already been paid. A prepaid invoice is one 
that is paid before it arrives. 

Invoice Amount Group Box 

The Invoice Amount group box displays the various amounts associated with the invoice currently selected 
in the Invoices grid. 

• Gross displays the gross amount due for the invoice. 

• Discount displays the amount of the discount applied to the invoice. 

• Tax displays the amount of tax associated with the invoice. 

• Freight displays the freight charges associated with the invoice. 

• Total displays the net amount due for the invoice. 

GL Distribution Grid 
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The GL Distribution grid displays the general ledger accounts affected by the release of the invoice 
selected in the Invoices grid. 

• Profit Center displays the profit center associated with the invoice. 

• Acct # and Description identify the general ledger account. 

• Amount is the amount credited to the general ledger account. 

  

Version 7.3.2.0 Getting Started  6-25 



Vendors  Service Invoices 

Service Invoices 

When you receive an invoice from a vendor and enter it into Enspire, you have the option of using Matched 
Invoice Entry or Service Invoices. Use Matched Invoice Entry when you buy items for the purpose of 
reselling them. Use Service Invoices when you buy services or items that you do not intend to resell, such 
as supplies. 

To process service invoices: 

1. Open the Service Invoice Entry dialog (Transactions>Vendor Payables>Service Invoices). 

2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. If 
necessary, type a different Batch Description, then click OK. 

3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. 
Select the batch you want to open, then click OK. 

4. Complete the Invoice grid as follows: 
 
Invoice # is the number of the invoice to be paid. The number must be unique for this vendor 
and period. 
 
Vendor # is the vendor that sent you the invoice. 
 
Type determines whether the unmatched document is an I) Invoice or a C) Credit Memo. 
 
Invoice Date is the date on the invoice. 
 
Terms identifies the terms of the payment. 
 
Due Date is the date payment is due. 
 
PO # is the purchase order associated with the invoice. 
 
Line # is the line number in the Invoice grid. 
 
Profit Center displays your company's profit center associated with this invoice. 
 
1099 identifies the vendor as a 1099 vendor. If 1099 is selected, the vendor is a 1099 vendor. 
If 1099 is unselected, the vendor is not a 1099 vendor. 
 
Ref # is an optional, user-defined reference number for the invoice. 
  

5. If you want to include additional information about the invoice, click in the Comments text 
area and type the information. 

6. If you want to process more than one invoice, click in the Invoice grid then press the INSERT 
key on your keyboard. Complete the steps above for the invoice. 

7. In the Invoice Header section, you provide the invoice amount, including taxes, freight, and 
discounts, and also select whether this invoice is a prepayment to the vendor.  Complete the 
following: 

Payee is the vendor's payee. 

6-26 Getting Started  Version 7.3.2.0 



Vendors  Service Invoices 

Acct# is vendor's account number for your company. 

Pre-Pay determines whether this invoice is prepaid. Select Pre-Pay if the invoice is prepaid. 
Leave this option unselected if the invoice is not prepaid.  

The Amount group box establishes the amount due for the invoice, including discounts, taxes, 
and freight. The amounts are displayed in the domestic currency and foreign currency, if 
applicable. 
 
Subtotal is the subtotal of the invoice. The subtotal does not take into account discounts, 
taxes, and freight charges. 
 
Disc is the discount amount and date by which you must pay the invoice in order to receive 
the discount. 
 
Taxes is the amount of the tax associated with the invoice. 
 
Freight Charge is the amount of the freight you are paying. 
 
Invoice Total it the total amount due for the invoice. The total includes the subtotal, 
discounts, taxes, and freight charges. 
 
Bal-to-Distribute displays the amount still to be distributed. 

Check Comments allows you to include comments that print on the check stub when the invoice is 
paid. 

8.   The Distribution Summary section determines the amount of the invoice distributed to the selected 
general ledger accounts and warehouse locations. Complete this section as follows: 

Acct # is the general ledger account that is credited or debited by the specified Amount. 

Description displays the description of the selected account. 

Location identifies the warehouse location affected by the matched invoice entry. 

Job Code is the job associated with the service invoice entry. If no job is associated with this entry, 
leave Job Code blank. 

Job Category is the category into which the selected Job Code falls. If you did not select a Job Code, 
Job Category is not available. 

Amount is the amount distributed to the selected general ledger account for the selected location. 

9.   If you are creating split payments, complete the Split Payments section.  

10.  You can save the batch or choose Post Batch to post it. If you save the batch without posting it, you 
can modify it at a later time.  
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Voiding Check Payments in the Current Period 

The Voided Check dialog allows you to void payments posted in the current period. You cannot void 
payments posted in a closed period. 

To void a check: 

1. Open the Voided Check dialog (Transactions>Vendor Payables>Voided Checks). 

2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. If 
necessary, type a different Batch Description, then click OK. 

3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. Select 
the batch you want to open, then click OK. 

4. Click in the Check grid then press the INSERT key on your keyboard. The Check grid is discussed 
below. 

5. In Payment #, select the payment you are voiding. 

6. From the Actions menu, choose Fetch Invoices (CTRL+F). Choosing Fetch Invoices displays the 
invoice or invoices associated with the selected payment. 

7. In the Invoice grid, select whether you want to reinstate the invoices. 
 
If you select Reinstate, the invoice is reinstated as an open payable. If Reinstate is not selected, 
Enspire debits the Cash account and credits the account or accounts you select in the Non-
reinstated Invoice Distributions grid. 
  

8. If Reinstate is not selected, select the distribution account or accounts to credit.  
 
To select an account, click in the Non-reinstated Invoice Distributions grid then press the INSERT 
key on your keyboard. Complete the grid as follows: 
 
Acct # is the general ledger account to credit. 
 
Profit Center is the location where the account is being credited. 
 
Amount is the amount to credit the account.  

9. Print the Voided Check Register. To print the register, choose Print Select from the File menu, 
then choose AP Voided Check Register (Proof). The register is also available for printing after 
you post. 

10. From the Actions menu, choose Post Batch. 
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About this Chapter 
This chapter covers the basics for setting up your Accounts Receivable information. It includes 
information on customer classes, holds, and contracts. 

Creating a Customer Class 
Customer classes are user-defined methods for grouping, sorting, and comparing customers. For 
example, creating a class called New and assigning new customers to it, gives you the ability to 
group and analyze your new customers. You assign a class code to a customer in the Customer 
Master Maintenance dialog. 

When you select a customer during order entry, a message appears based on that customer’s class. 
For example, you could create a class called Best and assign your top customers to it. Then, you 
could create a message to remind your order entry personnel that they are dealing with one of your 
best customers. 

To create a customer class: 

1. Open the Customer Class dialog (File Maintenance>Accounts Receivable> Classes). 

 

2. From the File menu, choose New. 

3. Complete the Customer Class grid as follows: 

Class Code is the code that identifies the customer class. This code is alphanumeric and 
can be up to 50 characters long. 

Description is the description of the customer class. If Notify Flag is selected, this 
description appears during order entry for each customer you assign this class to. 

Notify Flag, when selected, causes Enspire to display the class description when you 
create an order for a customer belonging to this class. Leave this option unselected if you 
do not want to receive notification during order entry. 
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Text Description allows you to type a longer description of the class. Click the down 
arrow, type your message in the text box, then click OK.  

 

4. From the File menu, choose Save. 

Creating a Customer Contract 
Enspire includes two types of contracts you can assign to customers: price contracts and quantity 
contracts. 

• A price contract provides specific pricing to a customer based on the items that are 
purchased. To calculate contract prices, you can use a quantity table or a pricing formula, 
or you can establish a specific price for the item. You assign a price contract to a 
customer in the Price Contracts section of the Customer Master Maintenance dialog. 

• A quantity contract is a means of tracking purchase quantities. A quantity contract does 
not influence pricing or quantity breaks. You use customer quantity contracts when a 
customer agrees to purchase a given quantity of certain items during a specific time 
frame. The quantity contract tracks the dollar amount and/or the quantity of units 
purchased. You can also have Enspire automatically void the contract when the customer 
reaches the contracted amount or quantity. Quantity contracts can also be used to 
guarantee minimum stock levels for a specific customer. You assign a quantity contract 
to a customer in the Qty Contracts section of the Customer Master Maintenance dialog. 

Creating a Customer Price Contract 
1. Open the Contract Price Assignments dialog (File Maintenance>Accounts 

Receivable>Contract Price Assignments). 

2. To open this dialog through the Customer Master Maintenance dialog, click the 
Customer tab, click Price Contracts, then click Edit Price Contract. 
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3. In the Contract Price Assignments dialog, choose New from the File menu. 

4. In Contract, type the code that identifies the contract. This code is 
alphanumeric and can be up to ten characters long. 

5. In Description, type a description of the contract. 

6. In Start Date, type the date the contract takes effect. 

7. In End Date, type the last date the contract remains in effect. 

8. In Cost Basis, select the cost used to calculate the cost for the contract. The 
options are: 

A) Actual Cost - This option uses the cost determined by your company’s 
inventory costing method: LIFO, FIFO, or weighted average. 

R) Next Cost - This option uses the cost of the item when you last purchased it. 

S) Standard Cost - This option uses the item’s standard cost, as established in 
the Pricing section of the Item Master dialog. 

9. In Currency, select the currency in which the prices for the contract are 
calculated. 

10. Assign a Priority to the contract.  

Priority determines the order in which Enspire applies the contracts, if you have 
more than one price contract assigned to a customer. Enspire applies the contract 
with the greatest priority that also meets the beginning date and ending date 
requirements. For example, a contract with a priority of 1 is applied before a 
contract with a priority of 2. 
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11. In Rounding, select whether you round the contract price to 2, 3, or 4 decimal 
places. For example, the price is $1.3472. Selecting 4 leaves the price as is. 
Selecting 3 changes the price to $1.347. Selecting 2 changes the price to $1.35. 

12. If items on the contract are also eligible for customer rebates, select Customer 
Rebates. If items are not eligible for rebates, unselect Customer Rebates. 

13. If items on the contract are also eligible for family discounts, select Family 
Discounts. If items are not eligible for family discounts, unselect Family Discounts. 

14. Add items, product groups, and/or families to the contract. Adding items is discussed 
below. For information on adding product groups and families to a contract, see the 
Enspire online help. 

15. After you have added items, product groups, and/or families to the contract, choose 
Save. 

Adding Items to a Price Contract 
1. In the Details section of the Contract Price Assignments dialog, click Items. 

2. If the start date for the item is different than the start date for the overall contract, 
type the Start Date in the Items section. If the start dates are the same, leave Start 
Date blank in the Items section. 

3. If the end date for the item is different than the end date for the overall contract, type 
the End Date in the Items section. If the end dates are the same, leave End Date 
blank in the Items section. 

4. Complete the Item grid as follows: 

Item is the item included on the contract. 

UM is the item’s unit of measure that determines the contract price. 

Method determines how the item’s price is calculated for the contract. If you select a 
method of Quantity, the Price Contract Quantity Brackets dialog appears. Here, you 
set the quantity discounts for the contracts. For information on this dialog, see the 
Enspire online help. 

Formula determines the formula used to calculate the contract price.  

Formula % is the percentage discounted from the selected method. Formula % is 
inactive for the Manual and Quantity methods. 

Cost Basis is the cost used in the formula calculation to determine the contract price. 
Cost Basis is inactive for Dollar Amount, List Down, Reference Price Down, and 
List Multiplier formulas. 

Round determines whether you round the contract price to 2, 3, or 4 
decimal places. For example, the price is $1.3472. Selecting 4 leaves the 
price as is. Selecting 3 changes the price to $1.347. Selecting 2 changes the 
price to $1.35. 

If this item is also eligible for customer rebates, select Customer Rebates. 
If it is not eligible for rebates, unselect Customer Rebates. 
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If this item is also eligible for family discounts, select Family Discounts. If 
it is not eligible for family discounts, unselect Family Discounts. 

5. If you selected a method of Quantity, Use Customer Bracket becomes 
active.  

Use Customer Bracket determines whether the customer’s minimum 
quantity bracket also applies to the price contract quantity table. You 
determine the minimum quantity bracket in the Pricing section of the 
Customer Master Maintenance dialog. For example: Use Customer 
Bracket is selected. Bracket number 2 of the price contract requires that the 
customer purchase 100 items to receive the associated contract price. A 
customer has a minimum quantity bracket of 2 and orders 10 items. The 
customer receives the contract price associated 100 items, as determined by 
bracket 2, because of the minimum quantity bracket. If Use Customer 
Bracket is unselected, the customer receives the contract price associated 
with 10 items. 

6. When you have finished adding items to the contract, choose Save. 

Assigning a Price Contract to a Customer 
Assigning a price contract to a customer makes the contract available to that customer and its ship-
to locations.  

To assign a price contract to a customer: 

1. In the Contract Price Assignments dialog, open the contract you want to assign. 

2. Click the Customers tab. 

3. To add a single customer, click in the Customer grid then press the INSERT key on your 
keyboard. 
 
To add customers based on filters you apply, click Add Customers. In the Filter Customers 
dialog, select the filters you want to apply then click OK. 

4. Complete the Price Contracts grid as follows: 

Customer is the customer being assigned to the contract. 

Priority determines the order in which Enspire searches the contracts for a match. Once a 
match is found, Enspire uses that contract and ignores others with a lower priority. The 
highest priority is 1. 

ShipTo is the customer’s ship-to location the contract applies to. If you want the contract 
to apply to all customer ship-tos, leave ShipTo blank. 

Begin Date is the first date this contract takes effect for this customer. This date must be 
equal to or later than the begin date for the contract. 

End Date is the last date this contract is in effect for this customer. This date must be 
equal to or earlier than the end date for the contract. 

5. From the File menu, choose Save. 
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Creating a Customer Quantity Contract 
Before you can create a quantity contract for a customer, that customer must have at least one 
price contract assigned to it. 

To assign a quantity contract to a customer: 

1. In the Customer Master Maintenance dialog, click the Customer tab. 

2. Click Qty Contracts then click Edit Quantity Contract. 

 

3. In the Quantity Contract dialog, choose New from the File menu. 

4. In Contract #, select the price contract associated with the quantity contract. 

5. In Ship #, select the ship-to location that the quantity contract applies to. 

6. If you want to set a different start date and end date for the selected ship-to 
location, type those dates in Start Date and End Date. 

7. Add items to the contract. 

8.  To add an item, click in the Items grid then press the INSERT key on your 
keyboard. Complete the Items grid as described in the steps below. 

9. Complete the Item Information fields in the Items grid as follows: 

Item is the item included on the contract. Only items included on the selected price 
contract are available here. 

Void Price determines whether you void the price contract associated with the item once 
the customer has met the conditions of the quantity contract. Select this option to void the 
price contract. Leave this option unselected to keep the price contract in force. 
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10. Complete the Effective Period fields in the Items grid as follows: 
 
If you want to set a different start date and end date for this item, enter those dates in 
Begin Date and End Date. 

11. Complete the Quantity fields in the Items grid as follows: 

If you are guaranteeing that you will have a certain quantity always in stock for the 
customer, type that quantity in Min Stock. 

If you are contracting that you will sell a certain quantity to the customer, type that 
quantity in Contract. Otherwise, leave Contract set to 0 (zero). Actual displays the 
contracted quantity the customer has already purchased. Balance displays the quantity 
that the customer must still purchase to fulfill the contract. 

12. Complete the Amount fields in the Items grid as follows: 

If you are contracting that you will sell a certain amount to the customer, type that 
amount in Contract. Otherwise, leave Contract set to 0.00. Actual displays the 
contracted amount the customer has already purchased. Balance displays the amount that 
the customer must still purchase to fulfill the contract. 

13. When you have finished adding items to the contract, choose Save. 

14. If you want to add another contract for the same customer, choose New. If you are 
finished, click OK. 
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Freight Allowances 
A freight allowance is the amount discounted from freight charges for a given order. To calculate 
freight allowances, Enspire uses the total freight charges including handling fees, COD fees, and 
insurance. If you assign a freight allowance code to a customer, the allowance associated with the 
bracket appears automatically during order entry. However, you can override the amount of the 
allowance if necessary. You assign a freight allowance code to a customer in the Shipping section 
of the Customer ShipTo dialog. 

To add freight allowances: 

1. Open the Freight Allowances dialog (File Maintenance>Accounts Receivable>Freight 
Allowances). 

2. From the File menu, choose New. 

3. In Allowance Code, type a code that identifies the allowance. This code is alphanumeric 
and can be up to 10 characters long. 

4. Select a Basis. The basis you select determines the value used to calculate the allowance. 
The options are as follows: 
 
A) Amount - This option uses the amount of the order to calculate the allowance. 
 
U) Units - This option uses the quantity of the items being ordered to calculate the 
allowance. 
 
V) Volume - This option uses the volume of the items being ordered to calculate the 
allowance. 
 
W) Weight - This option uses the weight of the items being ordered to calculate the 
allowance.  

5. Click in the Brackets grid then press the INSERT key on your keyboard. 

6. Complete the Brackets grid as follows: 
 
Bracket identifies the various levels used to calculate freight allowances. Enspire 
provides the bracket numbers automatically and they cannot be changed. 
 
 Order Amount, Order Units, Order Volume, or Order Weight is the quantity or 
amount used to determine whether an order qualifies for the associated freight allowance. 
For example, if you select a Basis of Volume, then the freight allowance depends on the 
volume you type here. 
 
 Allowance Amount is the amount of the allowance for the bracket. To specify a 
percentage instead of, or in addition to, an amount, use Rate %. 
 
 Rate % is the percentage of the freight charges used as the allowance for this bracket. 
To specify an amount instead of, or in addition to, a percentage, use Allowance Amount. 
  

7. From the File menu, choose Save.  
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In the example below, no freight allowances are given for orders under $100. Orders 
between $100 and $499.99 receive an allowance of $2.00. Orders between $500 and 
$999.99 receive an allowance of 50 percent of the freight charges. Orders of $1,000 and 
above receive an allowance of 100 percent of the freight charges, which means customers 
assigned to this allowance code pay no freight on orders of $1,000 and over. 
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Freight Charges 
Freight charges allow you to override the rates charged by your inside and/or outside carriers with 
the rates on the freight table you set up here. When you assign a freight table to a customer, 
Enspire applies the charges associated with the appropriate bracket instead of using the freight 
charges for the selected carrier. You can also enter a specific freight charge during order entry. 
The freight charges in a table are based on the amount of the order. 

To set up a freight charges table: 

1. Open the Freight Charges dialog (File Maintenance>Accounts Receivable>Freight 
Charges). 

2. From the File menu, choose New. 

3. In Charge Code, type a code that identifies the charge. This code is alphanumeric and 
can be up to 10 characters long. 

4. Select a Basis. The Basis you select determines how the freight charges are calculated. 
The options are as follows: 

 a.) Frt Amt + (NetBill*Rate) - This option multiplies the amount you are billing the 
customer by the percentage in Rate % and adds that amount to the Freight Amount. 
You determine the Rate % and the Freight Amount in the Brackets grid. In the example 
below, a $40 order has a freight charge of $5. A $70 order has a freight charge of $6.40 
(2 percent of $70 is $1.40, which is then added to the Freight Amount of $5.) A $300 
order has a freight charge of $15, which is 5 percent of $300. 
 

 
 
 b) Frt Amt * %Filled - This option multiplies the Freight Amount by the percentage of 
the order that has been filled. You determine the Freight Amount in the Brackets grid. In 
the example below, a $200 order that is 50 percent filled has a freight charge of $3, which 
is 50 percent of $6. A $700 order that is 30 percent filled has a freight charge of $4.20, 
which is 30 percent of $14. 
 

  

5. Click in the Brackets grid then press the INSERT key on your keyboard. 

6. Complete the Brackets grid as follows: 
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 Bracket identifies the various levels used to calculate freight charges. Enspire provides 
the bracket numbers automatically and they cannot be changed. 
 
 Order Amount is the minimum amount required for an order to qualify for the 
associated freight charge. 
 
 Freight Amount is the amount of the freight charge for the bracket. 
 
 Rate % is the percentage of the order amount that is applied as a freight charge. 

7. When you have finished adding brackets, choose Save from the File menu. 
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Reason Codes 
A/R reason codes allow you to track and analyze the reasons for accounts receivable adjustments, 
credit memos, and debit memos. Adjustment reason codes also determine the default general 
ledger account when you enter adjustments. 

To add an A/R reason code: 

1. Open the Reason Code Maintenance dialog (File Maintenance>Accounts 
Receivable>Reason Codes). 

2. From the File menu, choose New. 

3. Select a Document Type. The type you select determines the type of document 
associated with the corresponding reason code. The types are: 
 
 A) Adjustments - Only reason codes with this type are available for selection when you 
create an AR adjustment. 
 
 C) Credit Memos - Reason codes with this type are available for selection when you 
create a credit memo. If you try to select a reason code with a type of Adjustments or 
Debit Memos, you receive a warning. However, you can still use that reason code. 
 
 D) Debit Memos - Reason codes with this type are available for selection when you 
create a debit memo. If you try to select a reason code with a type of Adjustments or 
Credit Memos, you receive a warning. However, you can still use that reason code. 
  

4. In Reason Code, type a code that that identifies the reason. This code is alphanumeric 
and can be up to four characters long. 

5. In Description, type a description of the code. 

6. If you want the Reason Code Analysis report to include transactions that use this reason 
code, select Printed. If Printed is not selected, the Reason Code Analysis report does not 
include transactions that use this reason code. 

7. In GL Expense Acct #, select the general ledger account associated with the reason code. 
If necessary, you can override this account when using the reason code. 

8. If you are using departments, select the department associated with the reason code in Dept. Dept 
is inactive if you do not use departments. 

9. From the File menu, choose Save. 

  

Salesperson 
In Enspire, you can set up both inside and outside sales people and track a variety of information 
for your sales force, including: commissions, spiffs, and quotas. You assign an inside and/or an 
outside salesperson to a customer in the Codes section of the Customer ShipTo dialog. This 
salesperson is assigned to orders for the customer during order entry.  

To add a sales person: 

1. Open the Salesperson Maintenance dialog (File Maintenance>Accounts 
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Receivable>Sales Persons). 
2. From the File menu, choose New. 
3. In Sales Rep Code, type a code that identifies this salesperson. 

 
 Name displays the salesperson's last name after you type it in Last Name. 
  

4. If the salesperson is involved in inside sales, select Inside OK. 
5. If the salesperson is involved in outside sales, select Outside OK. 

 
 Inside OK indicates that the salesperson handles inside sales. Outside OK indicates that 
the salesperson handles outside sales. Select both Inside OK and Outside OK to indicate 
that the salesperson handles both inside and outside sales. If neither Inside OK nor 
Outside OK is selected, the sales person is not available for selection during order entry 
or as a default salesperson in the Codes section of the Customer ShipTo Locations dialog. 

6. Complete the information in the Personal Info tab as follows: 
 
 First Name is the salesperson's first name. 
 

 Last Name is the salesperson's last name. 
 
 Social Security # is the salesperson's Social Security Number. 
 
 Hired Date is the date the employee was hired. 
 
 Commission Plan is the commission plan assigned to the salesperson. For 
information, click Commission Plans. 
 
 Spiff determines whether the salesperson is eligible to receive Spiffs. If the 
salesperson is not eligible for spiffs, leave this option unselected. Spiffs are 
percentages of sales or profits, or flat per-unit amounts paid to a salesperson as 
incentive for selling particular items. You determine whether you pay spiffs on 
an item in the Controls section of the Item Master dialog. You determine how 
the spiff is paid in the Controls section of the Warehouse Item dialog. 
 
 The Demographics area displays the salesperson's address, phone, and email 
information. To add or edit this information, double click in the Demographics 
area to display the Salesperson Address dialog. 
  

7. If another sales person receives an override from this salesperson's commission, 
create a commission override. Commission overrides create additional 
commission awards. They do not reallocate existing commissions. To reallocate 
existing commissions, you create a commission adjustment. To create a 
commission override, click the Commission Override tab. Click in the 
Commission Override grid, then press the INSERT key on your keyboard and 
complete the grid as follows: 
 
 
Override Rate % is the percentage of the salesperson's commission that is 
given to the selected Override Rep as a commission override. For example: A 
salesperson's commission is 10 percent. Another salesperson receives a 1 
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percent commission on sales that the first salesperson makes. If the first 
salesperson sells an item for $100, that salesperson receives $10 in commission 
and the second salesperson receives $1 as an override. 

Description allows you to include a description of the override. 
 
Override Rep is the salesperson or salespersons awarded the commission override. 
  

8. If you want to set sales and/or profit quotas for the salesperson, click the Yearly Recap 
tab. In Year, select the year you want to set the quotas for then click Fetch. 
 
 In Sales Quota, type the amount of sales the salesperson should have for each period. 
 
 In Profit Quota, type the amount of profit the company should earn from the 
salesperson's sales. 
 
 In Units Quota, type the number of units the salesperson should sell during each period. 
  

9. From the File menu, choose Save.  
 

To review the salesperson's performance for a given year, click the Yearly Recap tab. In Year, 
select the year you want to review then click Fetch. The Recap grid contains the following 
information: 

• Period lists the accounting periods. 

• Sales Quota is the amount of the sales the salesperson should have for each period. 

• Profit Quota is the amount of the profit the company should earn from the salesperson's 
sales. 

• Units Quota is the quantity of units the salesperson should sell during each period. 

• Sales is the amount of the salesperson's actual sales. 

• Cost is the cost of the items sold by the salesperson. 

• Units is the quantity of units the salesperson actually sold. 

• Commission is the commission earned by the salesperson. 

• Profit is the profit your company has earned on sales by this salesperson. 

• Margin % is the margin your company has earned on sales by this salesperson. 
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Sales Teams 
Sales teams allow you to group salespeople and assign each salesperson to a specific item, group 
of items, and or a specific customer type. For example, you can build sales teams that handle large 
accounts, or, you can build sales teams based on an individual salesperson's expertise with a 
particular item. 

To create a sales team: 

1. Open Sales Team Maintenance dialog (File Maintenance>Accounts Receivable>Sales 
Teams). 

2. From the File menu, choose New. 
3. In Sales Team Code, type a code that identifies this sales team. This code is alpha-

numeric and can be up to four characters long.  
4. In Name, type the name you want to assign to the sales team. 
5. If the sales team is involved with inside sales, select Inside OK. 
6. If the sales team is involved with outside sales, select Outside OK. 

 
 Inside OK indicates that the sales team handles inside sales. Outside OK indicates that 
the sales team handles outside sales. Select both Inside OK and Outside OK to indicate 
that the sales team handles both inside and outside sales. 
  

7. If you want to assign individual items, all items with a product group, and/or a specific 
customer type to members of a sales team, click the Groups & Items tab. Click in the 
Groups & Items grid then press the INSERT key on your keyboard and complete the grid 
as follows: 
 
 Salesrep is the salesperson assigned to the item and/or product group. 
 
 Product Group is the group that contains the items you want to assign to the selected 
salesperson. 
 
 Item is the item you want to assign to the selected salesperson. 
 
 Commission Plan is the commission plan assigned to the selected salesperson when that 
salesperson sells the assigned items or sells to customers belonging to the selected 
customer type. When the salesperson sells the assigned items or sells to the selected 
customer type, the plan selected here overrides the plan, if any, assigned to the 
salesperson in the Salesperson Maintenance dialog. 
 
 Customer Type allows you to assign a customer type to a salesperson. Whenever the 
salesperson sells to a customer within the selected type, that salesperson receives 
commission based on the selected Commission Plan. For information on customer types, 
click Type Codes. 
  

8. If you want to set sales and/or profit quotas for the sales team, click the Yearly Recap 
tab. In Year, select the year you want to set the quotas for then click Fetch. 
 
 In Sales Quota, type the amount of sales the sales team should have for each period. 
 
 In Profit Quota, type the amount of profit the company should earn from the sales 
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team's sales. 
  

9. From the File menu, choose Save. 

The Recap grid contains the following information: 

• Period lists the accounting periods. 

• Sales Quota is the amount of the sales the sales team should have for each period. 

• Profit Quota is the amount of the profit the company should earn from the sales team's sales. 

• Sales is the amount of the sales team's actual sales. 

• Cost is the cost of the items sold by the sales team. 

• Commission is the commission earned by the sales team. 
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Terms of Sale 
Terms of sale refer to the terms you grant your customers as well as the terms your vendors grant 
you. You assign terms of sale to customer ship-to locations in the Codes section of the ShipTo 
Locations dialog. You assign terms of sale to vendors in the Buy Codes section of the Vendor 
Maintenance dialog. 

Enspire includes the terms of sale described below. Click a term to display instructions for setting 
it up. 

• COD Plus 

COD Plus allows you to collect an outstanding balance from a customer while invoking 
COD terms on current shipments. For example: A customer has an outstanding balance of 
$1,000. This customer wants to purchase an additional $500 worth of merchandise. COD 
Plus allows you to charge for the current merchandise as well as add a portion of the 
outstanding balance, either as a percentage or a flat rate. Enspire then applies the extra 
COD amount to the outstanding balance until it is paid off. Once it is paid off, the COD 
Plus term functions as a typical COD.  

• Installment 

Installment allows you to set up a payment plan for a customer. You can schedule up to 
99 payments and include an interest rate, late fees, and early payment discounts. 

• Manual 

Manual establishes a specific due date for use on an invoice. For example, you negotiate 
a large sale. As part of the negotiation, you agree that payment is due on 11/22/02. You 
could use manual terms to define that specific date as the due date.  

• Proximo 

Proximo defines the due dates and, optionally, discount dates as specific days of the 
month. For example, if the discount date is the first and the due date is the 15th, a 
customer has until the first of the month to receive the payment discount. You can split 
proximo terms into installment-like payments. 

Or, you can set up proximo terms as one full payment. The full payment option 
typically includes declining discount percentages in each period. Proximo terms 
differ from installment terms in that proximo terms do not allow for interest or 
late fees. Proximo terms also give you the ability to include different levels of 
prompt payment discounts.  

• Standard 

 Standard allows you to set up standard terms of sale, for example, Net 30 and 2 
Percent 10 Days Net 30. Standard terms can be COD or non-COD. If they are 
not COD, they involve a number of days within which full payment is due. Non-
COD Standard Terms can also include a discount.  

• Conditional 

 Conditional functions in a similar manner to Standard terms. Additionally, 
Conditional terms allow you to set up the following conditions: minimum order 
amount, maximum order amount, and maximum days past due. If none of the 
conditions are met, the standard terms are used. However, if at least one of the 
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conditions is met, Enspire uses the Terms Code selected in the Conditional 
Terms group box. 
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Setting Up COD Plus Terms of Sale 
COD Plus allows you to collect an outstanding balance from a customer while invoking COD 
terms on current shipments. For example: A customer has an outstanding balance of $1,000. This 
customer wants to purchase an additional $500 worth of merchandise. COD Plus allows you to 
charge for the current merchandise as well as add a portion of the outstanding balance, either as a 
percentage or a flat rate. Enspire then applies the extra COD amount to the outstanding balance 
until it is paid off. Once it is paid off, the COD Plus term functions as a typical COD. 

To set up COD plus terms of sale: 

1. Open the Terms of Sale Maintenance dialog (File Maintenance>Accounts 
Receivable>Terms of Sale). 

2. From the File menu, choose New. 
3. In Terms Code, type a code that identifies the terms of sale. This code is alphanumeric 

and can be up to four characters long. 
4. In Description, type a description of the terms of sale. 
5. Select a Type of C) COD Plus. After you select a Type, the COD Plus section becomes 

the active section. 
6. If you want to include a brief message on any invoice that uses this COD Plus terms of 

sale, type it in Message. 
7. OK for Vendors is not available to COD Plus terms. 
8. Select the Customer that the terms apply to. 
9. If the terms apply only to a single ship-to location, select it in Ship No. 

 
 Leave Ship No blank if the terms apply to all of the customers ship-to locations. 
   

10. Start Date displays the date the terms were created, which is also the date the terms 
begin. 

11. Select a COD Type. The types are as follows: 
 
a) POS Payment Required - This option indicates that payment is required when the order 
or invoice is entered into Enspire. 
 
 b) COD Terms, No Credit Hold - This option indicates that COD terms apply and that 
the credit hold code is turned off. 
 

c) COD Terms, Credit Hold Allowed - This option indicates that COD terms apply 
and that the credit hold code is turned on.  

12. Complete the Open Balance Amount group box as follows: 
 
 Original is the original amount of the outstanding balance. 
 
 Collected is the amount of the outstanding balance that you have collected so far. 
 
 Remainder is the amount of the balance still outstanding. 
  

13. Complete the Invoice Amount group box as follows: 
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 Amount is the extra amount added to the invoice until the outstanding balance is paid 
off. 
 
 Percentage is the percentage of the invoice amount that is applied to the outstanding 
balance until it is paid off. 
 
 Minimum is the minimum amount that you want to apply to the outstanding balance. If 
the amount to be applied to the outstanding balance is lower than the Minimum, Enspire 
automatically increases that amount to the minimum. Minimum applies only if you 
provide a Percentage and the Minimum amount must be greater than the amount in 
Amount. 
 
 In the example Invoice Amount group box below, a flat amount of $25 plus 10 percent 
of the invoice amount is added to each invoice until the outstanding balance is paid off. If 
the invoice amount is $200, $45 is added to that invoice ($25 plus 10 percent of $200). If 
the invoice amount is $75, $35 is added to that invoice because $25 plus $7.50 (10 
percent of the invoice amount) does not equal the minimum of $35. 
 

 
   

14. From the File menu, choose Save. 
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Setting Up Conditional Terms of Sale 
Conditional functions in a similar manner to Standard terms. Additionally, Conditional terms 
allow you to set up the following conditions: minimum order amount, maximum order amount, 
and maximum days past due. If none of the conditions are met, the standard terms are used. 
However, if at least one of the conditions is met, Enspire uses the Terms Code selected in the 
Conditional Terms group box. 

To set up conditional terms of sale: 

1. Open the Terms of Sale Maintenance dialog (File Maintenance>Accounts 
Receivable>Terms of Sale). 

2. From the File menu, choose New. 

3. In Terms Code, type a code that identifies the terms of sale. This code is alphanumeric 
and can be up to four characters long. 

4. In Description, type a description of the terms of sale. 

5. Select a Type of T) Conditional. After you select a Type, the Standard section becomes 
the active section. 

6. If you want to include a brief message on any invoice that uses this Conditional terms of 
sale, type it in Message. 

7. OK for Vendors is not available to Conditional terms. 

8. Select a COD Type. The types are as follows: 
 
a) Not COD Terms - This option indicates that COD terms do not apply. If you select this 
option, you determine when the payment is due in Full Payment Due. 
 
b) POS Payment Required - This option indicates that payment is required when the order 
or invoice is entered into Enspire. 
 
c) COD Terms, No Credit Hold - This option indicates that COD terms apply and that the 
credit hold code is turned off. 
 
d) COD Terms, Credit Hold Allowed - This option indicates that COD terms apply and 
that the credit hold code is turned on. 
  

9. In Full Payment Due enter the number of days until full payment is due. For example, if the 
number of days is set to 30, the full payment is due 30 days after the invoice date. This option 
applies only if you selected a COD Type of Not COD Terms. 

10. Set up the discount levels. Click in the Discount Brackets grid. Press the INSERT key on your 
keyboard then complete the Discount Brackets grid as follows: 

 
 Bracket identifies the various levels used to calculate contract prices. Enspire provides the 
bracket numbers automatically and they cannot be changed. 
 
 Days is the maximum number of days after the invoice date that a payment can be made and still 
qualify for the discount. 
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 Discount Rate % is the percentage discounted from the amount due if payment is made within 
the specified number of days. 
  

11. If you selected a COD Type of Not COD Terms, the Payment Message group box appears. 
Complete the Payment Message group box as follows: 
 
Message determines the format of the message included on the invoice. The format options are as 
follows: 
 
 a) Net Amount Message - This message appears in the body of the invoice and displays the net 
amount due if the invoice is paid by a specific date, for example: "If paid by 07/27/02, your net 
amount due is $545.67." 
 
 b) Gross Amount Message - This message appears in the body of the invoice and displays the 
gross amount due if the invoice is not paid by a specific date, for example: "If NOT paid by 
01/20/03, your gross amount due is $9,023.18." 
 
 c) Pay on Date Message - This message appears at the bottom of the invoice and displays the 
amount a customer should pay after a specific number of days, for example: "After 10 days, please 
pay $121.77." 
 

 
 d) Deduct Amount Message - This message appears in the body of the invoice and 
displays the amount the customer can deduct from the payment if the invoice is paid 
before a specific date, for example: "If paid before 11/22/02, you may deduct $25.00." 

 N) Do not Include Message - This option does not include a message on the invoice. 
 
Days is the number of days added to the invoice date to determine the date included in 
the message. For example: You select a Message option of 1. The invoice date is May 7, 
2002. Days is set to 5. The date that appears on the message is May 12, 2002. 
 
Base determines the invoice amount used for calculating payment discounts. The options 
are: 
 
 B) Invoice Subtotal before Surcharge 
 
 S) Invoice Subtotal before Tax and Freight 
 
 T) Invoice Total 
 
Adj % is the percentage to increase or decrease the amount used in the payment 
message. 
 
 
 
If the amount of an invoice is $500 and its due date is July 22, 2002, the example 
Payment Message group box below would include the message that the customer could 
deduct $50 (an adjustment of 10 percent of the invoice total before a surcharge) if the 

Version 7.3.2.0 Getting Started  7-23 



Accounts Receivable  Terms of Sale 

invoice is paid on or before July 27, 2002 (5 days after the invoice date). 

 
   

12. Complete the Conditional Terms group box as follows: 
 
 Terms Code identifes the conditional terms to use if any of the minimum/maximum 
order amount or maximum days past due conditions are met. 
 
 Min Order Amount determines the minimum amount an order must exceed to qualify 
for the terms established in the Discount Brackets grid. If the amount of the order is less 
than or equal to the Min Order Amount, Enspire uses the conditional terms selected in 
Terms Code. 
 
 Max Order Amount determines the maximum amount an order cannot exceed to 
qualify for the terms established in the Discount Brackets grid. If the dollar amount of the 
order is greater than or equal to the Max Order Amount, Enspire uses the conditional 
terms selected in Terms Code. 
 
 Max Past Due determines the maximum number of days past due that any invoice for 
the customer cannot exceed in order to qualify for the terms established in the Discount 
Brackets grid. If the number of days past due is greater than or equal to the Max Past 
Due, Enspire uses the conditional terms selected in Terms Code. When determining the 
maximum days past due, Enspire ignores invoices in dispute. 
 
 In the example Conditional Terms group box below, any order less than $99,999 
qualifies for the terms in the Discount Brackets grid as long as the customer has no 
invoice 5 days or more past due. 
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13. From the File menu, choose Save. 
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Setting Up Installment Terms of Sale 
Installment allows you to set up a payment plan for a customer. You can schedule up to 99 
payments and include an interest rate, late fees, and early payment discounts. 

To set up installment terms of sale: 

1. Open the Terms of Sale Maintenance dialog (File Maintenance>Accounts 
Receivable>Terms of Sale). 

2. From the File menu, choose New. 

3. In Terms Code, type a code that identifies the terms of sale. This code is alphanumeric 
and can be up to four characters long. 

4. In Description, type a description of the terms of sale. 

5. Select a Type of I) Installment. After you select a Type, the Installment section becomes 
the active section. 

6. If you want to include a brief message on any invoice that uses this Installment terms of 
sale, type it in Message. 

7. If you want to use these terms of sale as vendors' terms that apply to you or as your terms 
that apply to your customers, select OK for Vendors. Leave OK for Vendors unselected 
to indicate that the terms of sale are your terms that apply only to your customers. 

8. In Installments, enter the number of installments for these terms of sale. 

9. In Interest Rate %, type the annual interest rate. For example, if you type 9, the annual 
interest rate is 9 percent. 

10. Complete the Discount group box as follows: 
 
 Percentage is the percentage of the payment discounted if the payment is early. 
 
 Days is the number of days before the due date a payment must be made in order to 
receive the discount specified in Percentage. For example: A payment is due on the 16th. 
Days is set to 5. To receive the discount, the payment must arrive on or before the 11th. 
  

11. Complete the Frequency group box as follows: 
 
 Code determines the frequency of the installment payments. The options are as 
follows: 
 
 F) Fixed - This option allows you to specify the day of the month on which the 
payment is due. You type the day in Day. For example, if you type 10, the 
payment is due on the tenth of every month. 
 
 M) Monthly - This option sets the first of every month as the due date. 
 
 S) Semi-Monthly - This option sets the first and the sixteenth of every month as 
the due dates. 
 
 X) Every X Days - This option allows you to determine the number of days 
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between payments. You type the number of days in Day. For example, if you 
type 15, a payment is due every 15 days. 
 
 Day applies if you select a Code of Fixed or Every X Days. If you select Fixed, 
Day is the day of the month on which the payment is due. If you select Every X 
Days, Day is the number of days between payments. 
  

12. Complete the Late Fees group box as follows: 
 
 Percentage is the percentage added to the payment if the payment is made after 
the Grace Period expires. 
 
 Amount is the flat amount added to a payment if the payment is made after the 
Grace Period expires. 
 
 Minimum is the minimum late fee assessed. If the late fee is lower than the 
Minimum, based on the specified Percentage and/or Amount, Enspire 
automatically increases the late fee to the minimum. 
 

 Grace Period is the number of days after the due date that late fees start accruing. For 
example: A payment is due on the 10th. Grace Period is set to 3. Any payment not made 
by the 13th is subject to the late fees. 
  

13. Enter a Cutoff Day. The Cutoff Day establishes the day beyond which the first payment 
is due one period later. For example: The payment is due on the 5th of every month. The 
Cutoff Day is set to 25. If a purchase is made on May 23, the first payment is due on 
June 5. However, if the purchase is made on May 26, the first payment is due on July 5. 

14. Complete the Payment Message group box as follows: 
 
 Message determines the format of the message included on the invoice. The format 
options are as follows: 
 
 a) Net Amount Message - This message appears in the body of the invoice and displays 
the net amount due if the invoice is paid by a specific date, for example: "If paid by 
07/27/03, your net amount due is $545.67." 
 
 b) Gross Amount Message - This message appears in the body of the invoice and 
displays the gross amount due if the invoice is not paid by a specific date, for example: 
"If NOT paid by 01/20/03, your gross amount due is $9,023.18." 
 
 c) Pay on Date Message - This message appears at the bottom of the invoice and displays 
the amount a customer should pay after a specific number of days, for example: "After 10 
days, please pay $121.77." 
 
 d) Deduct Amount Message - This message appears in the body of the invoice and 
displays the amount the customer can deduct from the payment if the invoice is paid 
before a specific date, for example: "If paid before 11/22/02, you may deduct $25.00." 
 
 N) Do not Include Message - This option does not include a message on the invoice. 
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Days is the number of days added to the invoice date to determine the date included in 
the message. You can enter as many as 45, 60, or 90 days to add to the invoice date.   For 
example: You select a Message option of 1. The invoice date is May 7, 2002. Days is set 
to 5. The date that appears on the message is May 12, 2002. 

Base determines the invoice amount used for calculating payment discounts. The options 
are: 
 
 B) Invoice Subtotal before Surcharge 
 
 S) Invoice Subtotal before Tax and Freight 
 
 T) Invoice Total 
 
 Adj % is the percentage to increase or decrease the amount used in the payment 
message. 
 
 If the amount of an invoice is $500 and its due date is July 22, 2002, the example 
Payment Message group box below would include the message that the customer could 
deduct $50 (an adjustment of 10 percent of the invoice total before a surcharge) if the 
invoice is paid on or before July 27, 2002 (5 days after the invoice date). 
 

 
   

15. From the File menu, choose Save.  
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Setting Up Manual Terms of Sale 
Manual establishes a specific due date for use on an invoice. For example, you negotiate a large 
sale. As part of the negotiation, you agree that payment is due on 11/22/02. You could use manual 
terms to define that specific date as the due date. 

To set up manual terms of sale: 

1. Open the Terms of Sale Maintenance dialog (File Maintenance>Accounts 
Receivable>Terms of Sale). 

2. From the File menu, choose New. 

3. In Terms Code, type a code that identifies the terms of sale. This code is alphanumeric 
and can be up to four characters long. 

4. In Description, type a description of the terms of sale. 

5. Select a Type of M) Manual. After you select a Type, the Manual section becomes the 
active section. 

6. If you want to include a brief message on any invoice that uses this Manual terms of sale, 
type it in Message. 

7. If you want to use these terms of sale as vendors' terms that apply to you or as your terms 
that apply to your customers, select OK for Vendors. Leave OK for Vendors unselected 
to indicate that the terms of sale are your terms that apply only to your customers. 

8. In Manual Date, enter the date on which the total payment is due. 

9. If you want to provide a discount if the payment is made before the Manual Date, enter 
the discount percentage in Discount. If you do not want to provide a discount, leave 
Discount set to 0 (zero). 

10. From the File menu, choose Save. 
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Setting Up Proximo Terms of Sale 
Proximo defines the due dates and, optionally, discount dates as specific days of the month. For 
example, if the discount date is the first and the due date is the 15th, a customer has until the first 
of the month to receive the payment discount. You can split proximo terms into installment-like 
payments. Or, you can set up proximo terms as one full payment. Proximo terms differ from 
installment terms in that proximo terms do not allow for interest or late fees. Proximo terms also 
give you the ability to include different levels of prompt payment discounts. 

To set up proximo terms of sale: 

1. Open the Terms of Sale Maintenance dialog (File Maintenance>Accounts 
Receivable>Terms of Sale). 

2. From the File menu, choose New. 
3. In Terms Code, type a code that identifies the terms of sale. This code is alphanumeric 

and can be up to four characters long. 
4. In Description, type a description of the terms of sale. 
5. Select a Type of P) Proximo. After you select a Type, the Proximo section becomes the 

active section. 
6. If you want to include a brief message on any invoice that uses this Proximo terms of 

sale, type it in Message. 
7. If you want to use these terms of sale as vendors' terms that apply to you or as your terms 

that apply to your customers, select OK for Vendors. Leave OK for Vendors unselected 
to indicate that the terms of sale are your terms that apply only to your customers. 

8. Complete the Day of Month group box as follows: 
 
 Discount is the day of the month on or before which payment must be made in order to 
receive the early payment discount. 
 
 Full Payment is the day of the month on which the full payment is due. 
 
 Cutoff Day establishes the day beyond which the payment is due one period later. For 
example: The payment is due on the 5th of the month. The Cutoff Day is set to 25. If a 
purchase is made on May 23, the payment is due on June 5. However, if the purchase is 
made on May 26, the payment is due on July 5. 
  

9. In Start Date, enter the date the proximo aging process begins. 

10. In Discount Rate %, type the discount percentage the customer receives if the payment 
is made in full and by the day of the month in Discount. 

11. If you are creating a split proximo, select Split Proximo. A split proximo allows for 
multiple payments and/or discounts. Leave Split Proximo unselected if you plan on 
requiring one full payment and offering a discount based on when that payment is made. 

12. If Split Proximo is selected, click in the Split Table grid. Press the INSERT key on your 
keyboard and complete the Split Table grid as follows: If Split Proximo is not selected, 
skip this step. 
 
 Split identifies the number of payments within the split proximo. Enspire provides the 
split numbers automatically and they cannot be changed. 
 
 Split % is the percentage of the total payment associated with the corresponding split 
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number. 
 
 Discount Rate % is the percentage discount applied if the payment is made by the day 
of the month in Discount. 
 
 In the split proximo example below, the proximo aging process begins on July 27, 2002. 
Because it is after the cutoff date of the 25th, the customer can earn a 12 percent discount 
(the discount rate for the first payment in the Split Table grid) as long as 75 percent of the 
total payment is made by September 10. If the first payment is made after September 10, 
the discount no longer applies. However, the customer can still earn the 5 percent 
discount on the second payment if that payment is made before October 10. 
 

 
   

13. If Split Proximo is not selected, click in the Split Table grid. Press the INSERT key on 
your keyboard and complete the Split Table grid as follows: If Split Proximo is selected, 
complete the previous step and skip this step. 
 
 Bracket identifies the various levels of discounts. Enspire provides the bracket numbers 
automatically and they cannot be changed. 
 
 Day is the day of the month by which payment must be made in order to receive the 
discount in the bracket. 
 
 Discount Rate % is the percentage discount applied if the payment is made by the day 
of the month in Discount. 
 
 In the proximo example below, the proximo aging process begins on July 27, 2002. 
Because it is before the cutoff date of the 28th, payment must be made by August 10 to 
receive the full 15 percent discount as established in Discount Rate %. If payment is 
made after August 10, the customer can still earn a 10 percent discount if full payment is 
made by August 15, which is the date established in bracket 1. If payment is made after 
August 25, no discount is earned. 
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14. Complete the Payment Message group box as follows: 
 
 Message determines the format of the message included on the invoice. The format 
options are as follows: 
 
a) Net Amount Message - This message appears in the body of the invoice and displays 
the net amount due if the invoice is paid by a specific date, for example: "If paid by 
07/27/02, your net amount due is $545.67." 
 
 b) Gross Amount Message - This message appears in the body of the invoice and 
displays the gross amount due if the invoice is not paid by a specific date, for example: 
"If NOT paid by 01/20/03, your gross amount due is $9,023.18." 
 
c) Pay on Date Message - This message appears at the bottom of the invoice and displays 
the amount a customer should pay after a specific number of days, for example: "After 10 
days, please pay $121.77." 
 
d) Deduct Amount Message - This message appears in the body of the invoice and 
displays the amount the customer can deduct from the payment if the invoice is paid 
before a specific date, for example: "If paid before 11/22/02, you may deduct $25.00." 
 
 N) Do not Include Message - This option does not include a message on the invoice. 
 
 Days is the number of days added to the invoice date to determine the date included in 
the message. You can enter as many as 45, 60, or 90 days to add to the invoice date.  For 
example: You select a Message option of 1. The invoice date is May 7, 2002. Days is set 
to 5. The date that appears on the message is May 12, 2002. 
 
 Base determines the invoice amount used for calculating payment discounts. The options 
are: 
 
 B) Invoice Subtotal before Surcharge 
 
 S) Invoice Subtotal before Tax and Freight 
 
 T) Invoice Total 
 
 Adj % is the percentage to increase or decrease the amount used in the payment 
message. 
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 If the amount of an invoice is $500 and its due date is July 22, 2002, the example 
Payment Message group box below would include the message that the customer could 
deduct $50 (an adjustment of 10 percent of the invoice total before a surcharge) if the 
invoice is paid on or before July 27, 2002 (5 days after the invoice date). 
 

 
   

15. From the File menu, choose Save. 
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Setting Up Standard Terms of Sale 
Standard allows you to set up standard terms of sale, for example, Net 30 and 2 Percent 10 Days 
Net 30. Standard terms can be COD or non-COD. If they are not COD, they involve a number of 
days within which full payment is due. Non-COD Standard Terms can also include a discount. 

To set up standard terms of sale: 

1. Open the Terms of Sale Maintenance dialog (File Maintenance>Accounts 
Receivable>Terms of Sale). 

2. From the File menu, choose New. 
3. In Terms Code, type a code that identifies the terms of sale. This code is alphanumeric 

and can be up to four characters long. 
4. In Description, type a description of the terms of sale. 
5. Select a Type of S) Standard. After you select a Type, the Standard section becomes the 

active section. 
6. If you want to include a brief message on any invoice that uses this Standard terms of 

sale, type it in Message. 
7. If you want to use these terms of sale as vendors' terms that apply to you or as your terms 

that apply to your customers, select OK for Vendors. Leave OK for Vendors unselected 
to indicate that the terms of sale are your terms that apply only to your customers. 

8. Select a COD Type. The types are as follows: 
 
 1) Not COD Terms - This option indicates that COD terms do not apply. If you select 
this option, you determine when the payment is due in Full Payment Due. 
 
 2) POS Payment Required - This option indicates that payment is required when the 
order or invoice is entered into Enspire. 
 
 3) COD Terms, No Credit Hold - This option indicates that COD terms apply and that 
the credit hold code is turned off. 
 
 4) COD Terms, Credit Hold Allowed - This option indicates that COD terms apply and 
that the credit hold code is turned on. 
  

9. In Full Payment Due enter the number of days until full payment is due. For example, if 
the number of days is set to 30, the full payment is due 30 days after the invoice date. 
This option applies only if you selected a COD Type of Not COD Terms. 

10. Set up the discount levels. Click in the Discount Brackets grid. Press the INSERT key on 
your keyboard then complete the Discount Brackets grid as follows: 
 
 Bracket identifies the various levels used to calculate contract prices. Enspire provides 
the bracket numbers automatically and they cannot be changed. 
 
 Days is the maximum number of days after the invoice date that a payment can be made 
and still qualify for the discount. 
 
 Discount Rate % is the percentage discounted from the amount due if payment is made 
within the specified number of days. 
  

11. If you selected a COD Type of Not COD Terms, the Payment Message group box 
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appears. Complete the Payment Message group box as follows: 
 
 Message determines the format of the message included on the invoice. The format 
options are as follows: 
 
 1) Net Amount Message - This message appears in the body of the invoice and displays 
the net amount due if the invoice is paid by a specific date, for example: "If paid by 
07/27/02, your net amount due is $545.67." 
 
 2) Gross Amount Message - This message appears in the body of the invoice and 
displays the gross amount due if the invoice is not paid by a specific date, for example: 
"If NOT paid by 01/20/03, your gross amount due is $9,023.18." 
 
 3) Pay on Date Message - This message appears at the bottom of the invoice and 
displays the amount a customer should pay after a specific number of days, for example: 
"After 10 days, please pay $121.77." 
 
 4) Deduct Amount Message - This message appears in the body of the invoice and 
displays the amount the customer can deduct from the payment if the invoice is paid 
before a specific date, for example: "If paid before 11/22/02, you may deduct $25.00." 
 
 N) Do not Include Message - This option does not include a message on the invoice. 
 
 Days is the number of days added to the invoice date to determine the date included in 
the message. For example: You select a Message option of 1. The invoice date is May 7, 
2002. Days is set to 5. The date that appears on the message is May 12, 2002. 
 
 Base determines the invoice amount used for calculating payment discounts. The options 
are: 
 
 B) Invoice Subtotal before Surcharge 
 
 S) Invoice Subtotal before Tax and Freight 
 
 T) Invoice Total 
 
 Adj % is the percentage to increase or decrease the amount used in the payment 
message. 
 
 If the amount of an invoice is $500 and its due date is July 22, 2002, the example 
Payment Message group box below would include the message that the customer could 
deduct $50 (an adjustment of 10 percent of the invoice total before a surcharge) if the 
invoice is paid on or before July 27, 2002 (5 days after the invoice date). 
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 12. From the File menu, choose Save. 
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Territory Codes 
Territory Codes give you the ability to analyze sales by individual territories. You assign a 
territory to a customer ship-to location in the Codes section of the ShipTo Locations dialog. 

To add a territory code: 

1. Open the Territory Maintenance dialog (File Maintenance>Accounts 
Receivable>Territory Codes). 

2. From the File menu, choose New. 

3. In Territory Code, type a code that identifies the territory. This code is alphanumeric 
and can be up to four characters long.  

4. In Description, type a description of the territory. 

5. From the File menu, choose Save. 
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About this Chapter 
This chapter covers the basics for setting up your customers. It also includes information on 
customer ship-to locations. 

Adding a Customer 
In Enspire, customers are the companies or individuals that purchase items and/or services from 
your company. Each customer you set up in Enspire must have at least one ship-to location. 
Optionally, you can also include a separate bill-to and/or pay-from customer. 

NOTE This procedure covers the initial steps for adding a customer. For 
detailed information on the sections and fields within the Customer 
Master Maintenance dialog, see the Enspire online help. 

To add a customer: 

1. Open the Customer Master Maintenance dialog (File Maintenance>Customer> Customer 
Master). 

 

2. From the File menu, choose New. 

3. In Customer, type a customer number. 

4. In Currency, select the currency the customer uses. 

5. In Credit Limit, type the amount of the customer’s credit limit. If the total amount of the 
customer’s orders exceeds the credit limit, the customer is placed on a credit hold. 

6. In Class Code, select the class, if any, that you want to assign to the customer. For 
information on customer classes, see Customer Classes earlier in this chapter. 

7. In Customer Name, type the full name of the customer. 
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8. In Customer XRef Name, type the name the customer calls itself. You can use this name 
as a cross-reference for the name in Customer Name. For example, the customer’s legal 
name is Triple J Construction. However, when someone from the company calls to place 
an order, the caller identifies the company as JJJ. Having JJJ as the cross-reference name 
gives you the ability to search for the customer by either Triple J Construction or JJJ. 

9. In the Information section, double click in the Customer Demographics area to display 
the Customer Address dialog. In this dialog, type the general customer information 
including address, phone and fax numbers, email address and web address. After you 
type this information, click OK to close the Customer Address dialog. 

10. If you want to assign a pay-from customer to this customer, use the lookup to select it in 
PayFrom Customer. 

11. After you have completed each section within the Customer Master Maintenance dialog, 
choose Save. 

Adding a Ship-to Location 
A ship-to location defines the location or locations where you deliver items and/or services to a 
customer. Each customer you set up in Enspire must have at least one ship-to location. If a 
customer has multiple locations, setting up each one as a ship-to location allows you to maintain 
separate operating parameters for each ship-to location, ship orders to each of the locations, and 
track customer history at the ship-to level. 

NOTE This procedure covers the initial steps for adding a ship-to location. 
For detailed information on the sections and fields within the ShipTo 
Locations dialog, see the Enspire online help. 
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To add a ship-to location: 

1. Open the ShipTo Locations dialog (File Maintenance>Customer>ShipTo Locations). 

To open this dialog from within the Customer Master Maintenance dialog, click the 
ShipTo tab then click Edit ShipTo Locations. You can then skip step 2. 

 

2. Open the customer you are adding the ship-to location to. 

To open a customer, choose Open from the File menu. In the Customer LookUp dialog, 
select the customer you want to open then click OK. 

3. From the File menu, choose New. 

4. Complete the ShipTo grid as follows: 

ShipTo is the code that identifies this ship-to location. This code is alphanumeric and can 
be up to eight characters long. 

Name is the name of the ship-to location. 

Comment allows you to type a brief comment about the ship-to location. 

Status is the current status of the ship-to location. 

5. After you have completed each section within the ShipTo Locations dialog, choose Save. 

AR Adjustments 
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Enspire gives you the ability to make adjustments to invoices, on-account amounts, balance-
forward amounts, finance charge accruals, credits, and debits. You record A/R adjustments in the 
A/R Adjustments dialog. After documents are added to a batch, you can print an adjustment 
journal and the adjustment distributions. For information, click Printing AR Adjustment 
Documents. 

The list below provides several examples of when you might perform an A/R adjustment. 

• Finance Charges - If a customer refuses to pay a finance charge, and you would rather forgive 
the finance charge than lose that customer's business, you can create an A/R adjustment and 
select a Document Type of Finance Charge. 

• Small Balance Due - If a customer underpays an invoice by a small amount, you can create an 
A/R adjustment to bring the balance due to zero (0). 

• Sales Tax Errors - Because of an incorrect tax jurisdiction or tax rates that changed, an 
invoice may incorrectly state the amount of tax due. You can create an A/R adjustment to 
correct the tax. For information, click Sales Tax Adjustment. 

• Bad Debt - If you determine that you cannot collect on an invoice, you can create an A/R 
adjustment that credits A/R and debits a bad debt expense account. 

NOTE: Adjustments should not be used as a substitute for credit memos or to compensate for 
questionable business practices. Use A/R adjustments sparingly. Adjustments do not affect 
inventory or cost of goods sold.  

To record an AR adjustment: 

1. Open the A/R Adjustments dialog (Transactions>Accounts Receivable>Adjustments). 

2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. If 
necessary, type a different Batch Description, then click OK. 

3. If you want to add an adjustment to an existing batch, choose Open to display the Batch LookUp 
dialog. Select the batch you want to open, then click OK. 

4. In Reason Code, select the default reason for the adjustments. 
 
 This reason is applied to each document in the Invoices grid, whether you select it individually or 
retrieve it based on filters. Therefore, you want to select the reason code that will apply to the 
majority of documents. If necessary, you can select a different reason code for a document. 
  

5. In the Automatic Adjustment Filters group box, select any filters that you want to apply. 
 
 These filters allow you to retrieve documents based on the selected filters. If you do not use 
filters, you enter the documents one at a time. When you create A/R adjustments, the Automatic 
Adjustment Filters allow you to retrieve documents based on the criteria you provide. In the 
example below, only documents created for customer KPJ between July 27, 2003, and July 31, 
2003, that also have a finance charge balance between $0.01 and $2.00 will be included in the 
adjustment. 
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Customer is the specific customer that you are entering the adjustment for. 

Document Type is the type of document you want to adjust. The available types are: 
 
 C) Credit Memo 
 
 D) Debit Memo 
 
 F) Finance Charge 
 
 I) Invoice 
 
 O) On-account 
  

From Date is the earliest date a document can have and still be included as part of the adjustment 
batch. 

To Date is the latest date a document can have and still be included as part of the adjustment 
batch. 

Bal From is the lowest balance a document can have and still be included as part of the 
adjustment batch. 

Bal To is the highest balance a document can have and still be included as part of the adjustment 
batch. 

Adjustment Limit is the maximum amount of an adjustment. For example, an Adjustment Limit 
of $10.00 adjusts the balance of all included documents by $10.00. If the current balance is 
between -$10.00 and $10.00, Enspire sets the balance to $0.00. 

After you select the filters you want to apply, choose Fetch from the Actions menu. 

6. From the Actions menu, choose Fetch. Choosing Fetch displays the documents that meet the filter 
criteria in the Invoices grid. 

7. If you do not set any filter criteria, click in the Invoices grid then select the Document you want to 
adjust. 
 
Customer and Cust Name identify the customer associated with the document. 
   

8. Reason displays the selected Reason Code. If you want to assign a different reason code, select it 
in Reason. 
 
 Invoice Date displays the date the document was created.  

9. In Location, select your profit center associated with the adjustment. 

10. In Dept, select the department for the adjustment. Dept is inactive if you do not use departments. 

11. Account displays the general ledger account and sub-account associated with the selected reason 
code. If you want to assign a different account, select it in Account. 
 
 Current Balance displays the current balance on the document. 
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12. In Adjust Amount, type the amount of the adjustment. 
 
 Adjusted Balance displays the new balance associated with the document. To calculate this 
amount, Enspire adds the amount in Adjust Amount to the current balance. If the sales tax is 
being adjusted, Adjusted Balance also includes that amount. 
 
 Tax Adjust Amount displays the amount of the sales tax adjustment. For information, click Sales 
Tax Adjustment. 
  

13. When you have finished typing adjustment amounts, you can save the batch or choose Post to post 
it. If you save the batch without posting it, you can modify it at a later time. For information on 
posting batches, click Posting at the beginning of this topic. 

  

Printing AR Adjustment Documents 
When you have finished entering an adjustment batch, you can print the adjustment journal and 
distributions. 

• The adjustment journal lists the adjustments in the batch. 

• The adjustment distributions include the general ledger accounts that were debited or credited 
when you posted the adjustment batch. 

To print these documents from AR Adjustments: 

1.  From the File menu, choose Print Select or Print Preview. 

2.  In the Document Print selection dialog, select Adjustment Journal or Adjustment 
Distributions. 

3.  Click OK. 

When you click OK, the selected document is displayed in the Report Explorer. From here, you 
can choose Print from the File menu to print it. 
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Applying Customer Payments 
   

The Check Application dialog allows you to apply customer payments, on-acounts, deposits, and 
credit memos to invoices. You apply payments to invoices in the Checks section. You apply on-
accounts, deposits, and credit memos to invoices in the Credits section.   

If you want to apply payments automatically, choose Auto Apply Checks from the Actions menu.  

NOTE: To apply on-accounts, deposits, and credit memos in Check Application, the customer 
must have a payment included in the Check Entry batch you select in step 2 below. If the customer 
does not have a payment included in the batch, you must use Credit Application instead of Check 
Application.  

You can also create on-accounts and deposits. For information, click On-Accounts and Deposits. 

To apply a payment to one or more invoices: 

1. Open the Check Application dialog (Transactions>Accounts Receivable>Check 
Application). 

2. Open the Check Entry batch that contains the payment or payments you want to apply.  
 
 To open a batch: From the File menu, choose Open to display the Batch LookUp dialog. 
Select the batch you want to open, then click OK. 
  

3. Make sure the Checks section is displayed. If this section is not displayed, click the 
Checks tab. 

4. If you want to load all invoices for the payments listed in the Checks grid, choose Load 
All Check App Invoices from the Actions menu.  

5. In the Check grid, select the payment you want to apply. The Checks section of the Check 
Application dialog allows you to apply check, cash, and credit card payments to customer 
invoices.  

The Check grid lists the information, including customer and amount, for each payment you 
want to apply to the designated invoice or invoices. 

• Cust # and Cust Name identify the customer making the payment. 

• Type is the type of payment. The types are: 1) Check, 2) Cash, and 3) Credit Card. 

• Suspend identifies whether the payment has been suspended. To suspend a payment, you 
choose Suspend from the Actions menu. For more information, click Actions menu. 

• Check # is the number of the check or credit card used to make the payment. 

• Is Deposit identifies whether the payment is a deposit. To create a deposit, you choose 
Create Deposit from the Actions menu. For more information, click Actions menu. 

• Orig Order # is the number of the original order associated with the deposit. Orig Order # 
does not apply if the payment is not a deposit. 

• Action identifies whether the payment is a payment, a deposit, or an on-account. 
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• Amount is the amount of the payment. 

• Amount Applied is the amount of the payment applied to the invoice, or as a deposit or on-
account. 

• Remaining Balance is the amount remaining to apply. 

• XR Gain is the gain achieved based on the exchange rate. 

The Invoices grid lists the invoices to which you can apply the payment. 

• Sel identifies whether the invoice is selected for payment. Leave Sel unselected for the 
invoices that you do not want to include in the payment. A check mark identifies the invoice 
as selected. If you do not want to include an invoice, click Sel to remove the check mark and 
unselect Sel. 

• Document displays the number of the invoice. 

• Cust # and Ship# identify the customer and ship-to location associated with the 
invoice. 

• Invoice Date is the date the invoice was created. 

• Due Date displays the date on which the payment is due. 

• PO # is the customer's purchase order number associated with the invoice. 

• Order # is the number of the order that generated the invoice. 

• Payment is the amount of the payment applied to the invoice. 

• Allowance is the amount of the allowance for this invoice. 

• Acct # is the general ledger account that is debited the amount of the allowance. The 
default account is the A/R Payment Allowances account selected in the Company 
GL Account dialog (File Maintenance>Company>GL Accounts). 

• Original Balance is the original amount of the invoice. 

• Original XCRate is the exchange rate at the time the invoice was created. 

• Profit Ctr is the profit center that has its account debited the amount of the 
allowance. 

• Remaining Bal is the amount still owed on the invoice. 

The Invoice Details display information for the invoice selected in the Invoices grid. 

• Terms and Terms Description identify the terms of sale that apply to the customer. 
For information on terms of sale, click the Terms of Sale button at the beginning of 
this topic. 

• Days Late is the number of days the payment is late. 

• Customer's Last Payment displays the date of the customer's most recent payment. 

• Average Days to Pay displays the average number of days the customer takes to pay 
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you. 

• Original Balance is the original balance of the invoice. 

• Current Balance is the amount still owed on the invoice after the payment has been 
applied. 

• Pending Payments displays the amount of the payments still to be made toward the invoice. 

• Interest is the amount of interest owed on the invoice. 

• Late Fee is the amount of the late fee owed on the invoice. 

6. In the Invoice grid, select the Sel box for each invoice you want to apply the payment to. Even if 
you do not select Sel, the invoice is still unavailable to other processes in Enspire. To make the 
invoice available, you can choose Release Unselected Invoices from the Actions menu. Posting 
the batch also releases unselected invoices. 

7. In Payment, type the amount you want to apply to the invoice. If you have not selected Sel, typing 
a payment amount automatically selects Sel. 
 
 If the terms of sale assigned to the customer includes a discount, that discount appears in 
Allowance when you select Sel. 
   

8. If you want to apply a discount, you can accept the amount that appears in Allowance, type a 
different amount, or click the button in the Allowance field to display the Discount Table dialog. 
This dialog lists the discounts that are available to the customer based on the customer's terms of 
sale. Double click the discount you want to apply. If you do not want to apply a discount from the 
Discount Table dialog, click the x in the top right of the dialog to close it. 

9. In Acct #, select the general ledger account that is debited the amount of the allowance. The 
default account is the A/R Payment Allowances account selected in the Company GL Account 
dialog (File Maintenance>Company>GL Accounts). 

10. In Profit Ctr, select the profit center that has its account debited the amount of the allowance. 

11. When you have finished applying payments, deposits, and/or credit memos to invoices, you can 
save the batch or choose Post to post it. If you save the batch without posting it, you can modify it 
at a later time. If any of the payments in the Check grid have a remaining balance, you cannot post 
the batch. You can save the batch and post it later or you can create an on-account or a deposit.  

To apply a credit memo, on-account, or deposit to one or more invoices: 

1. Open the Check Application dialog (Transactions>Accounts Receivable>Check Application). 

2. Open the batch that contains the credit memo, on-account, or deposit you want to apply.  To open 
a batch: From the File menu, choose Open to display the Batch LookUp dialog. Select 
the batch you want to open, then click OK.  

3. Make sure the Credits section is displayed. If this section is not displayed, click the 
Credits tab. 

The Credits section of the Check Application dialog allows you to apply credit memos, 
on-account amounts, and deposits to customer invoices. This section includes the 
following grids: Credit, Deposit, and Invoice.  The Credit grid appears when you click 
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Credit Memos and OnAcct. The Deposit grid appears when you click Deposits. These 
grids contain the same information. 

• Cust # and Cust Name identify the customer associated with the deposit or on-
account. 

• Doc Code identifies the credit as an O) on-account or D) deposit. 

• Invoice displays the number of the on-account or deposit. 

• Original Balance is the original amount of the on-account or deposit. 

• Invoice Date is the date the on-account or deposit was created. 

• Current Balance is the amount of the on-account or deposit remaining to be 
applied. 

• Amount Applied is the amount of the on-account or deposit that has been applied. 

• Pending Balance is the amount of the on-account or deposit remaining to apply. 

The Invoices grid lists the invoices to which you can apply the on-account or deposit. 

• Sel identifies whether the invoice is selected for payment. Leave Sel unselected for 
the invoices that you do not want to include in the payment. A check mark identifies 
the invoice as selected. If you do not want to include an invoice, click Sel to remove 
the check mark and unselect Sel. 

• Document displays the number of the invoice. 

• Cust # and Ship# identify the customer and ship-to location associated with the 
invoice. 

• Invoice Date is the date the invoice was created. 

• Due Date displays the date on which the payment is due. 

• PO # is the customer's purchase order number associated with the invoice. 

• Order # is the number of the order that generated the invoice. 

• Payment is the amount of the payment applied to the invoice. 

• Original XCRate is the exchange rate at the time the invoice was created. 

• Allowance is the amount of the allowance for this invoice. 

• Remaining Balance is the amount still owed on the invoice. 

The Invoice Details display information for the invoice selected in the Invoices grid. 

• Days Late is the number of days the payment is late. 

• Terms and Terms Description identify the terms of sale that apply to the customer. For 
information on terms of sale, see Terms of Sale. 

• Customer's Last Payment displays the date of the customer's most recent payment. 

Version 7.3.2.0 Getting Started  8-11 



Customers  Applying Customer Payments 

• Average Days to Pay displays the average number of days the customer takes to pay you. 

• Original Balance is the original balance of the invoice. 

• Current Balance is the amount still owed on the invoice after the payment has been applied. 

• Pending Payments displays the amount of the payments still to be made toward the invoice. 

• Current Discount Available is the amount of the discount currently available to the invoice. 

4. To apply a credit memo or an on-account balance, click Credit Memos and OnAcct. Or, to apply 
a deposit, click Deposits. 

5. In the Credit grid, select the credit memo or on-account amount you want to apply. Or, in the 
Deposits grid, select the deposit you want to apply. 

6. In the Invoice grid, select the Sel box for each invoice you want to apply the credit memo, on-
account, or deposit to. Even if you do not select Sel, the invoice is still unavailable to other 
processes in Enspire. To make the invoice available, you can choose Release Unselected Invoices 
from the Actions menu. Posting the batch also releases unselected invoices. 

7. In Payment, type the amount you want to apply to the invoice. 

8. When you have finished applying payments, deposits, and/or credit memos to invoices, you can 
save the batch or choose Post to post it. If you save the batch without posting it, you can modify it 
at a later time. For information on posting batches, click Posting at the beginning of this topic. 

Check Application Actions Menu Options - 

The following commands are available on the Check Application Actions menu. They are listed in 
alphabetical order. 

• Auto Apply Checks automatically applies a check to an invoice when the amount of the check 
equals the amount of the invoice. For example, if you have a check for $200 and a check for $300 
as well as an invoice for $200 and an invoice for $300, choosing Auto Apply Checks 
automatically applies the $200 check to the $200 invoice and the $300 check to the $300 invoice. 
 
 If you choose Auto Apply Checks and no checks can be automatically applied, a message 
appears and gives you the option of applying the checks based on the earliest due date of the 
invoices. Click Yes on the message to apply the checks. Click No if you do not want to apply the 
checks automatically. 
  

• Create Deposit identifies the payment selected in the Check grid as a deposit. For information, 
click On-Accounts and Deposits. 

• Create On-Account places the amount of the payment on the customer's account. For 
information, click On-Accounts and Deposits. 

• Load All Check App Invoices retrieves at one time all invoices that are associated with the 
payments in the Check grid. When you open a batch in Check Application, Enspire retrieves only 
the invoices associated with the payment currently selected in the Check grid. When you select a 
different payment, Enspire retrieves the invoices associated with that payment. The Load All 
Check App Invoices command gives you the option of retrieving all invoices at once instead of 
retrieving them payment by payment. When you use this command, you can move from one 
payment to the next without waiting for Enspire to retrieve the associated invoices. This command 
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does not affect the invoices that are retrieved. It simply eliminates the retrieval time when you 
select a different payment. 
 
 NOTE: Once an invoice is retrieved, it is not available to other areas of Enspire until it is 
released. For information, see Release Unselected Invoices below. 
  

• Refresh Open Items updates the list of open items in the Invoice grid. The open items include 
invoices, debit memos, finance charges, or balance-forward amounts. For example, if you post an 
invoice for a customer after you have created a Check Application batch, that invoice is not 
automatically included in the batch. Only open items that are available when the Check 
Application batch was created are included in the Invoice grid. To include open items that were 
posted after the Check Application batch was created, use Refresh Open Items. This command 
applies only to the section that is currently displayed. For example, if you choose Refresh Open 
Items while the Checks section is displayed, the Invoice grid in the Credits section is not updated. 
 
 Additionally, if an open item is included in a different batch, it is not available to the Check 
Application batch. When you release the open item from the batch it is in, it becomes available to 
other areas of Enspire. Therefore, choosing Refresh Open Items will also include open items that 
have been released from other batches. 
   

• Release unsuspends a payment. For information, see Suspend below. 

• Release Unselected Invoices removes unselected invoices from the batch and makes them 
available to other areas of Enspire or to a different Check Application batch. If an invoice is 
included in a Check Application batch, it is not available to other Enspire processes until you 
release it. Therefore, an invoice that you expect to see in a different batch may not show up there 
because it is currently included in a Check Application batch. When you post a Check Application 
batch, unselected invoices are released automatically. 

• Remove Deposit removes the deposit designation of the check selected in the Check grid. 

• Suspend allows you to exclude payments when you post the batch. For example, if you want to 
research a payment but you do not want it to delay posting other payments, you can suspend it. 
Enspire ignores any payment that you suspend. If one or more invoices is selected, you cannot 
suspend the payment. To unsuspend a payment, choose Release.

Version 7.3.2.0 Getting Started  8-13 



Customers  Applying Customer Payments 

Check Entry 

     

Check Entry allows you to record payments you receive from customers. The payments can be 
checks, cash, or credit cards and Enspire keeps track of each type of payment that you enter. 

While different users can create check batches simultaneously, you cannot enter payments from 
the same customer in different batches. After payments are added to a batch, you can print a 
deposit slip and a Cash Application Worksheet. For information, click Printing Check Entry 
Documents. 

As you enter payments, Enspire automatically sorts them based on the selected column heading. 
For instructions on keeping payments in the same order as you entered them, click Displaying 
Payments in the Order You Enter Them. 

To record customer payments: 

1. Open the AR Check Entry dialog (Transactions>Accounts Receivable>Check Entry). 

2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. 
If necessary, type a different Batch Description, then click OK. 

3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. 
Select the batch you want to open, then click OK. 

4. In Bank, select the bank where you will deposit the payments you are entering. 
 
 After you select a bank, the Bank Name and Currency appear. 
  

5. If the Checks section is not displayed, click the Checks tab. 

6. Click in the Checks grid. 

7. Select the Customer you are entering the payment for. 
 
 Customer Name displays the name of the selected customer. 

8. Select the Type of payment. The types are: a) Check, b) Cash, and c) Credit Card. 

9. If the payment is a deposit, select Deposit. Leave Deposit unselected if the payment is not a 
deposit. For example, you may require that a customer put down a 10 percent deposit before 
you guarantee a large order.  
 
 If you select Deposit, you have the option of entering an order number associated with the 
deposit.  
  

10. Type a Reference #. This number is used to identify the payment. If the payment Type is 1) 
Check, Reference # is typically the check number. 

11. If the payment is a deposit to be applied to a specific order, type the order number in Orig 
Order #. 

12. Type the Amount of the payment. 
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13. From the File menu, choose Save.  

14. When you have finished entering payments, you can print a deposit slip and/or a cash 
application worksheet. Printing these documents is optional. For information, click Printing 
Check Entry Documents. 

Printing Check Entry Documents 
When you have finished entering payments in a Check Entry batch, you can print a deposit slip 
and a Cash Application Worksheet.  

• The bank deposit slip identifies the bank where you will deposit the payments and also includes 
the customer, payment type, the amount of each payment, and the total to be deposited.  

• The Cash Application Worksheet lists the credits and invoices associated with the customers 
selected in the Check Entry batch. The worksheet allows you to make notes about how you will 
apply the payments before you process Check Application. 

To print these documents from Check Entry: 

1. From the File menu, choose Print Select or Print Preview. 

2. In the Document Print selection dialog, select Bank Deposit or Cash Application 
Worksheet. 

3. Click OK. 

When you click OK, the selected document is displayed in the Report Explorer. From here, you 
can choose Print from the File menu to print it. 
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Credit Application 
 

Credit Application allows you to apply customer credit memos, on-accounts, and deposits to open 
items. The open items include invoices, debit memos, finance charges, or balance-forward 
amounts. 

To apply a customer credit memo or deposit to an open item: 

1. Open the Credit Memo Application dialog (Transactions>Accounts Receivable>Credit 
Application). 

2. In the Customers with Credits grid, double click the customer that has a credit you want to 
apply. 
 
Customer with Credits Grid 

This grid lists the customers that have credits you can apply to open items. Double click a 
customer to display its credits and open items. 

• Customer No and Customer Name identify the customer. 

• Credit Balance displays the amount of credit the customer currently has. 

• Credit Count displays the number of credits (credit memos, on-accounts, and deposits) 
the customer currently has. 

  When you double click a customer, the customer's credits appear in the Credits for 
Customer grid:  

 Credits for Customer Grid 

This grid lists the credits that the customer currently has. 

• Credit No identifies the credit. A plus sign (+) next to the credit number indicates that it 
has been selected to be applied to one or more invoices. Click the plus sign to display the 
invoices. Click the minus sign (-) to hide the invoices. 

• Doc Code is the type of credit. The options are: C) Credit memos, O) On-accounts, and 
D) Deposits. 

• Invoice Date is the date the credit was created. 

• Original Balance is the original amount of the credit. 

• Current Balance is the amount of the credit remaining to be applied. 

• Amount Applied is the amount of the credit that has been applied to the 
selected invoice or invoices. 

• Pending Balance is the amount of the credit that will be available after the 
amount in Amount Applied is posted. 

 And the customer's open items you can apply the credits to appear in the 
Invoices for Customer grid.  

Invoices for Customer Grid 
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This grid lists the invoices for the selected customer. 

• Invoice No is the number of the invoice. 

• Doc Code identifies the type of document. The types are: I) Invoices, D) Debit 
Memos, F) Finance Charges, and B) Balance-forward Amount. 

• Invoice Date is the date the invoice was created. 

• Due Date is the date the invoice is due. 

• PO No is the customer purchase order number associated with the invoice. 

• Order No is the order that generated the invoice. 

• Original Balance is the original amount of the invoice. 

• Current Balance the amount of the invoice that is still outstanding. 

• Payment Amount is the amount of the credit or credits that has been applied to 
the invoice. 

• Pending Balance is the amount of the invoice that will still be outstanding after 
the amount in Payment Amount is posted. 

3. Use one of the techniques described below to apply the credit to one or more open 
items. The techniques are: Selecting Invoices, Entering Invoice Numbers, and 
Assigning Credits to Invoices. 

4. If you want to remove one or more credits from an open item, click the plus sign (+) 
next to the open item. In the list that appears below the open item, select the credit 
you want to remove. Press the DELETE key on your keyboard. 

5. If you want to remove one or more open items from a credit, click the plus sign (+) 
next to the credit. In the list that appears below the credit, select the open item you 
want to remove. Press the DELETE key on your keyboard. 

Selecting Invoices 

This procedure allows you to apply a credit to one invoice at a time. 

1. In the Credits for Customer grid, select the credit you want to apply. 

2. In the Invoices for Customer, select the open item you are applying the credit to. 

3. Press the SPACE BAR on your keyboard. 
 
 When you press the SPACE BAR, the open item is selected and a plus sign (+) appears next 
to it. You can click the plus sign to display information for the credit or credits assigned to the 
open item. Click the minus sign (-) to hide this information. 
  

4. When you are ready to post the credit application, choose Post from the Actions menu. 

Entering Invoice Numbers 

This procedure allows you to apply a credit to multiple invoices at the same time. 
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5. In the Credits for Customer grid, double click the credit you want to apply. The Credit Memo 
Invoices dialog appears. 
 
 You enter the invoices in the Invoices Allocated to Credit Memo grid. 
  

6. In Invoice No, type the number of the invoice you are applying the credit to. 

7. In Payment Amount, type the amount of the credit you are applying to the invoice. 

8. When you have finished typing invoice numbers and amounts, click OK. If you do not want 
to apply the credit to the designated invoices, click Cancel. 

 

Assigning Credits to Invoices 

This procedure allows you to assign multiple credits to an invoice at the same time: 

1. In the Invoices for Customer grid, double click the invoice you want to apply the credit or 
credits to. 
 
 You enter the credits in the Credit Memos Allocated to Invoice grid. 
  

2. In Invoice No, type the number of the credit you are applying to the invoice. 

3. In Payment Amount, type the amount of the credit you are applying to the invoice. 

4. When you have finished typing credit numbers and amounts, click OK. If you do not want to 
apply the credits to the invoice, click Cancel. 
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On-Accounts and Deposits 

In addition to applying customer payments to invoices, Check Application (Transactions>Accounts 
Receivable>Check Application) gives you the option of creating on-accounts or deposits. You can view 
and apply the on-accounts and deposits in the Credit Memo Application dialog (Transactions>Accounts 
Receivable>Credit Application) as well as the Credits section of the Check Application dialog. 

• On-accounts can be created if a customer overpays or if you receive a payment that does not apply 
to a specific order or invoice. For example, if a customer pays you $100 when the invoice was for 
$90, you can apply $90 of the payment toward the invoice then create an on-account for $10. 
Enspire would then generate a credit memo for the customer for $10. If a customer pays you $100 
but no order has been entered for that customer yet, you can can create an on-account for the entire 
$100. 

• Typically, you create a deposit when you require a downpayment from a customer, either in 
general or for a specific order. Optionally, you can enter an order number when you create a 
deposit. You can designate a payment as a deposit in either Check Application or Check Entry. 

To create an on-account: 

1. Enter the payment in a Check Entry batch (Transactions>Accounts Receivable>Check Entry). 
2. Open that Check Entry batch in Check Application (Transactions>Accounts Receivable>Check 

Application). 
3. In the Checks grid, select the payment you want to use to create an on-account. 
4. From the Actions menu, choose Create On-Account. 

 
This command is not available if any invoices are selected in the Invoice grid and the entire 
amount of the payment can be applied to the selected invoices. If only part of the payment can be 
applied to the selected invoices, choose Create On-Account to create an on-account for the 
remaining balance of the payment. If no invoices are selected, Enspire creates an on-account for 
the entire amount of the payment. 
  

5. If you want to remove the on-account designation from the payment, select the payment then 
choose Remove On-Account from the Actions menu. 

6. When you have finished, you can save the batch or choose Post to post it. If you save the batch 
without posting it, an on-account is not created and you can modify the batch at a later time. 

To create a deposit in Check Application: 

1. Enter the payment in a Check Entry batch (Transactions>Accounts Receivable>Check Entry). 
2. Open that Check Entry batch in Check Application (Transactions>Accounts Receivable>Check 

Application). 
3. In the Checks grid, select the payment you want to use to create a deposit. 
4. From the Actions menu, choose Create Deposit. 

 
This command is not available if any invoices are selected in the Invoice grid and the entire 
amount of the payment can be applied to the selected invoices. If only part of the payment can be 
applied to the selected invoices, choose Create Deposit to create a deposit for the remaining 
balance of the payment. If no invoices are selected, Enspire creates a deposit for the entire amount 
of the payment. 
  

5. If you want to remove the deposit designation from the payment, select the payment then choose 
Remove Deposit from the Actions menu. 

6. When you have finished, you can save the batch or choose Post to post it. If you save the batch 
without posting it, a deposit is not created and you can modify the batch at a later time. 
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DB/CR Memos 
 

You use DB/CR Memos to create miscellaneous credit or debit memos. The credit or debit memos 
you create here do not affect commissions. 

• Debit memos can be used to add an amount that was omitted from an invoice or to restore charges 
when a payment was applied to an invoice in error. For example, if you forgot to charge a 
customer for freight, you can create a debit memo for that customer. A debit memo debits your 
Accounts Receivable account and credits the account or accounts you select. 

• You can create credit memos here whenever you issue a credit without a return or if a return 
arrives with no RMA. If item returns and RMAs are involved, credit memos are generated through 
the RMA process. You can also create a credit memo to apply a price credit. For example, a 
customer did not receive the contracted price for an order and realized after receiving the invoice 
that they were overcharged. A credit memo credits your Accounts Receivable account and debits 
the account or accounts you select. 
After you create a debit or credit memo, you can print it. For information, click Printing Debit or 
Credit Memo Documents. 

NOTE: Only one debit memo or one credit memo is created per batch. 

The steps below apply to creating a debit memo or a credit memo. 

1. Open the DB/CR Memo dialog (Transactions>Accounts Receivable>DB/CR Memo). 
2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. If 

necessary, type a different Batch Description, then click OK. 
3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. Select 

the batch you want to open, then click OK. 
4. In the Type group box, select Debit Memo if you are creating a debit memo, or select Credit 

Memo if you are creating a credit memo. 
5. Select the Customer you are creating the memo for. 
6. Select the customer's ShipTo location you are creating the memo for. 
7. In Location, select the profit center affected by the memo. 
8. Select the Reason for the memo. To jump to information on reasons, click Reason Codes. 
9. Select the Terms of sale for the selected customer. 
10. If the memo is associated with a specific invoice, type the invoice number in Invoice #. 

 
 The number you type here is for information purposes only when you create the memo for a 
specific invoice. 
  

11. In Date Created, enter the date the memo was created. 
12. If you want to assign a salesperson to this memo, select an Outside Salesrep or an Inside 

Salesrep.  
13. If the customer's Currency is a foreign currency, type an Exchange Rate.  
14. Complete the Amounts group box as follows: 

 
 Gross Amount is the total amount of the memo. 
 
 Discount is the amount of the discount, if any, associated with the debit memo. If you are 
creating a credit memo, Discount is inactive. The amount entered here is subtracted from the 
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Gross Amount when Enspire calculates the Total amount. 
 
 Freight is the amount of the freight, if any, associated with the memo. The amount entered here is 
added to the Gross Amount when Enspire calculates the Total amount. 
 
 If the memo is taxable, select Is Taxable. If the memo is not taxable, leave Is Taxable 
unselected. 
 
 Total Tax displays the tax on the memo. 
 
 Total displays the total amount of the memo, including discounts, freight, and tax. 
 
 If an inventory cost is associated with the debit memo, type the cost in Cost. You may need to 
provide a cost if profit-based or margin-based sales commissions are accrued for the debit memo. 
For example, if you create a $50 debit memo and $25 of it is the cost of inventory, you do not 
want to pay commission on the full $50 if the salesperson should only be paid based on profit. 
Typing a Cost of $25 prohibits that amount from being included in the commission calculation. If 
you are creating a credit memo, Cost is inactive. 
  

15. Type a Description of the memo. 
16. Complete the GL Distribution grid as follows: 

 
 Acct # is the general ledger account or accounts affected by the memo. A debit memo credits 
these accounts. A credit memo debits these accounts. 
 
 Amount is the amount of the memo that applies to the selected account. Percent displays the 
percentage of the memo assigned to the selected account. 
  

17. If you are creating a debit memo that has a discount and/or a cost associated with it, the GL 
Accounts group box becomes active. Complete this grid as follows: 
 
 Discount Account is the general ledger account credited by the discount associated with the debit 
memo. Amount displays the amount entered in Discount. 
 
 Cost of Sales is the general ledger account credited by the cost associated with the debit memo. 
Amount displays the amount entered in Cost. 
 
 Inventory Account is the general ledger account debited by the cost associated with the debit 
memo. Amount displays the amount entered in Cost. 
  

18. When you have finished creating the memo, you can save the batch or choose Post to post it. If 
you save the batch without posting it, you can modify memo at a later time. For information on 
posting batches, click Posting at the beginning of this topic. 
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Printing Debit or Credit Memo Documents 

When you have finished entering a credit memo or a debit memo, you can print the memo, a memo 
register, and a list of the memo distributions. 

• The debit memo includes the reason for the memo, the customer it was created for, the amounts 
for freight, tax, and discounts, and the total amount of the debit memo. 

• The memo register presents the memo information in a different layout. 
• The memo distributions include the general ledger accounts that were debited or credited. 

To print these documents from DB/CR Memos: 

1. From the File menu, choose Print Select or Print Preview. 
2. In the Document Print selection dialog, select Memo Document Print, Memo Register or Memo 

Distributions. 
 
Memo Distributions is not available until after you post the debit or credit memo. You must print 
the distributions before you exit the DB/CR Memo dialog. Otherwise, this option will not be 
available. 
  

3. Click OK. 

When you click OK, the selected document is displayed in the Report Explorer. From here, you can choose 
Print from the File menu to print it. 
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Invoice Corrections - Accounts Receivable 
 

Invoice Corrections allows you to correct general information on an invoice, such as pay-from, 
invoice date, and terms. You also use Invoice Corrections to mark an invoice as disputed. For 
more information, refer to Disputed Invoices. 

You do not use Invoice Corrections to change the amount due for an invoice. To change the 
amount, you create an A/R adjustment. 

NOTE: If you change the terms of sale when you correct an invoice, a message appears and gives 
you the option of recalculating the due date based on the new terms. Click Yes in the message to 
recalculate the due date. Click No if you do not want to recalculate the due date. For example,  

To create an invoice correction: 

1. Open the Invoice Corrections dialog (Transactions>Accounts Receivable>Invoice Corrections). 
2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. If 

necessary, type a different Batch Description, then click OK. 
3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. Select 

the batch you want to open, then click OK. 
4. Select the Invoice you want to correct. An invoice is not available here until it has been posted. If 

an invoice has not been posted, you can open it in Order Entry and make some of the corrections 
listed here, such as customer purchase order number and terms. 

5. In the Corrections group box, make your corrections to any or all of the following information. 
 
 PayFrom is the customer responsible for paying the invoice. 
 
 ShipTo is the customer's ship-to location to which you ship the items associated with the invoice.  
 
 Invoice Date is the date the invoice was created. 
 
 Terms identifies the payment terms for this invoice. If you change the terms of sale, a message 
appears and gives you the option of recalculating the due date based on the new terms. Click Yes 
in the message to recalculate the due date. Click No if you do not want to recalculate the due date. 
 
 Currency is the currency used by the customer to pay this invoice. 
 
 Disputed identifies whether this invoice is under dispute. A check mark indicates the invoice is 
under dispute. For more information, refer to Disputed Invoices. 
 
 Dispute Date is the date the invoice first became disputed. 
 
 Release Dispute Date is the date the invoice is no longer being disputed. 
 
 Fax Date is the date you faxed the invoice to the customer. 
 
 Customer PO is the customer's purchase order number associated with the invoice. 
 
 Exchange Rate is the rate between your currency and the foreign currency, if applicable, used to 
pay the invoice. 
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 COD identifies whether this invoice is COD. A check mark indicates that the invoice is COD. 
 
 COD Tag is the tag number associated with the COD. 
 
 Department is the customer's department associated with the invoice. 
 
 Dispute Memo allows you to type additional information about a disputed item. 
  

6. When you have finished creating the invoice correction, you can save the batch or choose Post to 
post it. If you save the batch without posting it, you can modify it at a later time. For information 
on posting batches, click Posting at the beginning of this topic. 
You can select to display the Billing Recap information in your Domestic Currency or, if 
applicable, the Foreign Currency. 

• Gross Amount is the gross amount of the invoice. 
• Discount is the total amount of all discounts that apply to the invoice. 
• Freight is the freight charges associated with the invoice. 
• Tax is the amount of the tax applied to the invoice. 
• Total is the amount charged to the customer. The total is the gross amount, minus the discount, 

plus the tax and freight. 
• Current Balance is the amount the customer currently owes on the invoice. 
• # of Payments is the number of payments made on the invoice. 
• Total Paid is the total amount of the invoice the customer has paid so far. 
• Last Paid is the date of the last payment made on the invoice. 
• Last Payment is the amount of the last payment made on the invoice. 
• Last Check is the check number used to make the last payment on the invoice. 
• Last NSF identifies the most recent insufficient funds check received for this invoice. 
• Allowances is the amount of the allowances. 
• Adjustments is the amount of the adjustments made to the invoice. 
• Refunds is the amount of the refunds made to the customer based on this invoice. 
• CM Applied displays the amount of all credit memos applied to this invoice. 
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Disputed Invoices 

If a customer wants to dispute an invoice, debit memo, or finance charge, you designate it as disputed in 
Invoice Corrections. 

• Placing an open item in dispute prevents aging of the open amount. 
• An invoice or debit memo in dispute does not accrue finance charges.  Note:  For invoices, you 

have the option to calculate the finance charge without subtracting the disputed invoices from total 
amount for finance charges.  The CO Miscellaneous Control File - Company Section contain the 
Subtract Disputed Invoices from total Amount for Finance Charges setting, which provides 
you the option to calculate finance charges without subtracting the disputed invoices from the 
total.  If the option is set to True (Checked), which is the default, the system the system calculates 
finance charges after subtracting any disputed invoices from the total outstanding amount. If you 
want to calculate the finance charge without subtracting the disputed invoices from total amount, 
de-select (Uncheck) the Subtract Disputed Invoices from total Amount for Finance Charges 
option. 

• Disputed items are excluded from credit limit consideration and will not contribute to placing a 
credit hold on the account. 

• Disputed items remain active in the system until paid in full or adjusted to zero. 
• Disputed items may be processed as any other non-disputed item. 
• When the disputed flag is removed from an unpaid item, the aging and finance charge accrual are 

calculated as if the dispute never occurred. 

To identify an open item as disputed: 

1. In the Invoice Corrections dialog (Transactions>Accounts Receivable>Invoice Corrections), open 
or create a batch. 

2. Select the invoice, debit memo, or finance charge being disputed. 
3. Select Disputed. 
4. If you want to include a note about the dispute, type it in Dispute Memo. 
5. Save or post the batch. 
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NSF Checks 
 

An NSF (insufficient funds) check occurs when your bank returns a previously applied customer 
check because of insufficient funds in the customer's account. Recording an NSF check reverses 
the effects of the previous payment application. After checks are added to a batch, you can print a 
deposit slip and a Cash Application Worksheet. For information, click Printing Check Entry 
Documents. 

Note: If you do not know the check number of the NSF check, you must create a debit memo 
instead of an NSF check. 

To enter an NSF check: 

1. Open the NSF Checks dialog (Transactions>Accounts Receivable>NSF Checks). 
2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. If 

necessary, type a different Batch Description, then click OK. 
3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. Select 

the batch you want to open, then click OK. 
4. Click in the Customer grid then press the INSERT key on your keyboard. 
5. Select the Customer that gave you the NSF check. 

 
 Cust Name displays the name of the selected customer. 
   

6. Select the Bank that processed the NSF check. 
7. In Check, type the check number. 

 
 Currency displays the customer's currency. 
 
 Processed displays the number of times the bank has processed the check. 
 
 Date Paid displays the date the customer made the payment. 
 
 Check Amount displays the amount of the insufficient check. 
 
 Foreign Amount displays the amount of the check written in foreign currency. 
 
 The Invoice grid displays each invoice you applied the check to. This grid is discussed below. 
  

8. When you have finished adding NSF checks, you can save the batch or choose Post to post it. If 
you save the batch without posting it, you can modify it at a later time. For information on posting 
batches, click Posting at the beginning of this topic. 
Invoice Grid 

The Invoice grid displays each invoice you applied the check to. 

• Doc # is the number of the invoice the check was applied to. 
• Date Applied is the date the check was applied to the invoice. 
• Amount Applied is the amount of the check applied to the invoice. 
• Commission (Cash Basis) is the amount of the commission paid based on the amount of the 
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check applied to the invoice. This amount displays commission paid on a cash basis, not an 
accrual basis. 

• Tax (Cash Basis) is the amount of the tax associated with the portion of the check applied to the 
invoice. This amount displays tax paid on a cash basis, not an accrual basis. 
  

Printing NSF Check Documents 
When you have finished entering an NSF check batch, you can print the NSF check register and 
distributions. 

• The NSF check register lists the NSF checks in the batch. 
• The NSF check distributions include the general ledger accounts that were debited or credited 

when you posted the NSF check batch. 
To print these documents from NSF Checks: 

1. From the File menu, choose Print Select or Print Preview. 
2. In the Document Print selection dialog, select NSF Check Register or NSF Check Distributions. 

 
 NSF Check Distributions is not available until after you post the NSF check batch. You must 
print the distributions before you exit the NSF Checks dialog. Otherwise, this option will not be 
available. However, you can print the distributions from the Report Explorer. 
  

3. Click OK. 
When you click OK, the selected document is displayed in the Report Explorer. From here, you 
can choose Print from the File menu to print it. 
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Refund Checks 
 

Refund Checks allows you to issue refund checks to customers who have unused credit items such 
as credit memos and on-account records. When you create a refund check, the credit is no longer 
available and does not appear in Credit Application or Check Application. If you void the refund 
check, the credit becomes available again. 

To create a refund check: 

1. Open the Refund Checks dialog (Transactions>Accounts Receivable>Refund Checks). 
2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. If 

necessary, type a different Batch Description, then click OK. 
3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. Select 

the batch you want to open, then click OK. 
4. In the Filters group box, select the filters, if any, that you want to apply. 

 
 Customer allows you to select a specific customer. If you want to retrieve credit memos and/or 
on-accounts for several customers, but do not want to retrieve all customers, you can retrieve 
customers one at a time. To retrieve them one at a time, select a Customer then select Credit 
Memos and/or On-Accounts. From the Actions menu, choose Fetch. Credit memos and/or on-
accounts are retrieved for the selected customer and placed in the check grid. Repeat those steps 
for each customer you want to create refund checks for. The Checks grid contains credit memos 
and/or on-accounts for all customers you retrieve. If you leave Customer blank, Enspire retrieves 
credit memos and/or on-accounts for all customers. 
 
 Credit Memos retrieves credit memos when you choose Fetch. If you do not want to retrieve 
credit memos, unselect Credit Memos. 
 
 On-Accounts retrieves on-accounts when you choose Fetch. If you do not want to retrieve on-
accounts, unselect On-Accounts. 
  

5. Select the Bank that will process the refund check. 
6. If you want to use the electronic signature set up for the bank, select Use Signature. Leave this 

option unselected if you do not want to use the electronic signature. You create an electronic 
signature in the Bank Account Maintenance dialog. To jump to information on that topic, click 
Banks. 

7. If the Check section is not currently displayed, click the Check tab. 
8. From the Actions menu, choose Fetch. Choosing Fetch displays the credit memos and/or on-

account balances associated with the customer. 
9. To issue a full or partial refund for a credit memo or on-account, select Pay in the Check grid. 

 
 Customer # and Cust Name identify the customer you are creating the refund for. 
 
 Document is the credit memo or on-account you are creating the refund for. CM in the document 
number identifies it as a credit memo. OA in the document number identifies it as an on-account. 
 
 Balance is the balance remaining on the document. 
 
 Invoice Date is the date the credit memo or on-account was created. 
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10. In Refund, type the amount of the refund check. 
11. If you want to include a comment with any or all of the refund checks, complete the Comment 

group box as follows: 
 
 In the Check grid, select the document you want to create a comment for. Click in the text box 
and type the comment. 
 
 Print Comment determines whether you include the comment when printing the refund check. 
To print the comment, select a credit memo or on-account balance in the Refund Checks grid, then 
select Print Comment. 
 
 Apply to All, when selected, applies the comment to each refund in the batch. Leave Apply to 
All unselected to apply the comment only to the credit memo or on-account balance currently 
selected in the Checks grid. 
  

12. Print the refund check. To display the procedure for printing refund checks, click Printing Refund 
Checks. 

13. When you have finished creating refund checks, you can save the batch or choose Post to post it. 
If you save the batch without posting it, you can modify it at a later time. For information on 
posting batches, click Posting at the beginning of this topic. 
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Printing Refund Checks 
1. In the Refund Checks dialog, select the credit memos and/or on-accounts you want to print refund 

checks for. 
2. To print the check, choose Print Select from the File menu. If you want to preview the check 

before you print it, choose Print Preview. 
3. In the Document Print Selection dialog, select the document you want to print then click OK. 

 
 First, you must print the Preliminary Check Register. After the preliminary check register prints 
and you are ready to print the checks, repeat step 2 and select Print Checks. The Check Print 
dialog appears. 
  

4. In the Check Print dialog, make sure Print is selected for each check that you want to print. If you 
do not want to print a check, unselect Print. 

5. After you print the checks, you can open the Document Print Selection dialog and print the Final 
Check Register. 

6. You can then open the Document Print Selection dialog and print the Refund Distributions, 
which shows you how the refund check affects your general ledger. 
 
 Refund Distributions is not available until after you post the batch. You must print the 
distributions before you exit the Refund Checks dialog. Otherwise, this option will not be 
available. However, you can print the distributions from the Report Explorer. 
  

7. Click OK. 
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 About this Chapter 
This chapter covers creating a basic order and also takes you through the order entry cycle. It also 
discusses order types, order status, and holds. 

Order Entry Flowchart 
This flowchart shows the general path an order takes from order entry through confirmation and 
invoice posting. Each of the procedures in the flowchart is discussed later in this chapter. 

 

Order Types and Subtypes 
When you create an order, you select an order type. The types are: 

• Basic 

• Drop Ship 

• Direct Invoice 

• Future 

• Quote 

• Recurring 

Basic Order Type 
A Basic order is a one-time order that should be shipped and invoiced as soon as possible. Enspire 
commits the stock when each item quantity is entered. If stock is unavailable for an order line, the 
line can be converted to a special order or retained as a backordered line item. When you create a 
basic order, you must select a subtype. The subtypes are: Blind Shipment, Ship Complete, 
Standard, Tag & Hold, and Will Call. 

Blind Shipment Subtype 
Blind Shipment creates an order that you ship directly to your customer’s customer. However, the 
order looks like is was shipped by your customer instead of by your company. 

Ship Complete Subtype 
A ship complete order is a basic order with an additional requirement that all items on the order 
must ship at the same time. If all items on the order are not in stock when the picking ticket is 
printed, Enspire prints SHIP COMPLETE instead of the customer address on the picking ticket. 
The in-stock items are picked and placed in a staging area until the remaining stock is received. 
You print the final picking ticket when the last of the stock is received and you can completely fill 
the order. The final picking ticket indicates that the order is a previously printed Ship Complete 
order and shows the address and the staging area where the other stock is located. If Must Ship 
Complete is selected for the customer, a new basic order is automatically converted to a Ship 
Complete order during order entry. You select Must Ship Complete in the Controls section of the 
Customer ShipTo dialog. 
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Standard Subtype 
Standard creates a one-time order that should be shipped and invoiced as soon as possible. Enspire 
commits the stock when each item quantity is entered. 

Tag & Hold Subtype 
A tag & hold order is an order that will be picked from stock, placed in a staging area, but not 
immediately shipped. Enspire prints TAG & HOLD instead of the customer address. When the 
order is released, another picking ticket is printed that includes the customer address and the 
staging area where the stock is located. The release date is the date the order should be shipped 
and the cancel date is the date the order should be deleted and stock uncommitted if the order has 
not been released. As part of the close-day process, Enspire indicates which tag and hold orders 
should be released or deleted. 

Will Call Subtype 
A will call order is an order that the customer will pick up at your location. Because you do not 
ship the order, Enspire prints WILL CALL instead of the customer address. You confirm the order 
and proceed with invoicing after the customer picks up the order. The ship date is the expected 
date of pickup. Optionally, you can enter the release time of day for the pickup date. 

Direct Invoice 
A direct invoice order allows you to print an invoice quickly from within Order Entry. This type is 
typically used for point-of-sale transactions.  

Drop Ship Order Type 
A drop ship order is an order that will ship from a warehouse location other than the warehouse 
assigned to the customer. A drop ship order is used when the order entry operator knows ahead of 
time that the assigned warehouse has no stock available for the desired items. You cannot assign a 
drop ship order type to an order. Enspire creates a drop ship order automatically when you select a 
disposition of drop ship. 

Future Order Type 
A future order is an order that is released at a later date, typically more than 30 days from today’s 
date. Enspire does not commit stock for a future order until it is released. The earliest release date 
for a future order is equal to the longest lead-time for any item on the order plus fourteen days. 
Enspire automatically releases future orders when the day prior to the release date is closed. When 
the order is released, Enspire commits the stock, if available. If stock is unavailable when the 
order is released, Enspire automatically initiates a backorder. 

Quote 
A quote allows you to provide customers or prospects with pricing and availability information. 
Quotes can include taxes, carriers, shipping charge, and minimum order charges. No stock is 
committed and no documents, such as pick tickets and packing slips, can be generated from a 
quote. 

Recurring Order Type 
A recurring order is an order that is shipped on a regular basis, such as daily, weekly, or monthly. 
Use this order when the same items and quantities are shipped for every recurring order. Enspire 
commits stock, if available, when the order is released. If stock is unavailable when the order is 
released, Enspire automatically initiates a backorder. 
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Recurring Order Type 

A recurring order is an order that is shipped on a regular basis, such as daily, weekly, or monthly. 
Use this order when the same items and quantities are shipped for every recurring order. Enspire 
commits stock, if available, when the order is released. If stock is unavailable when the order is 
released, Enspire automatically initiates a backorder. 

Remote  

A remote order is an order placed by a customer then released into Enspire. When you release remote 
orders, they are converted to basic sales orders with a status of Entered and available stock is 
committed. 

 

What the Order Status Means 
An order’s status identifies where that order is within the order entry process. For example, an 
order status of Printed means that the order has been created and printed and is now ready to be 
confirmed. The status options are: Entered, Printed, and Shipped. 

• Entered indicates that the order is either partially or completely entered, but a packing 
slip or a picking ticket has not yet been printed. 

• Printed indicates that at either a packing slip or a picking ticket has been printed for the 
order  

• Shipped indicates that the order has been confirmed, an invoice has been created, and that 
all lines on the order have a disposition of Completed Line. If one or more lines on the 
order has a disposition other than Completed Line, the order’s status is reset to Entered. 

Order Line Dispositions 
Initially, Enspire assigns a disposition to an order line based on the order type, item type, and/or 
available quantity. In some cases, you can change the disposition. The dispositions are as follows: 

• Back Order – Applies if back orders are allowed and there is not sufficient quantity to fill 
the order line. 

• Completed – Indicates there is enough quantity on-hand to fill the line. 

• Drop Ship – Creates a drop-ship order for the item and ships the item from the warehouse 
selected in the Drop Ship Warehouse Selection dialog. This dialog appears when you 
select the Drop Ship disposition. Select the drop-ship warehouse, then click OK. The 
Document field in the Items grid displays the drop ship order number. 

• Future – Applies if you will ship the item at a later date. The earliest ship date for the line 
must be greater than today’s date plus the items’ lead time (as set in the Reorder section 
of the Warehouse Item Master dialog) plus the future release days (as set in the Order 
Entry section of the Miscellaneous Control File dialog).  

• Miscellaneous – Assigned to Miscellaneous Debit or Credit items. 

• Purchase Order – Creates a purchase order for the item. The Costulator appears and 
allows you to select a vendor from which to purchase the item. The Document field in the 
Items grid displays the purchase order number. 
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• Recurring – Assigned to items included on orders with an order type of Recurring. 

• Special Order – Makes the item available for a special order buy. For information on 
special order buys, see the Purchasing chapter. 

• Transfer – Creates a transfer for the item and transfers the item from the warehouse 
selected in the Transfer Warehouse Selection dialog. This dialog appears when you select 
the Transfer disposition. Select the transfer warehouse, then click OK. The Document 
field in the Items grid displays the transfer number. 

• Vendor Direct – Creates a vendor direct purchase order for the item. The Costulator 
appears and allows you to select a vendor from which to purchase the item. The 
Document field in the Items grid displays the purchase order number. 

• Work Order – Occurs when you have to assemble a stocked kit rather than pull one from 
pre-assembled stock. 

• StockAid – Indicates that the line is being filled with items from StockAid. 

Hold Controls 
When an order is placed on hold, it cannot be printed until the hold or holds are removed. You can 
set up Enspire to place orders on hold for a variety of reasons, including questionable credit, 
incomplete information, and outstanding balances. Managing hold orders allows you to determine 
which orders are ready to be processed and to view relevant information for the orders currently 
on hold. This information can include customer credit standing, license status, and margin levels. 

Enspire includes the following types of holds. 

• A) Authorization Hold – Enspire places this hold when a point-of-sale credit card 
payment is waiting for an authorization number. You cannot override this hold. 

• B) Bad Check Hold – If you have received an insufficient funds check from a customer 
within a specified number of days, Enspire places that customer’s orders on hold. You set 
the number of days in the Hold Controls section of the Miscellaneous Control File dialog. 

• C) Credit Hold – If a customer exceeds its credit limit, or of the customer is due for a 
credit review, Enspire can place a credit hold on that customer’s orders and invoices. You 
set credit limits and credit review dates in the Credit section of the Customer Master 
Maintenance dialog. 

• H) Customer Margin Hold – A customer margin hold occurs if you do not achieve the 
specified minimum margin when selling to a customer. You establish this margin in the 
Pricing section of the ShipTo Locations dialog. 

• I) Inactive Account Hold – If a customer has not placed an order within the specified 
number of days, Enspire places that customer’s orders on an inactive account hold. You 
set the number of days in the Hold Controls section of the Miscellaneous Control File 
dialog. 

• L) License Hold – A license hold occurs when a customer orders a regulated item and a 
license number is not available, either manually or from a license table. 

• M) Margin Hold – A margin hold occurs if you do not achieve the specified minimum 
margin on an order. You establish this margin in the Hold Controls section of the 
Miscellaneous Control File dialog. 
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• N) New Account Hold – This hold type applies to new customers, based on the Date 
Opened date in the Information section of the Customer Master Maintenance dialog. You 
set the number of days a customer is considered new in the Hold Controls section of the 
Miscellaneous Control File dialog. 

• O) Order Limit Hold – If a customer exceeds its maximum amount allowed in a single 
order, Enspire places the order on hold. You set the single order maximum in the Pricing 
section of the Customer ShipTo dialog. 

• P) Past Due Hold – When the age, in days, of a customer’s oldest unpaid and undisputed 
invoice is greater than the specified number of days, Enspire places that customer’s 
orders on hold. You set the number of days in the Credit section of the Customer Master 
Maintenance dialog. 

• S) Status Hold – A status hold is a manual hold that you place on a customer’s ship-to 
location in the Customer ShipTo dialog. 

• W) Warehouse Hold – A warehouse hold allows you to minimize the number of 
shipments for backorders and consolidate multiple backorders for shipping. You can set 
or remove a warehouse hold during order entry. 

• Z) Zero Cost/Price Hold – If an order contains items, excluding free goods, with a zero 
cost or price, Enspire places the order on a zero cost/price hold. 

Hold Order Management Filtering Criteria 
The Filtering Criteria group box in the Hold Order Management dialog allows you to determine 
the orders and/or invoices made available for adding or removing holds. You can filter on any or 
all of the following. 

• Warehouse Code allows you to identify a specific warehouse. Leave Warehouse Code 
blank to make available orders and invoices from all warehouses. 

• The Lock Status group box determines whether you retrieve all orders and invoices that 
meet the filter criteria, or only documents that have one or more holds placed on them. 
Locked retrieves only documents that have one or more holds placed on them that also 
meet the filter criteria. All retrieves all documents that meet the filter criteria. 

• The Customer group box allows you to retrieve orders and invoices based on a range of 
customers. Begin is the first customer in the range. End is the last customer in the range. 

• The Document group box determines whether you retrieve invoices, orders, or both. It 
also allows you to retrieve documents based on a range of documents. Orders, when 
selected, includes orders in the range of documents. Leave this option unselected if you 
do not want to include orders. Invoices, when selected, includes invoices in the range of 
documents. Leave this option unselected if you do not want to include invoices. Begin 
Doc # is the number of the first document in the range. End Doc # is the number of the 
last document in the range. 
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The Filter Criteria below retrieves all orders that belong to the West warehouse that also have a 
document number between 77679 and 77684. 

 

Placing an Order on Hold Manually 
The parameters you establish determine when Enspire places an order on hold automatically. 
However, in some instances, you may want to override the automatic hold controls and place an 
order on hold manually. For example, if you receive a bad check from a customer on the same day 
that customer places an order, you can place that order on a Bad Check Hold to make sure the 
order is not shipped before the bad check is entered into Enspire. 

Holds that are applied manually remain in effect until hold conditions are re-evaluated and reset, 
which happens when you close the day. Hold conditions for an individual order are re-evaluated 
and reset each time you open that order. For example, if you do not enter the bad check into 
Enspire before you close the day or open the order, the hold is removed. 

To place an order on hold manually: 

1. Open the Hold Order Management dialog (Transactions>Order Entry>Hold Orders and 
Invoices). 

2. Set the Filter Criteria you want to use to retrieve orders. Because you want to retrieve 
only orders, make sure Invoices is unselected. For information on the filters, see Hold 
Order Management Filtering Criteria above. 

3. From the Actions menu, choose Fetch. 

Choosing Fetch retrieves the orders according to your filtering criteria.  

4. In the Orders grid, select the order or orders you want to place on hold. 

5. In the Hold Switch group box, select the Type of hold you want to place. A list of the 
hold types is included earlier in this chapter. 

6. Click Lock. 

The holds appear under Hold Switches in the Orders grid. In the example below, order 
77679 has a bad check hold and a credit hold applied to it, order 77682 has a warehouse 
hold applied to it, and order 77684 has a bad check hold applied to it. 

 

7. After you have applied all the holds you want to apply, choose Post from the Actions 
menu. 

Removing Holds 
Enspire removes holds automatically when the hold condition no longer applies. Holds that you 
remove manually are reset when hold conditions are re-evaluated and reset, which happens when 
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you close the day. Hold conditions for an individual order are re-evaluated and reset each time you 
open that order. 

Removing Holds in Hold Order Management 
1. Open the Hold Order Management dialog (Transactions>Order Entry>Hold Orders and 

Invoices). 

2. Set the Filter Criteria you want to use to retrieve orders. Because you want to retrieve 
only orders, make sure Invoices is unselected. For information on the filters, see Hold 
Order Management Filtering Criteria earlier in this chapter. 

3. From the Actions menu, choose Fetch. 

Choosing Fetch retrieves the orders according to your filtering criteria. 

4. In the Orders grid, select the order or orders you want to remove holds from. 

5. In the Hold Switch group box, select the Type of hold you want to remove. A list of the 
hold types is included earlier in this chapter. 

6. Click Unlock. 

7. After you have removed all the holds you want to remove, choose Post from the Actions 
menu. 

Removing Holds in Order Entry 
1. Open an order in Order Entry (Transactions>Order Entry>Order Entry). 

2. From the Actions menu, choose Totals. 

3. In the Totals dialog select the hold or holds you want to remove. 

In the Hold Management group box, a check mark identifies each hold that is currently 
placed on the order. In the example below, Order Limit is not a current hold and New 
Account is. 

 

4. Click OK. 

Creating a Basic Order 
A basic order with a standard subtype is the most common type of order created in Enspire. The 
procedures and techniques used to create a basic order can be applied to the other order types. 
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To create a basic order: 

1. Open the Sales Order Entry dialog (Transactions>Order Entry>Order Entry). When you 
create a new order, the Type defaults to B) Basic and the Sub Type defaults to S) 
Standard. 

  

2. In Customer, use the lookup to select a customer. 

If this customer is set up to display a class notification message, that message appears. If 
a mandatory memo is assigned to the customer, that memo appears. You can also choose 
Memo from the Tools menu or the  icon to display customer memos. If a hold applies 
to the order, you are given the option to cancel the order or continue. If open orders exist 
for the customer, the Open Orders dialog appears. You can select an order with a status of 
Entered and include additional items on that order. 

3. Use the lookup to select a customer ShipTo location. 

4. Select the Warehouse that will ship the order to the customer. The warehouse assigned 
to the ship-to location defaults here. You can change it if necessary. You assign a 
warehouse in the Codes section of the ShipTo Locations dialog. 

5. If you are committing the stock today, leave Commit Today selected. If you are 
committing the stock later, unselect Commit Today. 

This option determines whether stock for the order is committed today or later. The 
warehouse time settings and the ship-to’s earliest ship days determine if Commit Today 
is available. You set the earliest days to ship in the Shipping section of the ShipTo 
Locations dialog. If Commit Today is unselected, you cannot print pick tickets or 
packing slips for the order. These forms are the only ones that move an order into printed 
status. 

6. Complete the Customer Information group box as follows: 
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Purchase Order is the customer’s purchase order number, if any, associated with the 
order. 

Release is the customer’s release number for this order. 

Currency displays the currency the customer uses to pay for this order. 

Exchange Rate displays the exchange rate from the customer’s currency into your 
currency. 

Carrier is the carrier that will deliver the order. 

Service describes the type of service the carrier will provide for this order. 

Terms are the terms assigned to the customer for this order. The Terms ID selected in the 
Codes section of the Customer Master Maintenance dialog appears as the default here. 
You can change it if necessary. If you select an installment term, a warning appears to 
make sure that you want to assign installment terms. 

Source identifies the marketing tool that prompted the order. 

Ordered By is the person who placed the order. 

Department is the department of the person who placed the order. 

7. Accept or change the order dates. The dates available to a basic order are as follows: 

Ordered is the date you created the order. 

Earliest Ship is the earliest date the order can ship. 

Latest Ship is the last date the order can ship. 

Cancel On is the date after which the customer can refuse an order. For example, a 
customer wants you to cancel an order if you cannot ship it within 10 days. In this case, 
you would set the Cancel On date to ten days from the Ordered date. Cancel On is used 
for informational purposes only. Enspire will not automatically cancel orders based on 
this date. 

8. Add items to the order. For instructions, see Adding an Item to an Order below. 

Adding an Item to an Order 
1. Click in the Items grid. 

2. In Item, use the lookup to select an item. 

After you select an item, the Prices dialog displays the pricing options available to the 
customer for the selected item. In the User Profile dialog, if Show Pricing during OE is 
selected, the Prices dialog appears automatically after you select an item. Enspire 
automatically applies the correct price based on the pricing hierarchy. To display the 
Prices dialog at any time, choose Show Prices from the Actions menu. 
 
You can click  or choose Show BTO from the Actions menu to access the BTO 
Details dialog from if you are adding a BTO Kit or a BTO Assembly. 
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You can click  or choose Show Schedule from the Actions menu to access the 
Schedule Plan dialog, which is used to set up a scheduled line.  

3. In Quantity, type the quantity you want to order. 

If Enspire can commit the entire quantity to the order, the Commit quantity equals the 
ordered Quantity and the Disposition is set to C-Completed Line. If the entire quantity 
cannot be committed, Enspire commits the available quantity and backorders the 
remaining quantity. The Disposition is set to B - Back Order Line. If backorders are not 
allowed, Enspire commits the available quantity, cancels the remaining quantity, and sets 
the Disposition to C - Completed Line. 

4. If you want to change the item’s quantity unit of measure, select it in QUM. 

An item’s default quantity unit of measure appears in QUM. You assign the default to the 
item in the Pricing section of the Item Master dialog. 

5. If you want to change the price, type the new price in Price. 

Enspire automatically applies the correct price based on the pricing hierarchy. If you have 
the proper security clearance, you can change an item’s price during order entry. In 
Price, you can type a new price or use one of the modifiers to calculate a price. For 
example, if you type C10, the price for the item is cost plus 10 percent. If you type L10, 
the price for the item is the list price minus 10 percent. For a complete list of price 
modifiers, see the Enspire online help. 

6. If you want to change the item’s amount unit of measure, select it in AUM. 

An item’s default amount unit of measure appears in AUM. You assign the default to the 
item in the Pricing section of the Item Master dialog. 

7. If necessary, change the item’s Disposition. For information on dispositions, see Order 
Line Dispositions earlier in this chapter. 

8. When you have finished adding items to the order, choose Save. 
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Order Entry - Images Section  
The Order Entry dialog provides the same Item Imaging capabilities that are found within Item 
Master. The Images tab is located in the details (lower) section of the dialogue. Refer to the Item 
Master - Images Section for detailed instructions.  

 

Appendix Image Tools  

 

Open displays the Open dialog and allows you to select an image to open. When you 
open an image, it does not have to be located in the image library path folder. After you 
open it, you can save it in that folder.  

 

Save allows you to save the current image in the image library path folder. Choosing 
Save displays the Save As dialog.  

 

Print sends the contents of the image area to the selected printer based on your printer 
group.  

 

Scan Image allows you to scan an image if your computer is connected to a scanner.  

 
Select Scanner allows you to select a scanner for scanning an image. Choosing Select 
Scanner displays the Select Source dialog. Here, you select a scanner then click Select.  

 

Toggle Panning Zooming gives you the ability to zoom to enlarge the image area or pan 
to a specific part of the image area.  

 

Zoom In increases the size of the contents of the image area. If Best Fit is selected, 
Zoom In is not available.  

 
Zoom Out decreases the size of the contents of the image area. If Best Fit is selected, 
Zoom Out is not available.  
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Best Fit Image resizes the image to fit the image area.  

 
Center Image positions the contents of the image area in the center of the area.  

 
Reset Zoom restores the zoom to its original level.  

 
Cut to Clipboard removes the current image and places it on the clipboard.  

 

Copy to Clipboard copies the current image to the clipboard.  

 
Paste from Clipboard places the image on the clipboard into the image area.  

 
Undo Image undoes the last change to the image.  

 

Toggle Annotation Mode toggles the image area in and out of annotation mode. You 
must be in annotation mode to add or edit objects.  

 
Invert reverses the colors of the current image. Object colors are not inverted.  

 
Rotate 90 rotates the current image 90 degrees.  

 
Rotate 180 rotates the current image 180 degrees.  

 
Effect Manager allows you to change the appearance of the image. Choosing Effect 
Manager displays the Filters and Effects dialog.  

 

 

 

Object Tools  
 

 
Edit Annotation allows you to select and edit objects.  

 
Rectangle draws squares and rectangles.  

 
Hilite draws a highlighted area. The foreground color determines the color of the hilite.  

 
Line draws a straight line.  

 
Arrow draws a line with an arrow point at the end.  

 
Ellipse draws ovals and circles.  

 
Polyline draws custom shapes. Each time you click in the image area, a line is drawn that is 
connected to the previous line. To end the drawing, right click the mouse.  

 
Freehand draws a continuous line as long as you hold the mouse button down.  
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Polygon draws custom shapes. Each time you click in the image area, a line is drawn that is 
connected to the previous line. To end the drawing, right click the mouse.  

 
Insert Image allows you to insert a saved graphic.  

 
Label creates a text label with a colored background. To change the text in the label, right click 
the label, select Label Properties then Text. In the Text dialog, type the new text for the label. 
Load from File allows you to import text into the label. Save to File allows you to export the 
label text to a text file.  

 
Transparent Label functions in the same manner as Label but it does not have a background 
color.  

 
Draw Notes allows you to create a text box. The foreground color controls the color of the text 
and the background color controls the color of the text box.  

 
Rubberstamp allows you to place text and graphics onto the image. Click the rubber stamp tool 
then click in the image area. The Rubber Stamp Properties dialog appears. The Stamps area lists 
the stamps you can use. Click a stamp then click OK. The stamp appears in the image area. For 
instructions on creating a new stamp, click Creating a Rubberstamp.  

 
Opaque gives the selected object a solid white fill.  

 
Transparent gives the selected object a transparent fill.  

 
Solid gives the selected object a solid fill. The fill color is the foreground color.  

 
Line Width changes the line width of the selected line or shape.  

 
Bring to Front positions the selected object in front of all other objects.  

 Send to Back positions the selected object behind all other objects.  

Printing an Order 
Printing an order generates pick tickets, acknowledgements, packing slips, and other forms related 
to the order. You must print or preview pick tickets or packing slips to move an order from 
Entered status to Printed status. You can print a single order from Order Entry and you can print 
one or more orders from Document Print. 

Before you can print an order, you must remove all holds currently placed on the order. For 
information on removing holds, see Hold Controls earlier in this chapter. 

Printing an Order from Order Entry 
1. In the Sales Order Entry dialog (Transactions>Order Entry>Order Entry), open the order 

you want to print. 

To open an order, choose Open from the File menu. In the Order Entry Document 
LookUp dialog, select the order you want to open then click OK. 

2. Select the  icon or choose Totals from the Actions menu. 

3. In the Totals dialog, remove the holds, if any, currently placed on the order. 

4. From the File menu, choose Print Select. 
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5. In the Document Print Selection dialog, select the document you want to print. 

 

6. Click OK. 

Printing an Order from Document Print 
The Document Print dialog for Order Entry gives you the ability to print orders, invoices, credits, 
and quotes. You can also filter the orders that are available to print. For example, if you select a 
warehouse, only orders belonging to that warehouse will be available for printing. If you type a 
range of order numbers, Enspire retrieves only the orders within that range. 

To print an order from Document Print: 

1. Open the Document Print dialog for Order Entry (Transactions>Order Entry>Document 
Print). 

 

2. In the Print group box, select Orders. 
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3. Select any filters that you want to apply. In the sample dialog above, Enspire retrieves 
only those orders that belong to the West warehouse that have a document number 
between 77973 and 77984. 

4. In the Form group box, select the form or forms you want to print. 

5. In the Document group box, select the document or documents that you want to print the 
forms for. 

6. Click Fetch. When you click Fetch, the documents that meet your filtering criteria 
appear in the Documents grid. 

7. In the Documents grid, make sure Print is selected for each document you want to print. 

8. If you want to print the selected documents, click Print. If you want to preview the 
selected documents, click Preview. 

Previewing a document allows you to review it onscreen then decide if you want to print 
a hard copy. When you preview an order, it is displayed in the Enspire Report Explorer. 
Previewing or printing packing slips and/or pick tickets sets an order’s status to Printed. 

Confirming an Order 
After you print an order, you are ready to confirm it. You confirm an order when it has been 
loaded and is ready for shipping, or when it has already been shipped. After you confirm an order, 
you can print the shipping manifest, driver route sheet, and COD tags. Posting an order 
confirmation batch creates an invoice for each order included in the post and changes the status of 
those orders to Shipped. 

To confirm an order: 

1. Open the Order Confirmation dialog (Transactions>Order Entry>Order Confirmation). 

 

2. Open or create the confirmation batch you want to add the order to. 
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To create a new confirmation batch, choose New from the File menu. In the Batch 
Maintenance dialog, you can accept the batch description or type a new one, then click 
OK. 

To add orders to an existing confirmation batch, choose Open from the File menu. In the 
Batch LookUp dialog, select the batch you want to open, then click OK. 

3. In Warehouse, select the warehouse responsible for shipping the order you are 
confirming. 

4. In Ship Date, select the shipping date you want to assign to all the orders you confirm. 

5. Complete the Orders grid as follows: 

Time is the time the order was added to the confirmation batch. 

Select Confirm for each order you want to confirm when the batch is posted. 

Type displays the type of order you are confirming. 

Document is the number of the order you are confirming. 

Customer displays the customer that placed the order. 

Carrier is the carrier that will deliver the order to the customer. 

Service Code identifies how the carrier will deliver the order. 

Box Count is the number of boxes in the order. 

Picked By identifies the person or department that selected the items included in the 
order. 

Packed By identifies the person or department that packed the items included in the 
order. 

6. If you want to view the manifest, choose Manifest from the Actions menu. 

7. If you want to view the freight charges, choose Freight from the Actions menu. 

8. When you are finished adding orders to the batch and are ready to confirm it, choose 
Confirm from the Actions menu.  
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Printing an Invoice 
Before you can post an invoice, it must be printed. To print an invoice: 

1. Open the Document Print dialog for Order Entry (Transactions>Order Entry>Document 
Print). 

 

2. In the Print group box, select Invoices. 

3. Select any filters that you want to apply. In the sample dialog above, Enspire retrieves 
only those invoices that belong to the West warehouse. 

4. Click Fetch. When you click Fetch the documents that meet your filtering criteria appear 
in the Documents grid. 

5. In the Documents grid, make sure Print is selected for each document you want to print. 

6. If you want to print the selected documents, click Print. If you want to preview the 
selected documents, click Preview. 

Previewing a document allows you to review it onscreen then decide if you want to print a hard 
copy. 

Posting an Invoice 
Posting an invoice updates accounts receivable and customer statistics and creates an A/R open 
item for the customer being invoiced. 
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To post an invoice: 

1. Open the Invoice Post dialog (Transactions>Order Entry>Invoice Post). 

 

2. In Post Invoice On or Before, select the last date for including invoices in the post. All 
invoices with a date earlier than or equal to the date selected here are eligible for posting. 

3. If you want to post only those invoices that belong to a specific warehouse, select it in 
Warehouse. 

4. From the Actions menu, choose Fetch. 

5. In the Invoices grid, make sure Post is selected for each invoice you want to post. 

6. When you are ready to post, choose Post from the actions menu. 
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Document Release 

The Document Release dialog allows you to release the following types of Order Entry documents: 

• Future - A future order is an order that is released at a later date, typically more than 30 days from 
today’s date. Enspire does not commit stock for a future order until it is released. The earliest 
release date for a future order is equal to the longest lead-time for any item on the order plus 
fourteen days. Enspire automatically releases future orders when the day prior to the release date is 
closed. You can release them manually here. When the order is released, Enspire commits the 
stock, if available. 

• Recurring - A recurring order is an order that is shipped on a regular basis, such as daily, weekly, 
or monthly. Use this order when the same items and quantities are shipped for every recurring 
order. Enspire commits stock, if available, when the order is released. 

• Tag & Hold - A tag & hold order is an order that will be picked from stock, placed in a staging 
area, but not immediately shipped. Enspire prints TAG & HOLD instead of the customer address. 
When the order is released, another picking ticket is printed that includes the customer address and 
the staging area where the stock is located. The release date is the date the order should be shipped 
and the cancel date is the date the order should be deleted and stock uncommitted if the order has 
not been released. As part of the close-day process, Enspire indicates which tag and hold orders 
should be released or deleted. 

• Quotes - A quote allows you to provide customers or prospects with pricing and availability 
information. Quotes can include taxes, carriers, shipping charge, and minimum order charges. No 
stock is committed and no documents, such as pick tickets and packing slips, can be generated 
from a quote. 

• ScratchPad - A ScratchPad entry allows you to perform a price and availability inquiry without a 
customer number. You can use a ScratchPad entry to create a potential order or create an actual 
order. If you release a ScratchPad entry that includes a discontinued item, all quantity that can be 
committed to the line will be committed. Any quantity that cannot be committed will be canceled. 
A discontinued item is an item that has a status of X) Sell Qty on Hand Only.  

• Remote - A remote order is an order placed by a customer then released into Enspire. When you 
release remote orders, they are converted to basic sales orders with a status of Entered and 
available stock is committed. 

To release a document: 

1. Open the Document Release dialog (Transactions>Order Entry>Document Release). 
2. In the Release group box, select the type of document you want to release. The available types are 

listed above. 
3. Select the filters, if any, that you want to apply. Filtering is discussed below. 
4. If you selected Recurring in the Release group box, select the Frequency you want to release. 

For example, if you select M) Monthly, only recurring orders set up to be released monthly are 
retrieved when you click Fetch. 

5. If you selected Quotes in the Release group box, select an Earliest Ship Date. This date is the 
earliest ship date assigned to orders generated from the quotes you release. 

6. If you want to retain the quote after you release it, select Keep Quote. Unselect this option if you 
want to delete the quote when the order is created. 

7. If you selected Quotes, ScratchPads, or Remote in the Release group box, select the Order 
Type you want to generate when you release. You can also select D) Customer Default. This 
option uses the customer's default order type. You select this default in the Codes section of the 
Customer ShipTo Locations dialog. 
 
NOTE: If select an order type of D) Customer Default, the ship complete setting for the order 
being released is determined by the Ship Complete setting for the customer in the Controls section 
of the ShipTo Locations dialog. If you select any other order type, then ship complete is set to No 
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for the order, which allows the order to ship if it is not complete.  
 

8. If you selected Quotes, ScratchPads, or Remote in the Release group box, type a Staging Area. 
This area is the staging area for the items on the document you release. 

9. In the Insufficient Quantity group box, select how Enspire handles insufficient quantities.The 
options are: 
 
Backorder puts the items on backorder. If backorders are not allowed, Enspire automatically 
creates a special order. 
 
Special Order creates a special order buy for the item. 
 
Automatically Purchase creates a purchase order for the item. 
  

10. If you want to release vendor requests for quotes, select Release VRQs. 
 
Selecting Release VRQs generates requests for vendor quotes for each line that has a disposition 
of G) VRQ on the documents being released. 
  

11. If you want to create a contract based on the quote, complete the Contract group box. 
 

12. Click Fetch. When you click Fetch, the documents that meet your filtering criteria appear in the 
Documents grid. 
 

13. In the Documents grid, make sure Release is selected for each document you want to release. A 
check mark indicates the document will be released. Click in the box to place the check mark. If 
you want to exclude the document, click in the box again to remove the check mark. 
 
You can also select or unselect all documents in the grid.. 
  

14. Click Release. 

Filtering Order Entry Documents 

Enspire gives you the ability to filter the documents you can select to release. 

• Tag & Hold Order is the number of the Tag & Hold order you want to release. Leave Tag & 
Hold Order blank to release all tag and hold orders.  This field appears only if you select Tag & 
Hold in the Release group box. 

• Begin Release Date is the first date included in the release. If you do not want to retrieve orders 
based on a beginning date, leave Begin Release Date blank. This field appears only if you select 
Future or Recurring in the Release group box. 

• End Release Date is the last date included in the release. If you do not want to retrieve orders 
based on an ending date, leave End Release Date blank. This field appears only if you select 
Future or Recurring in the Release group box. 

• Begin Customer is the first customer included in the release. If you do not want to retrieve orders 
based on a beginning customer number, leave Begin Customer blank. This field appears if you 
select any document except Tag & Hold in the Release group box. 

• End Customer is the last customer included in the release. If you do not want to retrieve orders 
based on an ending customer number, leave End Customer blank. This field appears if you select 
any document except Tag & Hold in the Release group box. 

• Begin Order is the first order included in the release. If you do not want to retrieve orders based 
on a beginning order number, leave Begin Order blank. This field appears only if you select 
Future or Recurring in the Release group box. 
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• End Order is the last order included in the release. If you do not want to retrieve orders based on 
an ending order number, leave End Order blank. This field appears only if you select Future or 
Recurring in the Release group box. 

• Begin Quote is the first quote included in the release. If you do not want to retrieve quotes based 
on a beginning quote number, leave Begin Quote blank.  This field appears only if you select 
Quote in the Release group box. 

• End Quote is the last quote included in the release. If you do not want to retrieve quotes based on 
an ending quote number, leave End Quote blank. This field appears only if you select Quote in 
the Release group box. 

• Begin ScratchPad is the first ScratchPad entry included in the release. If you do not want to 
retrieve ScratchPad entries based on a beginning ScratchPad number, leave Begin ScratchPad 
blank. This field appears only if you select ScratchPad in the Release group box. 

• End ScratchPad is the last Scratchpad included in the release. If you do not want to retrieve 
ScratchPad entries based on an ending Scratchpad number, leave End ScratchPad blank. This 
field appears only if you select ScratchPad in the Release group box. 

• Salesrep allows you to release documents that belong to a specific salesperson. Leave Salesrep 
blank to make available documents that belong to all salespeople. This field appears only if you 
select Quote, ScratchPad, or Remote in the Release group box. 

• Territory allows you to release documents that belong to a specific territory. Leave Territory 
blank to make available documents that belong to all territories. This field appears only if you 
select Quote or Remote in the Release group box. 

• Route allows you to release documents that belong to a specific route. Leave Route blank to make 
available documents that belong to all routes. This field appears only if you select Quote or 
Remote in the Release group box. 

• Warehouse allows you to release documents that belong to a specific warehouse. Leave 
Warehouse blank to make available documents that belong to all warehouses. This field appears 
only if you select ScratchPad or Remote in the Release group box. 
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Point-of-Sale (POS) Deposits 
Direct Invoice Data Flow 

Point-of-Sale Deposits applies a point-of-sale payment to the point-of-sale transaction that 
generated the payment. Posting point-of-sale payments creates a transaction in the Bank Account 
Manager. Posting point-of-sale deposits also  

NOTE: You cannot delete a point-of-sale payment from this dialog. You delete point-of-sale 
payments in the Totals dialog, which is available through Order Entry. 

To post a point-of-sale deposit: 

1. Open the Point-of-Sale deposits dialog (Transactions>Order Entry>Point of Sale Deposits). 
2. If you want to retrieve point-of-sale transactions based on the date they were created, enter a date 

in Post Deposit on or Before. All transactions with a date earlier than or equal to the date selected 
here are eligible for posting. Leave Post Deposit on or Before blank to retrieve all point-of-sale 
transactions that have not had deposits posted for them. 

3. If you want to retrieve point-of-sale deposits for a single warehouse, select it in Warehouse. 
Leave Warehouse blank to retrieve point-of-sale transactions for all warehouses. 

4. From the Actions menu, choose Fetch. 
5. In the Payments grid, make sure Post is selected for each transaction you want to post. A check 

mark indicates the document is included in the posting. Click in the box to place the check mark. 
If you want to exclude the document, click in the box again to remove the check mark. 

6. From the Actions menu, choose Post. 
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Direct Invoice Data Flow 

1. Create an order in Order Entry (Transactions>Order Entry>Order Entry). 
2. Assign the order a Type of E) Direct Invoice, then select a subtype and add the items you want to 

include on the order. 
3. From the Actions menu, choose Totals to open the Totals dialog and remove any holds that apply 

to the order. 
4. In the Payments tab, enter the payment then print a receipt. 
5. Record the deposit in Point-of-Sale Deposits (Transactions>Order Entry>Point of Sales Deposits). 
6. Post the invoice. Posting an invoice updates accounts receivable and customer statistics and 

creates an A/R open item for the customer being invoiced. You post invoices in Invoice Post 
(Transactions>Order Entry>Invoice Post). 

  

RMA Confirmation 
    

Confirming an RMA (return merchandise authorization) generates a credit memo and, if 
applicable, increments available and damaged quantities. You confirm an RMA when it has been 
received in full. 

To confirm an RMA: 

1. Open the RMA Confirmation dialog (Transactions>Order Entry>RMA Confirmation). 
2. If you want to create a new batch, choose New to display the Batch Maintenance dialog. If 

necessary, type a different Batch Description, then click OK. 
3. If you want to open an existing batch, choose Open to display the Batch LookUp dialog. Select 

the batch you want to open, then click OK. 
4. In Warehouse, select the warehouse that received the items being returned. 
5. In Date Received, enter the date the warehouse received the items being returned. 
6. Complete the RMA grid as follows: 

 
 Time is the time the RMA confirmation was created. 
 
 RMA is the RMA being confirmed. 
 
 Customer displays the customer for which you created the RMA being confirmed. 
 
 Carrier is the carrier that returned the items associated with the RMA being confirmed. 
 
 Received By is the person who received the items that were returned. 
 
 Inspected By is the person who inspected the items that were returned. 

7. The Items section lists the items included on the RMA selected in the RMA grid.  To receive an 
item being returned, complete the following  
 
In the Items grid, make sure Receive is selected for each item you want to receive. A check mark 
indicates the item will be received. Click in the box to place the check mark. If you want to 
exclude the item, click in the box again to remove the check mark. 
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 Line is the line on the RMA that the item appears on. 
 
 Type is the item type, such as stocked, nonstocked, or assembly. 
 
 Item is the item being returned. 
 
 Due is the quantity due to be returned. 
   

8. In Received, type the quantity of the item you received. 
 
 UM displays the unit of measure in which you received the item. 
  

9. If you received damaged items, type the damaged quantity in Damaged. The damaged quantity 
you type here is included with, not in addition to, the quantity you typed in Received. For 
example, if you receive 3 items and 2 are damaged, the Received quantity is 3 and the Damaged 
quantity is 2. 
 
 Action determines how you handle the item when or if it is returned. The actions are as follows: 
 
 A) Damaged Item (returned) - The item was damaged and the customer is returning it. 
 
 D) Damaged Credit (not returned) - The item was damaged but the customer is not returning it. 
 
 E) Entry Error (returned) - An entry error resulted in too many items being shipped. The customer 
is returning the surplus. 
 
 P) Picking Error (exchange) - The wrong item was shipped. The customer is returning it in 
exchange for the correct item. 
 
 R) Price Credit (not returned) - The customer was charged an incorrect price and should be 
credited. 
 
 S) Shortage Credit (not returned) - The quantity shipped was less than the quantity invoiced and 
the customer should be credited. 
 
 T) Other Credit (returned) - The item was returned for a miscellaneous reason. 
 
 W) Other Credit (not returned) - The item was not returned. 
 
 Disposition identifies whether the item was returned to stock (K) or returned to the vendor 
through a VRA (V). 
 
 VRA is the number of the VRA used to return the item to the vendor. 
 
 VRA Line is the line on the VRA on which the item appears. 
  

10. If you entered a Damaged Quantity, select a Damage Disposition. The options are K) Return to 
Stock and V) VRA. 

11. If the item is unit controlled or if you want to view the notes associated with the item, complete 
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the required information in the appropriate section of the RMA Confirmation dialog. To display 
the help topic for a section, click the RMA Confirmation Dialog button at the beginning of this 
topic. 

12. When you are ready to confirm the RMA, choose Confirm from the Actions menu. 
 

Entering RMA Unit Control Numbers 
The Unit Control section allows you to provide new control numbers when you confirm an RMA 
that includes lot, serial, weight, or volume controlled items. 

To enter a new control number: 

1. Select the unit controlled item. 
2. Click New. 
3. Complete the Unit Control grid as follows: 

 
 Type is the type of unit control. The options are: L) Lot, S) Serial, V) Volume, and W) Weight. 
 
 Control # is the control number assigned to the item. 
 
 Quantity is the quantity being returned. 
 

RMA Totals dialog 
 

The Totals dialog for RMAs allows you to review the amount of the credit that was generated by 
the RMA. You can also include other amounts to be included in the credit, such as surcharges, 
freight charges, and freight allowances. 

If you are creating a refund for the RMA, the Refunds section allows you to enter the amount of 
the refund. 

Totals Section 

The Document Totals group box displays the various totals for the RMA, including discounts, 
surcharges, freight, and taxes. 

If you want to put the RMA on hold, select On Hold. 

• Line Total displays the total price for all items on the RMA. An item's price appears under Price 
in the Items section of the Customer Returns Entry dialog. 

• Discounts displays the family discount and the bottom line discount totals as well as the amount 
of the instant rebate. To show the discounts, click the plus sign (+) next to Discounts. To hide the 
discounts, click the minus sign (-) next to Discounts. 
 
 Family Discount is the amount of bottom line and line level family discounts. 
 
 Bottom Line is the amount of bottom line and line level price column discounts. 
 
 Instant Rebate is the amount of the instant rebate. 
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• Charges displays the surcharge and restocking fee associated with the RMA. 
• Subtotal displays the subtotal for the RMA. Enspire calculates the subtotal as follows: Line total - 

Discounts + Charges = Subtotal. 
• Freight displays the various freight charges and the freight allowance for the order. 
• Taxes displays the total amount of the taxes for the committed items only or for the entire order. 
• Total displays the total amount of the committed items only or of the entire order. 

The Document Analysis group box displays analysis information such as estimated cost of the 
items on the order, maximum lead time, and rebates associated with the order. 

• Order is the amount of the order. 
• Sale is the actual amount of the sale, including discounts, surcharges, upcharges, and freight. 
• Cost is your cost for the items included on the order. 
• Profit is the amount of profit you earn on this order. 
• Margin is the margin you achieve on this order. 
• Hits displays the number of items and quantities you were able to fill on this order. 
• Fill Rate % is the percentage of items you were able to fill completely for this order. 
• Stock % is the percentage of stocked items included on the order. 
• Stock displays the value of the stocked items included on the order. 
• Miscellaneous % is the percentage of items included on the order that are neither stocked nor 

nonstocked. 
• Miscellaneous displays the value of the items included on the order that are neither stocked nor 

nonstocked. 
• Nonstock % is the percentage of nonstocked items included on the order. 
• Nonstock displays the value of the nonstocked items included on the order. 
• Customer Rebate displays the amount rebated to the customer. 
• Vendor Rebate displays the amount of the rebate you receive from the vendor. 
• Free Goods displays the amount of free goods included in the order. 
• COD Plus is the extra amount included on the order to cover COD plus charges. 

  

Making Cash or Credit Card Point-of-Sale Refunds 
 

The Refunds section of the RMA Totals dialog allows you to make cash or credit card point-of-
sale refunds. If you selected an RMA type of RMA, only credit card refunds are allowed. If you 
selected an RMA type of Direct Credit Memo, cash refunds or credit card refunds are allowed.  

Posting the refund in Point-of-Sale Deposits creates an accounts receivable open item for the 
refund. This open item has a type of R. For information, click Point-of-Sale Deposits. When you 
confirm the RMA, a credit memo is generated that offsets open item generated when the refund 
was posted. 

• Amount displays the amount of the RMA. 
• Amount Due is the amount still owed the customer for the items on the RMA. When you type an 

amount in the Refunds grid, the amount you type is subtracted from the Amount Due. 
• Process begins the process for PC Charge or ICVerify credit card refunds. Clicking Process opens 

the ICVerify Transactions dialog. For information, refer to Setting Up Enspire to Use Credit Card 
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Authorizations in the online help. 
• Settings allows you to set up Enspire to use PC Charge or ICVerify. For information, refer to 

Setting Up Enspire to Use Credit Card Authorizations in the online help. 
The Refunds grid allows you to enter the amount of the point-of-sale payment. Click in the 
Payments grid then press the INSERT key on your keyboard. 

• Method is the type of refund. The methods are 2) Cash and 3) Credit Card. 
• Amount is the amount of the refund. 
• If you selected a Method of Credit Card, complete the credit card information as follows: 

 
 Card Type is is the type of credit card, as established in the Credit Card dialog. 
 
 Card # is the credit card number. 
 
 Authorization # is the credit card authorization number. 
 
 Expires is the date the credit card expires. Enter the date in MMYYYY format, for example 
112006 is November of 2006. 
 
 If you are using PC Charge or ICVerify and need to set up Enspire to use it, click Settings. For 
information, refer to Setting Up Enspire to Use Credit Card Authorizations in the online help. 
 
 CVV2 is the four-digit credit card verification number. 
  

• Paid By is the name of the person who made the payment. 
• Status displays the current status of the refund. 
• Street is the street address of the company receiving the refund. 
• Zip is the zip code of the company receiving the refund. 
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Transfer/Replicate Orders 
    

Transfer/Replicate Orders allows you to create a new document based on an existing document. 
Transferring a document transfers the document from one customer to another. Replicating a 
document retains the document for the original customer and creates a copy of it for a different 
customer. A document must be in Entered or Printed status for it to be transferred or replicated. 

You can transfer or replicate recurring orders, future orders, or quotes. 

NOTE: If you want to transfer a different type of order entry document, such as a basic order or 
an invoice, you can use the Import Items command available from the Order Entry Actions 
menu. For information, click Importing Items into an Order. 

To transfer or replicate a document: 

1. Open the Transfer/Replicate Customer Orders dialog (Transactions>Order 
Entry>Transfer/Replicate Orders). 

2. If you want to transfer the document from one customer to another, select Transfer. 

3. If you want to copy the order, select Replicate. 

4. In Document, select the document you want to transfer or copy. 
 
 ShipTo displays the name, address, and other contact information for the ship-to location 
associated with the customer. 
 
 BillTo displays the name, address, and other contact information for the customer's bill-to 
location.  

5. In Customer, select the customer you are transferring or copying the document to. 

6. In ShipTo, select the customer's ship-to location you are transferring or copying the document 
to. 
 
 ShipTo displays the name, address, and other contact information for the ship-to location. 

BillTo displays the name, address, and other contact information for the customer's 
bill-to location.  

7. From the Actions menu, choose Post. 
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Importing an Item into an Order 

If you have an item or items on one order that you also want to include on a different order, you can import 
those items. 

To import an item into an order: 

1. Open or create the order you want to import items into. 

2. After you complete the header information, such as order type and customer information, choose 
Import Items from the Actions menu. 

3. In the Order Entry Document LookUp dialog, select the document that contains the items you 
want to import then click OK. 

4. Before the items are imported, you have the option of repricing the lines. If you want to reprice the 
items based on the customer you are creating the order for, click Yes when the reprice message 
appears. If you want the prices to remain the same as they are on the document you are importing 
from, click No when the reprice message appears. 

All items on the selected document are imported into the current document. You can then edit or delete any 
of those items and add new items to the order. 
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About this Chapter 
This chapter covers replenishing items and takes you through the purchasing cycle. It also 
discusses the Costulator and special order buys. 

Purchasing Flowchart 
This flowchart shows the general path a purchase order takes from creation through receiving. 
Each of the procedures in the flowchart is discussed in this chapter. 

 

Purchase Order Types 
When you create a purchase order, you can select one of the following types. 

• Basic – This type creates a standard purchase order. Basic is the most common type of 
purchase order. 

• Buyout – This type applies if you are buying out the inventory of a different company. 
Items purchased on a Buyout purchase order are considered StockAid items. 

• Quote – This type creates a quote instead of an actual purchase order. A quote allows you 
to check a vendor’s cost and availability without creating a purchase order. 

• Rework – This type applies if the purchase order contains only items that need to be 
reworked. A reworked item is an item sent to a vendor for servicing and received back as 
a different item. Some examples of services a vendor could perform are: finishing, 
coating, milling, and assembling. 

• Vendor Direct – This type indicates that the vendor will deliver the items on the purchase 
order directly to your customer. 

What the Purchase Order Status Means 
A purchase order’s status identifies where that purchase order is within the purchasing process. 

• C) Closed – This status indicates that the purchase order has been posted and all items 
received or otherwise accounted for. 

• E) Entered – This status indicates that the purchase order has been entered but has not 
been printed or released. 

• P) Printed – This status indicates that the purchase order has been entered and printed, but 
not released. 

• R) Released – This status indicates the purchase order has been sent to the vendor. 

• V) Voided – This status indicates that the purchase order has been voided. 

• W) Worksheet – This status indicates that the purchase order is a worksheet. 

10-2 Getting Started  Version 7.3.2.0 



Purchasing  Costulator 

Costulator 
The Costulator is an extremely valuable tool that considers all factors to determine the lowest cost 
vendor for an item. The vendor with the lowest purchase order cost is not necessarily the vendor 
with the lowest overall cost. Therefore, the Costulator performs an intelligent cost analysis that 
includes contracts, promotions, discounts, rebates, landed cost, and load factors. The Costulator is 
available in Enspire programs where you need to compare vendor costs. For example, in the 
Special Order Buy dialog, the Costulator appears when you select to purchase an item if that item 
has more than one vendor. 

 

The Costulator Details dialog shows you the cost breakdown for the selected vendor. 

 

Replenishing Items 
Even though Enspire gives you the ability to create purchase orders manually, doing so bypasses 
the automatic replenishment capabilities built into the software. To calculate the proper 
replenishment levels, Enspire uses a method of EOQ, Item Class, Min/Max, or Seasonal in 
combination with accepted inventory optimization techniques. 

When you post, the Documents Used in Post dialog appears and lists the purchase orders and 
transfers created or appended when you posted the worksheet. If a purchase order currently exists 
for a vendor selected during replenishment, Enspire appends that purchase order. Enspire appends 
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purchase orders only if they are in Entered status and if they are not tied to another document such 
as a sales order or requisition. For example, if a line on a sales order generates a purchase order, 
the replenishment process will not append that sales order. 

You can then edit purchase orders in PO Entry. For more information, see Editing a Purchase 
Order. 

Service Oriented Replenishment 
On the Inventory tab of the CO Miscellaneous Control File program, the Use Service Oriented 
Replenishment checkbox enables Service Oriented Replenishment at the company level. This 
option will be disabled by default. 

Service Oriented Replenishment, allows calculating the suggested order quantity based on a 
formula to keep the suggested quantity to an optimal value, which will avoid either ordering too 
much or ordering not enough quantities. 

The Service Oriented Replenishment option: 

• applies for the warehouse Items with reorder method as ‘C’ – Class or ‘Q’ – EOQ.  
• will not validate for the item class to be within class 4, rather it will consider items from class 1 to 

class 12. 
• will always override the existing line point based calculations for the items with reorder method as 

C or Q. 
The new Service Oriented Replenishment logic to calculate the suggested order quantity is as 
follows:  

When the value of the Line Point Quantity minus the Net Available Quantity is greater than the 
Enspire Order Quantity then the system will consider the Suggested Order Quantity as the Line 
Point Quantity minus the Net Available Quantity.  Otherwise it will use the Enspire Order 
Quantity as the Suggested Order Quantity.  

Note that the System will not perform any modifications to the Order Quantity on the following 
conditions: 

1. The order quantity is increased by the current backlog for stock orders (S lines). Since X number 
of items are already committed, it makes sense to increase the purchase amount by this quantity so 
that your available stock can be roughly as intended after the immediate fills of open orders during 
receiving. This also ensures that the order quantity is always at least enough to fill the current 
backlog. 

2. The order quantity is decreased by the quantity currently on order for stock purchases (S lines). 
Since X numbers of items are already on order, the system decreases the order quantity by that 
amount to ensure that double-ordering. 
The following built-in “common sense” checks will not be performed on every order quantity 
calculated. The order quantity will not be automatically adjusted accordingly if any of the 
following conditions are encountered. 

1. The recommended order quantity will not exceed the Line Point + Order Quantity.  
2. If the item does not have a defined shelf life, the order quantity never exceeds a 1 year supply. If 

there is a shelf life, the maximum order quantity is the expected amount that will be sold within 
the shelf life of the product. 

3. The order quantity must be at least enough to last for one review cycle based on expected usage. 
4. The order quantity must be at least a two weeks' supply based on expected usage. 
5. The order quantity must be at least equivalent to one “standard pack” as defined in the 

10-4 Getting Started  Version 7.3.2.0 



Purchasing  Replenishing Items 

Item/Vendor record. 
 

Creating a Preliminary Worksheet 
A preliminary worksheet allows you to filter the items you want to replenish. After you create a 
preliminary worksheet, you can autobuy the items or edit the worksheet. 

To create a preliminary replenishment worksheet: 

1. Open the Stocked Items Replenishment dialog (Transactions>Purchase 
Orders>Replenishment). 

 

2. From the File menu, choose New. 

3. Select a Type. When you create a replenishment worksheet, the Type defaults to D) 
Demand Buy, which is the type used in these steps. The types are as follows: 

D) Demand Buy identifies items that appear to be in need of replenishment, based on an 
item’s order point and/or line point. The Demand Buy type is the type typically 
recommended for stock purchases. 

K) Kit Only identifies only stocked kits that need replenishing. 

P) Promo Buy selects all items that meet the specified criteria that are also part 
of a vendor promotion. 

T) Total Review selects all items that meet the specified criteria. A Total 
Review helps ensure that the buyer monitors the status of all items and provides 
greater human control and involvement. 

4. If you want to retrieve only those items that have a review date on or before a 
specific date, select that date in Review Date. 
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The review date determines when Enspire checks the item to see if it should be 
replenished. You set the review date for an item in the Reorder section of the 
Warehouse Item Maintenance dialog. 

5. Select any filters that you want to apply. 

For example, if you select a range of buyers, only items belonging to those 
buyers will be available. If you also type a review date, only items that have a 
review date on or before the date you select, that also belong to the selected 
range of buyers, will be included on the worksheet. 

6. In the Costulator group box, select whether you use the Costulator or the 
primary vendor. If an item is replenished through a transfer, the settings in the 
Costulator group box are ignored. 

If you select Use Primary, Enspire uses an item’s default vendor to replenish 
the item. You select the default vendor for an item in the Vendors section of the 
Item Master dialog. 

If you select Use Costulator, Enspire uses the vendor with the lowest overall 
cost for the item to replenish it. 

7. If you selected Use Costulator and want to apply a tolerance, type the tolerance 
in Tolerance % and/or Tolerance Amount. 

The tolerance you apply determines the point at which you use the cheapest 
vendor instead of the primary vendor for an item. For example, if you set the 
Tolerance Amount to 1, the cheapest vendor’s cost must be at least $1.00 
below the primary vendor’s cost in order for Enspire to use the cheapest vendor. 
If you set the Tolerance % to 3, the cheapest vendor’s cost must be at least 
three percent below the primary vendor’s cost in order for Enspire to use the 
cheapest vendor. To always use the cheapest vendor when you use the 
Costulator, you must set Tolerance % and Tolerance Amount to 0 (zero). 

8. If you want to consider stocked kits in the replenishment, select Include Kits. 
Leaving Include Kits unselected excludes stocked kits from the replenishment 
process. 

9. If you want to identify warehouses that have a surplus, select Include Surplus. 
Identifying the surplus gives you the option of transferring in the items you need 
instead of ordering them from a vendor. Leave Include Surplus unselected if 
you do not want to take into account surplus stock at other warehouses. 

10. If you want to base the replenishment on the line point instead of the order point, 
select Use Line Point. 
 
If you select Use Line Point, Enspire uses the line point for all items included in 
the replenishment. If you want to select individual items for which to use the 
line point, leave Use Line Point unselected, then select Use LP in the Summary 
grid after you fetch the items. Line Point is the quantity that determines when 
you order an item. The line point quantity is calculated by adding the order point 
quantity and the item’s usage during the review cycle. Order Point is the 
quantity that determines when an item needs immediate replenishment. The 
order point quantity is calculated by multiplying the usage rate by the lead time, 
then adding the safety allowance amount. You establish an item’s order point 
and line point in the Reorder section of the Warehouse Item Maintenance dialog. 
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Note:  When the Service Oriented Replenishment option is enabled on the 
Inventory tab of CO Misc Control, then the system will always set the 
replenishment summary option Use LP to True for the items below Line Point.  

11. Click Fetch to retrieve the items that meet your filtering criteria. 

12. Create a replenishment worksheet or autobuy the items. 

For information, see Creating a Replenishment Worksheet and Autobuying 
Items below. 

Creating a Replenishment Worksheet 
You create a replenishment worksheet if you want to edit the preliminary worksheet. You can 
change the quantities, units of measure, or costs, and select the items you want to purchase. If you 
do not need to edit the preliminary worksheet, you can perform an autobuy, as described in 
Autobuying Items later in this chapter. 

To create a replenishment worksheet: 

1. In the Stocked Items Replenishment dialog (Transactions>Purchase 
Orders>Replenishment), create a preliminary worksheet. 

2. Click the Worksheet tab. 

3. A message appears and asks if you are ready to begin editing the worksheet. If you 
are ready, click Yes. If you want to return to the preliminary worksheet, click No. 

4. If necessary, you can edit the following information: 

Buyer is the buyer responsible for purchasing the item. The default buyer, as 
assigned in the Reorder section of the Warehouse Item Maintenance dialog, initially 
appears here. 

Quantity is the quantity that Enspire recommends that you purchase. 

QUM is the item’s quantity unit of measure. 

Unit Cost is the cost per each amount unit of measure. 

AUM is the amount unit of measure. 

5. Select Buy for each item you want to replenish. 

6. Resolve the items that you did not select to replenish. 
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Resolving an item indicates that you do not want to purchase it. To resolve an individual 
item, right click the item. From the menu that appears, select Do Not Buy. To resolve all 
unselected items on the worksheet, right click anywhere in the worksheet. From the menu 
that appears, select Do Not Buy Remaining. 

 

7. From the Actions menu, choose Post. 

Autobuying Items 
When you autobuy items, Enspire creates purchase orders for the recommended quantities. You 
can autobuy all items on the preliminary worksheet or select specific items that you want to 
autobuy. 

To autobuy all items on the preliminary worksheet: 

1. In the Stocked Items Replenishment dialog (Transactions>Purchase 
Orders>Replenishment), create a preliminary worksheet. 

2. From the Actions menu, choose AutoBuy All. 

3. From the Actions menu, choose Post. 

If you want to autobuy most, but not all, of the items on a preliminary worksheet, you can choose 
AutoBuy All then exclude the items you do not want to autobuy. For example, a preliminary 
worksheet includes 100 items and you want to autobuy 95 of them. Instead of selecting the 95 
items you want to purchase, you can autobuy all of them then unselect the five items you do not 
want to purchase. 

To unselect items after choosing AutoBuy All: 

1. From the Actions menu, choose AutoBuy. 

2. Select the item or items that you do not want to autobuy. 

3. Click UnBuy. 

4. Click OK. 

To select the items you want to autobuy: 

1. In the Stocked Items Replenishment dialog (Transactions>Purchase 
Orders>Replenishment), create a preliminary worksheet. 

2. From the Actions menu, choose AutoBuy. 

3. In the Replenishment AutoBuy dialog, select the items or items you want to autobuy. 

4. Click Buy. 
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5. If you selected to autobuy an item, but decide you want to exclude it from the autobuy, 
select that item then click UnBuy. 

6. After you have selected the items you want to autobuy, click OK. 

7. From the Actions menu, choose Post. 

Creating a Special Order Buy 
You create a special order buy when a sales order or requisition includes nonstocked items or 
when a customer does not want to wait for a stocked item to be back ordered. Posting a special 
order buy creates or appends purchase orders to include the items on the special order buy. You 
can then edit those purchase orders in PO Entry. For more information, see Editing a Purchase 
Order. 

To create a special order buy: 

1. Open the Special Order Buy dialog (Transactions>Purchase Orders>Special Order Buy). 

 

2. If you want to create a special order buy for sales orders and/or requisitions that belong to 
a single warehouse, select it in Warehouse. If you want to create a special order buy for 
sales orders and/or requisitions that belong to all warehouses, leave Warehouse blank. 

3. From the Actions menu, choose Fetch. 

4. The items available for the special order buy appear in the Unresolved section. Here you 
can select to use the Costulator or an item’s default vendor. 

5. If you want to use an item’s default vendor instead of selecting a vendor through the 
Costulator, select the item or items you want to purchase then choose Default from the 
Actions menu. When you choose Default, Purchase is  

selected for each item. When you post the special order buy, a purchase order 
will be created or appended to include the item. 
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6. If you want to use the Costulator, click Purchase for the item you want to buy. 

When you click Purchase, the Costulator appears. You can also double click a 
row in the grid to display the Costulator for that item. For information on the 
Costulator, see Costulator earlier in this chapter. 

In the Costulator, select the ` you want to buy the item from then click OK. 
When you click OK, Purchase is selected for the item. When you post the 
special order buy, a purchase order will be created or appended to include the 
item. 

7. If you do not want to buy an item, click Purchase again to unselect it. 

8. After you have selected the item or items you want to purchase, choose Post. 

When you post, the Documents Used in Post dialog appears and lists the purchase orders created 
or appended when you posted the special order buy. If a purchase order currently exists for a 
vendor, Enspire appends that purchase order. Enspire appends purchase orders only if they are in 
Entered status and if they are not tied to another document such as a sales order or requisition. For 
example, if a line on a sales order generates a purchase order, the special order buy process will 
not append that sales order. 

Editing a Purchase Order 
The purchase orders that Enspire creates automatically are available for editing in the Purchase 
Order Entry dialog. Here, you can add or delete items as well as edit the quantities, units of 
measure, and costs. As mentioned earlier in this chapter, you can bypass Enspire’s automatic 
replenishment capabilities to create a purchase order manually. However, this is not recommended 
because Enspire uses proven inventory optimization techniques to calculate automatically the 
proper replenishment levels. 

This section provides instructions on opening a purchase order for editing. For a complete 
description of the Purchase Order Entry dialog, see the Enspire online help. 
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To open and edit a purchase order: 

1. Open the Purchase Order Entry dialog (Transactions>Purchase Orders>PO Entry). 

 

2. From the File menu, choose Open. 

3. In the Purchase Order Document LookUp dialog, select the purchase order you want to 
open then click OK. 

4. When you have finished editing the purchase order, choose Save. 

Creating a Purchase Order Manually 
If you decide to bypass Enspire’s automated replenishment capabilities, you can create a purchase 
order manually. This section provides instructions on creating a purchase order and adding items 
to it. For a complete description of the Purchase Order Entry dialog, see the Enspire online help. 

 

To create a purchase order manually: 

1. Open the Purchase Order Entry dialog (Transactions>Purchase Orders>PO Entry). For an 
example of this dialog, see Editing a Purchase Order above. 

2. Select the Vendor you are creating the purchase order for. 

3. Select the destination Warehouse for the items on the purchase order. 

4. In Doc Type, select the type of purchase order you are creating. The types are: 

B) Basic - This option is for a standard purchase order. 

D) Vendor Direct - This option indicates that the vendor will deliver the items on the 
purchase order directly to your customer. 
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O) Buyout - This option applies if you are buying out the inventory of a different 
company. Items purchased on a Buyout purchase order are considered StockAid items. 

Q) Quote - This option creates a quote instead of an actual purchase order. 

R) Rework - This option applies if the purchase order contains only items that need to be 
reworked. 

5. Accept or change the following purchase order dates. 

Due is the date the items are scheduled to arrive at the selected warehouse. 

Ship By is the date on which the vendor should ship the items on the purchase order. 
After you save the purchase order, you cannot change this date. Any changes to the ship 
by date are reflected in Due. 

Cancels is the date on which the purchase order should be cancelled and considered 
closed if you have not received the items.  

Opened displays the date the purchase order was created. 

Released displays the date you released the purchase order. 

6. Add items to the purchase order. For instructions, see Adding an Item to a Purchase 
Order below. 

Adding an Item to a Purchase Order 

1. Click in the Items grid. 

2. In Item, use the lookup to select an item. 

3. If the destination warehouse for this item is different than the warehouse selected when 
you created the purchase order, select the warehouse in Warehouse. 

4. In Disposition, select the reason you are purchasing the item. 

5. If the selected disposition requires a document number, enter the number in Document. 
For example, if you are purchasing the items to fill a transfer, you provide the number of 
the transfer here. 

6. In Quantity, type the quantity you want to order. 

Back Ordered displays the quantity of the item the vendor had to place on back order. 

Canceled displays the quantity of the item canceled from the purchase order. 

Received displays the quantity of the item you have received. 

7. In QUM, select the item’s quantity unit of measure. 

8. You can accept the Unit Cost or type a new one. 

9. In AUM, select the item’s amount unit of measure. 

10. When you have finished adding items to the purchase order, choose Save. 
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Printing a Purchase Order 
You can print a single purchase order from Purchase Order Entry and you can print one or more 
orders at a time from Document Print. 

To print a purchase order from Purchase Order Entry: 

1. In the Purchase Order Entry dialog (Transactions>Purchase Orders>PO Entry), open the 
purchase order you want to print. 

To open a purchase order, choose Open from the File menu. In the Purchase Order 
Document LookUp dialog, select the purchase order you want to open, then click OK. 

2. From the Actions menu, choose Recap. 

3. In the Recap dialog, choose Print Select from the File menu. 

To print a purchase order from the Document Print dialog: 

1. Open the Document Print dialog for Purchase Orders (Transactions>Purchase 
Orders>Document Print). 

 

2. In the Print group box, select Orders. 

3. Select any filters that you want to apply. In the sample dialog above, Enspire retrieves 
only those purchase orders that belong to the West Warehouse that were also created on 
May 27, 2002. 

4. Click Fetch. When you click Fetch, the documents that meet your filtering criteria appear in the 
Documents grid.  

5. In the Documents grid, make sure that Print is selected for each document you want to print. 

6. If you want to print the selected documents, click Print. If you want to preview the selected 
documents, click Preview. 

Previewing a document allows you to review it onscreen then decide if you want to print a hard 
copy. When you preview a purchase order, it is displayed in the Enspire Report Explorer. 
Previewing a purchase order sets its status to Printed. 
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Releasing a Purchase Order 
You release a purchase order when you are ready to send it to the vendor. Releasing a purchase 
order changes its status to confirmed and makes it ready for receiving. 

To release a purchase order: 

1. Open the Document Release dialog (Transactions>Purchase Orders>Document Release). 

 

2. Select any filters that you want to apply. In the sample dialog above, Enspire retrieves 
purchase orders that belong to the West warehouse, that were created for all vendors with 
vendor numbers between AEA and JMBENT, and that were created on May 27, 2002. 

3. Click Fetch. When you click Fetch, the documents that meet your filtering criteria 
appear in the Documents grid. 

4. In the Documents grid, make sure that Release is selected for each document you want to 
release. 

5. Click Release. 

Receiving a Purchase Order 
Receiving a purchase order replenishes your on-hand quantities and automatically fills 
backordered and special-ordered items. You can receive by purchase order or by individual item. 
When you receive a purchase order, the PO Receipt dialog shows you the items and quantities due 
and allows you to provide the quantity actually received as well as the damaged quantity. If you 
receive less than the quantity due, Enspire automatically creates a back order or cancels the 
remaining quantity. If you receive more than the quantity due, Enspire gives you the option of 
selling it, putting it into StockAid, creating a vendor return authorization, or receiving the excess 
into stock. 

When the purchase order is fully received, its status changes to closed and it becomes available to 
accounts payable. 
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To receive a purchase order: 

1. Open the PO Receipt dialog (Transactions>Purchase Orders>PO Receiving). 

 

2. Create or open the Receipt batch you want to add the purchase order to. 

To add purchase orders to an existing receipt batch, choose Open from the File menu. In 
the Batch LookUp dialog, select the batch you want to open, then click OK. 

To create a new receipt batch, choose New from the File menu. In the Batch Maintenance 
dialog, you can accept the batch description or type a new one, then click OK. 

3. Click in the Receipts grid, then press the INSERT key on your keyboard. 

4. Select a Warehouse. 

5. After you select a warehouse, select a Vendor or a Purchase Order. 

6. Select the Purchase Order or Item that you want to receive. 

7. In Received, type the quantity received. 

8. If you received damaged items, type the damaged quantity in Damaged. The damaged 
quantity you type here is included with, not in addition to, the quantity you typed in 
Received. For example, if you receive 22 items and 6 are damaged, the Received 
quantity is 22 and the Damaged quantity is 6. 

9. If you received excess items, select an Excess Disposition. This field becomes active if 
you type a Received quantity that is greater than the Due quantity. 

10. In the Receiving grid, select Receive for each item you want to receive. To select all 
items, you can choose Receive All from the Actions menu. Receive All is available only 
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if you selected Allow Automatic Purchase/Transfer Receiving in the Inventory section 
of the CO Miscellaneous Control File dialog. 
 
To select to receive an item, click the box under Receive to place a check mark. If you 
want to unselect Receive, click the box again and remove the check mark. To unselect 
Receive for all items, you can choose Clear All from the Actions menu. You can also 
select a “range” of records in a receiving batch by using the shift-click and/or cntrl-click 
keys to multi-select items in the grid.  Under the Actions menu you can select to Receive 
Selected or Clear Selected for the items you selected in the grid. 

11. From the Actions menu, choose Post. 

 

Creating or Editing Vendor Return Authorizations 
    

VRA Entry allows you to create or edit vendor return authorizations. You can also create VRAs 
automatically when you receive damaged items or when you create an RMA or direct credit 
memo. You use a VRA whenever you need to return items to a vendor. 

The steps below show you how to create a VRA. For information on a specific section, click the 
Vendor Return Entry Dialog button. 

To create a VRA: 

1. Open the Vendor Return Entry dialog (Transactions>Purchase Orders>VRA Entry). 
2. From the File menu, choose New. 

 
 To open a VRA, choose Open from the File menu. 
  

3. Select the Vendor you are creating the VRA for. 
 
 Our Account displays your account number as assigned by the vendor. 
  

4. Select a Claim Vendor. 
 
 The claim vendor is responsible for crediting your company for the returned item. Typically, the 
vendor and the claim vendor will be the same. However, in some cases, you may need to select a 
different claim vendor. For example, if an item is damaged during delivery, the carrier may be 
responsible for issuing your company a credit. Therefore, you select that carrier as the claim 
vendor. To be able to select a carrier as a claim vendor, the carrier must first be set up as a vendor. 
  

5. Select the Warehouse that is returning the items. 
6. If the VRA is associated with an RMA, type the RMA number in RMA #. 

 
 Status displays the current status of the VRA. 
 
 Currency is the vendor's currency. 

7. If necessary, you can type a new Exchange Rate. The exchange rate is the multiplier used to 
convert your currency to the vendor's currency. For example, your currency is US dollars and the 
vendor's currency is pesos. If you type 5, then 5 dollars equal 1 peso. If you type .2, then 1 dollar 
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equals 5 pesos. 
8. In Date Opened, enter the date the VRA was created. 

 
 Shipping Date displays the date the items on the VRA will be shipped back to the vendor. 
  

9. If the vendor charges you a percentage of the cost as a restocking fee, enter the percentage in 
Restocking Rate. 

10. In Ship Via, select the carrier that will deliver the items to the vendor. 
11. Select the carrier's Service Code. This code identifies the type of service, such as overnight or 

standard, the carrier provides to return the items. 
12. If applicable, enter the Consignee associated with the VRA. Revision displays the number of 

times the document has been printed. Enspire increments this number each time you print the 
VRA. 

13. Complete the following in the Items section to view the items currently included on the VRA and 
add items. 

• Link UMs ensures that the quantity unit of measure and the amount unit of measure are the 
same. When Link UMs is selected, changing one unit of measure automatically changes the 
other. When Link UMs is not selected, you can change one unit of measure without changing 
the other one. 

• Line is the number of the line on which the item appears on the VRA. 
• Line Type is the type of item you are returning. The types are :N) Nonstocked and S) 

Stocked. 
• Item is the item being returned. 
• Disposition identifies the reason you are returning the item. The options are: 

 
C) Customer Return - This option is used automatically whenever a VRA is created from an 
RMA or a credit memo. 
 
D) Damaged - This option is used if the item is damaged. If there is a quantity damaged for an 
item, that quantity is decreased for each item returned. 
 
I) Wrong Product - Use this option if the vendor ships you the wrong item or an unacceptable 
substitute. 
 
J) Rejected Product - Use this option if an item is rejected because it did not meet quality 
standards or specifications. 
 
U) Surplus Stock - Use this option if the vendor allows you to return surplus stock. 
 
Z) Other - Use this option for a miscellaneous reason for a return. 
  

• Document is the document originally used to acquire the item from the vendor. 
• Line is the number of the line on which the item appears on the document. 
• Quantity is the quantity you are returning. 
• Commit is the quantity on hand that you can actually return. For example, if the VRA is tied 

to an RMA for a customer that is returning four items. If you have only received two of the 
items by the time you create the VRA, the Quantity would be 4 and the Commit would be 2. 

• QUM is the item's quantity unit of measure. 
• Unit Cost is the cost of the item, per unit. Enspire retrieves this cost from your 

purchase order that originally purchased the item. If no purchase order exists, you 
must enter the unit cost. 
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• AOM is the item's amount unit of measure. 
• Amount displays the cost of the items you are returning. 
• Weight displays the weight of the items you are returning. 
• Volume displays the volume of the items you are returning. 
• Restock Fee determines whether the vendor charges you a restocking fee for 

returning the item. Select Restock Fee if the vendor charges you a restocking fee. 
Leave this option unselected if the vendor does not charge you a restocking fee. The 
fee is based on the Restock Rate entered in the Vendor Return section. 

  

VRA Confirmation 
 

You confirm a VRA when you ship the items you are returning. 

To confirm a VRA: 

1. Open the VRA Confirmation dialog (Transactions>Purchase Orders>VRA 
Confirmation). 

2. From the File menu, choose New. 
 
 To open a VRA confirmation, choose Open from the File menu. 
  

3. Select the VRA you are confirming. 
4. In Ship Date, enter the date you ship the items on the VRA back to the vendor. 
5. In Freight, enter the amount of the freight that you are paying. If the vendor is paying the 

freight, leave Freight set to zero. 
6. Select the Carrier that will deliver the items to the vendor. 
7. Select the type of Service that the carrier provides. 
8. Type the carrier's Waybill number. 
9. If you want to put the vendor invoice on hold, select Put on Hold. 

 If Put on Hold is selected, Enspire generates an invoice for the vendor when you post the VRA 
confirmation. That invoice is placed on hold. To change the status from on hold to available, use 
Invoice Corrections (Transactions>Vendor Payables>Invoice Corrections).  

10. The Details section of the Confirm Vendor Direct Purchase Order dialog allows you to confirm 
the items and quantity included on the vendor direct purchase order.  If you do not need to make 
any changes, you simply select Receive.  
 
Otherwise, select Receive after you make your changes to the following: 
 
• Receive determines whether the customer received the items. A check mark indicates that the 

item will be confirmed. Click in the box to place the check mark. If you do not want to 
confirm the item, click in the box again to remove the check mark. 

• Line # is the line on the purchase order on which the item appears. 
• Item is the item number of the item being confirmed. 
• Due is the quantity of the item included on the purchase order. 
• Shipped is the quantity of the item actually shipped to the customer. 
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• BO is the quantity of the item on back order. 
• Canceled is the quantity originally included on the purchase order that you have since 

canceled. 
• QUM is the item's quantity unit of measure. 
• Unit Cost is the cost per item. 
• AUM is the item's amount unit of measure. 
• Link UMs ensures that the quantity unit of measure and the amount unit of measure are the 

same. When Link UMs is selected, changing one unit of measure automatically changes the 
other. When Link UMs is not selected, you can change one unit of measure without changing 
the other one. 

 
11. (Optional)  The Unit Control section allows you to provide new control numbers for unit-

controlled items.  If the item is unit controlled, complete the following.   
 
Select the unit controlled item you want to provide a lot or serial number for. 

Click New. 
 
If the item is lot-controlled, the Unit Control Selection - Lot dialog appears. In Commit, 
type the quantity you want to commit from each Control #. If you can use items from 
more than one lot for this transaction, select OK to Mix. Click OK. 
 
If the item is serial-controlled, the Unit Control Selection - Serial dialog appears. Select 
Commit for each serial number you want to commit to this transaction. Click OK and 
complete the Unit Control Grid.  
Unit Control Grid 

• Type is the type of unit control. The options are: L) Lot, S) Serial, V) Volume, and 
W) Weight. 

• Weight Type determines how the item is weight-controlled. L) Bulk Weight 
means you buy and sell the item according to the weight of the entire lot. S) Piece 
Weight means you buy and sell the item according to the weight of the individual 
items within the lot. 

• Quantity is the quantity of items associated with the control number. If the Type 
is S) Serial, the quantity is 1 and cannot be changed. 

• Weight/Volume is the weight or volume of the item. 
• Control # is the control number assigned to the item. 
• Vendor Control # is the vendor's control number for the item. 
• Bin is the number of the bin where the item is located. 

12. You can save or choose Post to post the VRA Confirmation. If you save without posting, 
you can modify it at a later time.  
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About this Chapter 
This chapter covers the Collections snap-on in Enspire.  Collections allows you to monitor your 
collection efforts. You can set up Enspire users as collectors, create collection letters, and monitor 
your follow-up contacts with customers that have past-due invoices.  

 
The collections data flow is as follows:  

1. Set up collectors, letters, and problems.  

• A collector is an Enspire user who can be assigned to contact customers that have past-
due invoices. You designate users as collectors in Collector (Snap 
Ons>Collections>Collector).  

• Collection letters are letters sent to customers that have past-due invoices. You create 
collection letters in Letters (Snap Ons>Collections>Letters).  

• Problems identify the reasons that an invoice is past due. You add problems in Problems 
(Snap Ons>Collections>Problems).  

2. Follow up past-due invoices.  

• The Follow-up portion of the Collections snap-on allows you to view and update your 
collection history with a given customer. You follow up past-due invoices in Follow-up 
(Snap Ons>Collections>Follow-up).  

 

Collector  
Collector allows you to designate the Enspire users who will serve as collectors for past-due 
invoices. Enspire assigns past-due customers to a collector automatically based on the collector's 
current load of past-due invoices.   
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To add a collector:  

1. Open the Collector dialog (Snap Ons>Collections>Collector).  

 
2. From the File menu, choose New (CTRL+N).  

3. In Title, type the code that identifies this collector.  

4. In Collector, select an Enspire user.  

5. Assign a Start Date. This date is the first date the collector can be assigned a past-due 
invoice.  

6. Select a Status. The status determines whether the collector is:  

A) Active  

I) Inactive  

An active collector can be assigned past-due invoices. An inactive collector cannot be 
assigned past-due invoices.  

7. In $/Minute, type your cost per minute for the collector to try and collect past-due 
invoices. For example, if you pay a collector $10 per hour, your cost per minute would be 
$.17, which is $10 divided by 60 minutes.  

8. Select Collector or Supervisor as the collector’s role.  

9. In Max Instant Adjust, type the maximum amount the collector can adjust an invoice. 
For example, if you want to give the collector the ability to adjust an overdue invoice by 
$100, type 100 here.  

10. If you want to give the collector the ability to change a customer's terms, select Change 
Cust Terms. Leave this option unselected if you do not want the collector to be able to 
change a customer's terms.  

11. If you want the collector to be available to all warehouses, select All Warehouses. If you 
want the collector to be available only to the warehouse assigned in User Profile, leave 
All Warehouses unselected.  

12. Follow-up allows the collection’s administrator to determine whether individual 
collectors are assigned follow-ups.  

Selecting A, Assign Follow-ups, activates the collector.  

Selecting N, No Follow-ups, de-activates the collector.  

13. If you want to have the ability to reassign the collector, select Reassign Collector. Leave 
this option unselected if you do not want to reassign the collector.  

14. From the File menu, choose Save (CTRL+S).  
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Collection Letters  
Letters allows you to create collection letters, assign them to Enspire templates, and determine 
when you want to send the letters. You can also select to include the customer statement when you 
send the letter. In addition to collection letters, Enspire also provides templates for anniversary 
letters. The letter templates are available through the Report Explorer, in the following folder: 
Enspire Standard Reports>Snap Ons Reports>Credit Collection.  

To set up a collection letter:  

1. Open Letters (Snap Ons>Collections>Letters).  

2. From the File menu, choose New (CTRL+N).  

3. In Letter Code, type a code that identifies the letter.  

4. In Letter Name, type a title or description of the letter.  

5. In Doc Code of Letter, select the Report Explorer template you want to assign to the 
letter.  

The letter templates are available through the Report Explorer, in the following folder: 
Enspire Standard Reports>Snap On Reports>Credit Collection.  

6. If you want to include the customer statement when you send this letter, select Attach 
Statement. Leave this option unselected if you do not want to send the statement.  

7. Select a Trigger. The trigger identifies the occurrence that places the letter in the Letter 
Queue section of the Follow-up dialog. The options are:  

A) Anniversary allows you to send letters to customers based on their anniversary date 
of becoming your customer.  

F) First Pay enables you to send letters to customers after they make their first payments.  

I) Inactive permits you to send letters to customers that have been inactive for a given 
number of days.  

N) New Customer makes it possible to send letters to new customers.  

P) Past Due allows you to send letters to customers past due.  

S) Large Sale enables you to send letters to customers who have recently made a large 
purchase from your company.  

8. In Letter Cost, type your cost for sending the letter. For example, this cost can include 
postage, paper, toner, and labor.  

9. Select a Time Frame Code and Time Frame Value. These options determine when a 
letter is added to the Letter Queue section of the Follow-up dialog. For example, if the 
Time Frame Code is Days and the Time Frame Value is 60, this letter is added to the 
Letter Queue section whenever an invoice is 60 days or more past due. The Time Frame 
Codes are:  

A) Amount  

D) Days  

M) Months  

Y) Years  

NOTE: The letter must be in the Cust Letter Setup section of the Follow-up dialog 
before it can be added to the Letter Queue section.  

10. In # Max Send, type the maximum number of times this letter is to be sent to a customer.  

11-4 Getting Started  Version 7.3.2.0 



Collections  Collection Problems 

11. If you want this letter included automatically in the Cust Letter Setup section of the 
Follow-up dialog, select Is Global. Leave this option unselected if you do not want the 
letter to be included automatically. You can add the letter manually if necessary.  

Is Global makes the letter available for all customers. When a customer has a past-due 
invoice and is placed in the Follow-up dialog, global letters are automatically included in 
the Customer Letter Setup section of the Follow-up dialog. If Is Global is not selected, 
you must add the letter to the Cust Letter Setup section for each customer you want to 
send the letter to.   

12. Type the text for the letter.  

You type the letter in the Body of Letter area at the bottom of the Letters dialog. Simply 
click in this area and begin typing.  

NOTE: You can override this text for specific customers in the Customer-Specific Body 
Text area in the Letter Queue section of the Follow-up dialog.  

13. From the File menu, choose Save (CTRL+S).  

 

Collection Problems  
Problems allow you to identify reasons that invoices become past due. You can then assign a 
problem to an invoice during follow-up.  

To add a collection problem:  

1. Open Problems (Snap Ons>Collections>Problems).  

 
2. From the File menu, choose New (CTRL+N).  

3. In Problem Code, type the code that identifies the problem.  

4. In Description, type the description of the problem.  

5. From the File menu, choose Save (CTRL+S).  

 

 

Document Print - Collections  
The Document Print dialog for collections allows you to select the letters you want to print or 
reprint. You can also select to print past-due invoices. If you select to print a letter, that letter 
prints for each customer that is scheduled to receive it.  
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To print letters or past-due invoices:  

1. Open the Document Print dialog (Snap Ons>Collections>Document Print).  

 
2. In the Print group box, select the type of document you want to print. The options are 

Letters and Invoices. If you select Letters, all letters that are currently in the letter queue 
that also meet your filtering criteria will be available for printing. If you select Invoices, 
all invoices that are past due as of the current date that also meet your filtering criteria 
will be available for printing.  

3. Select the filters, if any that you want to apply.  

Collector retrieves only those documents that belong to the selected collector. Leave this 
option blank if you do not want to filter by collector.  

Customer retrieves only those documents that belong to the selected customer. Leave 
this option blank if you do not want to filter by customer.  

Queued Begin Date retrieves documents based on the date they were added to the Letter 
Queue section of the Follow-up dialog. The date you select here is the first date for which 
documents are included. Leave this option blank if you do not want to filter by the 
beginning date.  

Queued End Date retrieves documents based on the date they were added to the Letter 
Queue section of the Follow-up dialog. The date you select here is the last date for which 
documents are included. Leave this option blank if you do not want to filter by the ending 
date.  

Sent Begin Date retrieves documents based on the date they were sent to the customer. 
The date you select here is the first date for which documents are included. Leave this 
option blank if you do not want to filter by the beginning date.  

Sent End Date retrieves documents based on date sent to the customer. The date you 
select here is the last date for which documents are included. Leave this option blank if 
you do not want to filter by the ending date.   

4. From the Actions menu, choose Fetch. When you choose Fetch, the documents that 
meet your filtering criteria appear in the Documents grid.  

5. In the Documents grid, make sure Print is selected for each document you want to print. 
A check mark indicates the document is included in the printing. Click in the box to place 
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the check mark. If you want to exclude the document, click in the box again to remove 
the check mark.  

6. If you want to print the selected documents, choose Print Select (CTRL+P) from the File 
menu. If you want to preview the selected documents, choose Print Preview.  

Follow-up Dialog  
The Follow-up dialog lists the customers that have past due invoices, the collector assigned to 
each customer, a record of the calls made to each customer, and other invoice information. When a 
customer has one or more past-due invoices, that customer is listed in the Follow-up dialog 
automatically. When you select a customer, all of the customer’s invoice history is provided for 
your analysis and action.  

Follow-up Grid  
You click Snap Ons>Collections>Follow-up to display the Collections Follow-up dialog.   

 
This grid contains the customers, assigned to the using collector, that have past-due invoices and 
that are scheduled to be contacted by the next follow-up date. The invoices for the selected 
customer appear in the Overdue Invoices section with the following information:  

• Customer lists the customers that have past-due invoices.  

• AP Contact Name is your contact in the customer's accounts payable department.  

• Next Follow-up is the date the collector will contact the customer again.  

• Promise Date is the date the customer promised to pay by.  

• Promisor is the person who made the promise.  

• Promise Logged is the date the payment promise was made.  

• Collector is the Enspire user who is assigned to the customer as a collector.  
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• Total Owed represents the outstanding balance for each of the customers listed. You may 
sort the data in the follow-up grid by clicking on any of the preceding column headings. 
For instance, if you wish to sort by the largest outstanding amount, click on the Total 
Owed column heading.  

“Current” Customer Follow-up  
At times, you may wish to look up customers that are not delinquent. Documentation and review 
of pre-lien agreements is an excellent example of why you might choose to look-up current 
customers. The following steps describe how to look-up a customer that is current with their 
payments:  

Click in the Follow-up grid and press the INSERT key.  

Use the look-up icon to select the customer you would like to document or evaluate.  

 

Call Diary Grid  
This grid lists the collection calls that were made to the customer.  

• Called is the date of the call.  

• Collector is the collector who made the call.  

• Minutes Spent is the length of time, in minutes, of the call.  

• Call Diary Notes allows you to type notes about the call. The notes that are displayed 
apply to the call selected in the Call Diary grid. To type a note, click in the Call Diary 
Notes area and begin typing.  

Adding a Call to the Call Diary  
1. In the Follow-up dialog (Snap Ons>Collections>Follow-up), select the customer you are 

adding the call for.  

2. Click in the Call Diary grid and press the INSERT key on your keyboard.  

3. In Called, select the date the call was placed.  

4. Select the Collector who placed the call.  
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5. In Minutes Spent, type the length of the call, in minutes.  

Invoices  
The Invoices tab provides a listing of all invoices that have been issued to the selected customer.  

 
• Doc # lists the document number of all invoices.  

• Invoice Date represents the date that each invoice was created.  

• Orig Balance shows the original amount owed  

• Current Balance displays the amount owed at present.  

• Terms shows the credit terms that the purchase was made under.  

• Next Due lists the date at which the next payment is due.  
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Invoice Notes  
The Invoice Notes tab enables you to document issues and thoughts for each invoice.   

 
• Date certifies when the documentation occurred.  

• Collector records the name of the collector making the input.  

• Comments used to document key issues concerning the invoice.  
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Invoice Problems  
The Invoice Problems tab provides you the ability to document disputes or concerns involving 
selected invoices.   

 
• Date documents when the problem was recorded.  

• Problems provides the ability to categorize problems with codes setup within Snap 
Ons>Collections>Problems.  

• Status enables documentation of the problem condition. Available options are  

C - Cancelled  

O - Open  

R - Resolved  

• Collector identifies the collector handling the problem.   

• Assigned To names the individual to who the problem is given to for resolution   

• Comments used to document key issues concerning the invoice problem    

• Corrective Action used to record specific step(s) taken to resolve the problem.  
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Invoice Copies  
Invoice Copies enable you to send a copy of the selected invoice via fax, e-mail or printed copy. 
After clicking the Invoice Copies tab, you must press the INSERT key to activate the dialog.   

 
• Media allows you to select which form of output you would like to use:  

E - Email  

F - Fax  

P - Paper  

• Queued shows the date the invoice copy is initiated  

• Sent Date shows the date the invoice copy was actually sent  

• Collector records the collector who sent the copy  

• Cost documents the cost of distributing the copy  

• Attention enables you to address the invoice copy to a designated individual  

• Auto Gen lets you know if the print is generated automatically  

• Print? executes document processing  
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Address  
The Address section allows you to keep track of the customer's bill-to locations. The bill-to 
addresses apply to the customer selected in the Follow-up grid.  

 
• Effective Date is the date the bill-to location was added to Enspire.  

• Bill To Name is the name of the bill-to location.  

To add a new bill-to address, click in the Bill To grid then press the INSERT key on your 
keyboard. Type an Effective Date and Bill To Name. Double click in the Address area then 
complete the Address dialog, which is described below.  

Address Dialog  

• Address is the customer's address.  

• City is the city where the customer is located.  

• State is the state where the customer is located.  

• Zip is the customer's zip code.  

• Country is the country where the customer is located.  

• Telephone is the customer's telephone number.  

• Fax is the telephone number for the customer's fax machine.  

• Email Address is the customer's e-mail address.  

• Web Address is the customer's internet address.   
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Profile  
The Profile section allows you to provide business and banking information about the customer. 
This information applies to the customer selected in the Follow-up grid. This section is divided as 
follows: Business, Bank, and Timing. To display the information within one of those headings, 
click the plus sign (+). To hide the information, click the minus sign (-).  

 
Business  

• Pay Type identifies how reliable the customer is in making payments.  
The types are as follows: 0) Good, 1) Slow, 2) Temporary Financial Issues, 3) Serious 
Financial Issues, 4) Avoider.  

• Owner is the owner of the customer's business.  

• Business Type is the type of business the customer has.  

• Dun and Bradstreet Rating is the customer's Dun and Bradstreet number.  

• Year Founded is the year the customer's business was started.  

• Employee Count is the number of employees working for the customer.  

• Annual Revenue is the amount of money the customer makes in a year.  

Bank  

• Bank Name is the bank that the customer uses.  

• Bank Contact is your contact at the customer's bank.  

• Bank Phone is the phone number of the customer's bank.  

• Bank Checking Acct # is the customer's checking account number.  

• Avg $ Balance in Checking is the average amount in the customer's checking account.  
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• Bank Savings Account # is the customer’s savings account number.  

• Avg $ Balance in Savings is the average amount in the customer's savings account.  

Timing  

• Call Days establishes the number of days an invoice is past due before Follow-up 
prompts the collector to call.  

• Remind Days sets the number of days at which a pre-defined “reminder” letter will be 
sent if an invoice is past due.  

Collector  

• Collector is the collection person assigned to a particular account.  

Credit Info  
The Credit Info section displays the customer's credit information. This information applies to the 
customer selected in the Follow-up grid. This section is divided as follows: Business and Credit 
Info. To display the information within one of those headings, click the plus sign (+). To hide the 
information, click the minus sign (-). The information displayed under Credit Info is established in 
the Customer Master Maintenance dialog (File Maintenance>Customer>Customer Master).  

 
Business (Bill To)  

• Phone # is the customer’s contact number for billing.  

• Fax # is the customer’s billing fax number.  

Credit Info  

• Credit Limit displays the maximum credit extended to the customer.  

• Finance Charge is the percentage that is charged based on the customer’s overdue 
balance each month.  
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• Credit Hold Days displays the number of days past due at which the customer goes on 
credit hold.  

• Past Due Days is the number of days the customer has had a past-due invoice.  

• Last Pay Days displays the number of days the customer took to pay the last paid 
invoice.  

• Avg Pay Days displays the average number of days the customer takes to pay an invoice. 
To calculate this number, Enspire takes into account the previous average and the 
customer's most recent payment. The calculation is a weighted average where 25 percent 
of the average is based on the most recent payment and 75 percent is based on the 
previous average.  

• Date Last Payment is the date of the customer's most recent payment.  

• Date Review Credit shows the next date on which you will review the customer's credit.  

Letter Queue  
The Letter Queue section allows you to schedule collection letters to send to customers. Only 
letters that are in the Cust Letter Setup section are available to be listed here. This information 
applies to the customer selected in the Follow-up grid.  

 
• Letter Name identifies the letters that are in the queue.  

• Media determines how the letter will be sent.  

• Queued is the date the letter was added to the queue.  

• Sent Date is the date the letter was sent to the customer.  

• Collector is the collector assigned to the customer.  

• Cost is your cost for sending the letter.  

• Attention is the customer contact you are sending the letter to.  
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• Is Auto determines whether the letter was placed in the queue automatically. A letter is 
placed in the queue automatically if Is Global is selected for the letter in the Letters 
dialog. To place a letter in the queue manually, click in the Letter grid and press the 
INSERT key on your keyboard. Select the Letter Code you want to add to the queue.  

• Print allows you to send the letter. Click the printer icon to the print, fax or e-mail.  

Customer-Specific Body Text  

When you set up a collection letter, you include generic text for the letter. This text is included on 
the letter for all customers. However, in some cases, you may want to customize a letter for a 
specific customer. You customize collection letters in the Customer-Specific Body Text area in the 
Letter Queue section. Any text that you type in this area replaces the text in the generic letter. To 
retain the generic letter text, you need to copy it and paste it here. You set up collection letters in 
Letters (Snap Ons>Collections>Letters).  

Cust Letter Setup  
The Cust Letter Setup section identifies the letters to be sent to the customer and determines how 
often they will be sent. If you select Is Global in the Letters dialog when you set up a letter, the 
letter appears in this section automatically when the customer meets letter criteria. To add a letter 
to this section manually, click in the grid and press the INSERT key on your keyboard. Select the 
Letter Code you want to add then complete the grid as described below.  

 
• Letter Code identifies the letter.  

• Time Frame is the time segment, such as days or weeks that determines how often the 
letter will be sent to the customer.  

• Time Frame Value is the number of time segments that determines how often the letter 
will be sent to the customer. For example, if Time Frame is Days and Time Frame Value 
is 7, the letter will be sent every 7 days. If Time Frame is Weeks and Time Frame Value 
is 2, the letter will be sent every 2 weeks.  
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• Max Times to Send is the maximum number of times the letter will be sent to the 
customer. For example, if Time Frame is Days, Time Frame Value is 7, and Max Times 
to Send is 3, the letter will be sent once every 7 days until it has been sent 3 times.  

• Gap Days defines how many days to wait between customer contacts. A Gap Day 
selection of 15 tells Collections to contact the customer every 15 days on late invoices.  

• Last Sent is the date the letter was most recently sent to the customer.  

• # Times Sent is the number of times the letter has been sent to the customer.  

 

References  
The References section identifies the references that will provide information about the customer. 
These references apply to the customer selected in the Follow-up grid. To add a reference, click in 
the Reference grid then press the INSERT key on your keyboard. Complete the reference grid as 
follows:  

 
• Reference Name is the company that is providing the reference.  

• Contact is the specific person that is providing the reference.  

• Requested is the date you requested the reference.  

• Responded is the date the company provided the reference.  

• Ref Cust Acct # is the customer's account number with the company you requested the 
reference from.  

Reference Information  

• Contact Method identifies how you contacted the reference.  

• Date Opened is the date the customer opened an account at the reference's company.  
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• Last Sale to Cust is the date of the reference's most recent sale to the customer.  

• Credit Limit is the customer's credit limit with the reference.  

• High Balance is the amount of the customer's highest balance with the reference.  

• Terms are the customer's terms of sale with the reference.  

• Pay Days is the average number of days it takes the customer to pay the reference.  

• Now Owes is the current amount the customer owes the reference.  

• Past Due is the amount that the customer owes the reference that is past due.  

• Customer Related Demographics displays the reference's address and other contact 
information. To add or edit this information, double click in the Customer Related 
Demographics area then complete the Address dialog.  

Address Dialog  

• Address is the reference's address.  

• City is the city where the reference is located.  

• State is the state where the reference is located.  

• Zip is the reference's zip code.  

• Country is the country where the reference is located.  

• Telephone is the reference's telephone number.  

• Fax is the telephone number for the reference's fax machine.  

• Email Address is the reference's e-mail address.  

• Web Address is the reference's internet address.  
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Statistics  
The Statistics section displays communication, sales, profit and past-due information for the 
customer. This information applies to the customer selected in the Follow-up grid.  

 
Accounting  

• Period is the accounting period that the information is displayed for.  

• Year is the accounting year that the information is displayed for.  

Communications  

• # Calls Made is the number of collection calls made to the customer during the period.  

• # Letters Sent is the number of collection letters sent to the customer during the period.  

Sales Rank  

• Period lists the customer's ranking in terms of sales volume for the period.  

• 3 Months lists the customer's ranking in terms of sales volume during the previous three 
months.  

• 12 Months lists the customer's ranking in terms of sales volume during the previous 12 
months.  

Profit Rank  

• Period lists the customer's ranking in terms of profit for the period.  

• 3 Months lists the customer's ranking in terms of profit during the previous three months.  

• 12 Months lists the customer's ranking in terms of profit during the previous 12 months.  

$ Past Due  

NOTE: Aging levels determine how Enspire ages invoices and when the invoices are considered 
past due. In the descriptions below, 1-30 represents aging level 1, 31-60 represents aging level 2, 
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61-90 represents aging level 3, and 90+ represents invoices that are beyond aging level 3. Aging 
levels are established in the Company section of the CO Miscellaneous Control File dialog.  

• 1-30 displays the amount of overdue invoices that are between 1 and 30 days past due.  

• 31-60 displays the amount of overdue invoices that are between 31 and 60 days past due.  

• 61-90 displays the amount of overdue invoices that are between 61 and 90 days past due.  

• Over 90 displays the amount of overdue invoices that are over 90 days past due.  

• Avg Pay is the average number of days it takes the customer to pay you.  

• # Overdue is the number of past-due invoices that occurred during the period.  

 

Aging  
The Aging section displays the current and past due open items for the selected customer.  

NOTE: Aging levels determine how Enspire ages invoices and when the invoices are considered 
past due. In the descriptions below, 1-30 represents aging level 1, 31-60 represents aging level 2, 
61-90 represents aging level 3, and 90+ represents invoices that are beyond aging level 3. Aging 
levels are established in the Company section of the CO Miscellaneous Control File dialog.  

 
• Type identifies the open item as an I-Invoice, C-Credit Memo, D-Debit Memo, O-On 
Account, B-Balance Forward, or F-Finance Charge.  

• Invoice displays the number of the open item.  

• Invoice Date shows the date that the invoice was originally posted.   

• Due Date is the date the open item is due.  

• * provides additional information about the status of the open item.  
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A dash (-) indicates that the item is being disputed. Aging is stopped until the dispute is 
resolved.  

i indicates that the invoice or debit memo includes installment or split payment terms.  

p indicates that a partial payment was applied to the open item.  

a indicates an adjustment or payment was applied to the open item.  

c indicates that the invoice or debit memo includes COD payment terms.  

• 1-44 displays the amount of the open item that is current.  

• 45-66 displays the amount of the open item that is between 45 and 66 days past due.  

• 67-99 displays the amount of the open item that is between 67 and 99 days past due.  

• 100+ displays the amount of the open item that is over 100 days past due.  

Kardex  
The Kardex section displays the invoice and payment history for the selected customer. For 
example, if you want to see the customer purchase order number tied to a specific invoice, you can 
display the Kardex.  

 
Filtering Kardex Information  

The filtering option you select determines the transactions that appear. Enspire gives you the 
option of filtering the transactions that appear in the Kardex. Filtering allows you to determine the 
number of transactions that appear.  

You can filter by the transaction date or by the number of transactions:  

• To filter by the number of transactions, select Transactions then type the number of 
transactions you want to view. For example, if you type 50, the Kardex displays the 50 
most recent transactions.  
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• To filter by transaction date, select Start Date then select a date. For example, if you enter 
a date of March 2, 2003, the Kardex displays all transactions that occurred between 
March 2, 2003, and the current date. Regardless of the filter criteria selected, the 
following information categories are displayed for your analysis.  

Date displays the date and time the batch that contains the document was created.  

User is the Enspire user who generated the batch.  

Batch is the batch that included the document associated with the order.  

Type is the type of document.  

PO # is the number of the customer purchase order used to place the original order.  

Document lists the invoices that belong to the selected customer.  

Doc Date is the date the document was created.  

Check is the number of the check used to pay the invoice.  

Amount is the amount of the check.  

Balance is the remaining balance of the document.  

Orig Order # is the number of the order that generated the invoice that is now past-due.  

History  
The History section displays historical information for the customer for the current and previous 
year. The History section includes the Sales, Service, and Documents dialogs, which are discussed 
below.  

 
Sales  

• This Year displays sales information for the current year. Last Year displays sales 
information for the previous year.  
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• Period lists each of your accounting periods.  

• Sales is the amount of sales to the customer during this period.  

• Cost is your cost for the items sold to the customer during this period.  

• Profit is the profit your company earned on sales to the customer during this period.  

• %Margin is the margin you achieved on sales to the customer during this period.  

Service  

This Year displays hits, misses, and other service information for the current year. Last Year 
displays hits, misses, and other service information for the previous year.  

 
• Period lists each of your company’s accounting periods.  

• Hits display the number of lines on all orders from the customer during this period.  
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• Misses displays the number of order lines during this period that you could not 
completely fill and ship as the customer requested.  

• % Service is the service level percentage. To calculate this percentage, Enspire divides 
the number of order lines that were filled and shipped as requested by the number of hits. 
For example, out of 200 order lines, you filled and shipped 190 as requested. The service 
level is 95 percent.  

• Late displays the percentage or number of order lines you could not completely fill and 
ship as requested because you did not meet the order ship date. Click in this field to 
toggle between the number and percentage.  

• Sub displays the percentage or number of order lines you could not completely fill and 
ship as requested because a substitute item was used. Click in this field to toggle between 
the number and percentage.  

• Partial displays the percentage or number of order lines you could not completely fill 
and ship as requested because some of the items were backordered. Click in this field to 
toggle between the number and percentage.  

• Lead displays the average lead time in days for items included on orders for the customer 
during this period.  

Documents  

This Year displays the number of documents for the current year. Last Year displays the number 
of documents for the previous year.  

 
• Period lists each of your company’s accounting periods.  

• Invoices are the number of invoices for the customer during this period.  

• C/Ms is the number of credit memos issued to the customer during this period.  

• Checks is the number of checks received from the customer and applied during this 
period.  

• NSFs is the number of insufficient fund checks received from the customer during this 
period.  
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• Adjusts is the number of accounts receivable adjustments made to the customer during 
this period.  

• D/Ms is the number of debit memos issued to the customer during this period.  

Overriding Collection Letter Text  
When you set up a collection letter, you include generic text for the letter. This text is included on 
the letter for all customers. However, in some cases, you may want to customize a letter for a 
specific customer.  

You customize collection letters in the Customer-Specific Body Text area in the Letter Queue 
section of the Follow-up dialog. Any text that you type in this area replaces the text in the generic 
letter.  
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Glossary  
A/P Adjustment Performed on open payables to handle discrepancies, such as an 

incorrect amount entered for an invoice. 

A/R Adjustment Used to adjust open customer invoices, on-account balances, finance 
charges, credit, and debits. 

Account Set A group of general ledger accounts that records item transactions. 
The number of account sets you have depends on the level of detail 
you want in your general ledger reporting. The fewer account sets 
you have, the less detailed your general ledger reporting capability. 

Account Type The type of general ledger account: balance sheet, profit and loss, 
and memo. 

Actual Cost The cost of an item as determined by your company’s inventory 
costing method. 

Adjustments See A/P Adjustment, A/R Adjustment, APC Rebate, Commission 
Adjustment, Quantity Adjustment, StockAid Adjustment, and Usage 
Adjustment. 

Amount UM The unit of measure used to display an item’s unit prices and costs. 

APC Rebate Accumulated purchase credits.  

Assembly Order A document and the resulting transactions that are used to assemble 
kits. 

Autobuy Automatically purchases the recommended quantities of the selected 
items on a preliminary replenishment worksheet. 

Autofill Automatically fills backordered items and special-ordered items 
when they are received. Special-ordered items are filled immediately. 
Backordered items are autofilled only if you received enough 
quantity to fill all backorders for the item. Otherwise, you must 
manually fill the backorders. 

Automatic Automatically uses the substitute or upgrade item in place of an item 
on an order. The information for the item you select as a substitute or 
upgrade appears on the order documents. 

Backorder Occurs when you do not have enough quantity on-hand to fill an 
order for a stocked item. 

Basic Order A one-time order that should be shipped and invoiced as soon as 
possible. 
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Blanket Order A single order that is shipped at regular intervals over a definite time 
period, for example, an order for 5,000 items that are shipped weekly 
500 at a time for 10 weeks. 

Blind Shipment An order that you ship directly to your customer’s customer. The 
order looks like it was shipped by your customer instead of by your 
company. 

Blind Uses the substitute or upgrade item in place of an item on an order. 
The information for the original item, not the substitute or upgrade 
item, appears on the order documents. 

Broker A company or individual that serves as a go-betweens for your 
company and foreign vendors. 

BTO Assembly A build-to-order kit that must be shipped as a complete kit. 

BTO Kit A combination of inventory items that can have variable components 
and/or component quantities. A BTO kit does not have to ship 
complete. 

Chart of Accounts Defines and maintains all of the general ledger accounts in Enspire. 

Click Pressing and releasing the left mouse button. 

Commission Adj An adjustment that changes or splits the amount of the original 
commission. Enspire provides two methods for adjusting sales 
commissions, correction and split. 

Commission Plan Establishes the parameters for calculating salesperson commissions. 

Consignment Items that you add to inventory, but you do not pay the vendor until 
they are sold. 

Costulator An intelligent cost analysis tool that compares contracts, promotions, 
discounts, rebates, landed cost, and load factors to determine the 
vendor with the lowest overall cost. 

Credit Memo Used to issue credits to customers. 

Cross-reference See Customer Cross-reference and Item Cross-reference. 

Customer Cross-reference The name the customer calls itself. For example, the customer’s legal 
name is Triple J Construction. However, when someone from the 
company calls to place an order, the caller identifies the company as 
JJJ. Having JJJ as the cross-reference name gives you the ability to 
search for the customer by either Triple J Construction or JJJ. 

Customer Rebate An incentive you offer your customers for purchasing specific items. 

Debit Memo Used to debit customer accounts. 

Default Vendor The main vendor for an item. 

Dialog The term used to identify the screen, for example the Item Master 
dialog. 

Double click Pressing and releasing the left mouse button twice. 
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Drag Holding down the mouse button as you move the mouse pointer to 
the desired position. 

Dropship Order An order that will ship from a warehouse location other than the 
warehouse assigned to the customer. 

Events A message that Enspire generates automatically when certain 
processes occur. 

Family Pricing Grants discounts based on the price, units, weight, or volume of 
items on an order that belong to the same family. Family discounts 
are applied after any other pricing method for an individual item. See 
also: Vendor Family Pricing. 

Fill Rate The percentage of items you were able to fill completely for a given 
order. 

Financial Ratio See Ratio. 

Frozen Item An item that is excluded from replenishment calculations. However, 
the item still appears on replenishment worksheets and all purchasing 
functionally still applies to the item. 

Future Order An order that is released at a later date, typically more than 30 days 
from the current date. 

Group Box A collection of related options within a dialog. 

Hits The number of lines on all orders for a given customer that were 
completely filled and shipped on time during a given period. 

Interchange See Customer Cross-reference and Item Cross-reference. 

Item Cross-reference Allows you to cross-reference an item number that is not in Enspire 
with one that is. For example, if customers routinely order some 
items by the manufacturer’s item numbers, you can use the 
manufacturer’s numbers as a cross-reference to your numbers. 

Item Movement Class Identifies item turnover rates for calculating replenishment 
quantities. 

Item Quantity Tables Establish different pricing levels based on the quantity the customer 
purchases. 

Journal A record of current transactions that allows you to group specific 
types of Enspire transactions. See also Manual Journal and Reserved 
Journal. 

K Cost The cost of carrying items in stock. 

Kits See BTO Kit, BTO Assembly, and Stocked Kit. 

Landed Cost The total cost of receiving an item, including: the unit cost of the 
item, freight, tariffs, brokerage fees, and any user-defined landed 
costs. 
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Line Point The quantity that determines when you order an item. The line point 
quantity is calculated by adding the order point quantity and the 
item’s usage during the review cycle. 

List Price The price you charge for an item. 

Manual Fill Allows you to select the backorders and special orders that are filled. 
See also: Autofill. 

Manual Journal Journals you create to handle specific transactions not covered by the 
reserved journals. You must create at least one manual journal before 
you can set up a recurring journal entry. 

Master Kit Serves as the primary source for all of a kit’s components, except for 
the variable component or components. Selecting a master kit 
automatically assigns its components to the kit you are creating. 

Misses The number of order lines during a given period that you could not 
completely fill and ship as the customer requested. 

Movement Classes See Item Movement Classes. 

Next Cost The replacement cost of the item, based on the most recent purchase. 

Order See Sales Order. 

Order Point The quantity that determines when an item needs immediate 
replenishment. The order point quantity is calculated by multiplying 
the usage rate by the lead time, then adding the safety allowance 
amount. 

OrderPad A template for customer orders. You can then modify a template to 
accommodate a specific order. 

Pay-from Customer A company that is responsible for processing payables for one or 
more of your customers. Using pay-from customers enables you to 
consolidate the billing for various subsidiary companies into a single 
pay-from account. 

Price Columns A method of calculating item pricing based on cost, price, or margin. 

Pricing Contract Provides specific pricing to a customer based on the items that are 
purchased. To calculate contract prices, you can use a quantity table 
or a pricing formula, or you can establish a specific price for the 
item. 

Primary Vendor See Default Vendor. 

Product Group A collection of items that allows you to group items for sales analysis 
and gives you the ability to simplify various functions in Enspire, 
such as item pricing and creating contracts. 

Profit Center A location within your business, such as a warehouse, for which 
general ledger accounts are tracked separately. 

Promotional Item Temporary price or cost changes on a selected item. Price 
promotions are your price incentives offered to your customers. Cost 
promotions are incentives offered by a vendor to your company. 

12-4 Getting Started  Version 7.3.2.0 



    Glossary 

PSR Number Price Service Reference number. It allows you to use the Trade 
Services Price File Maintenance Service to update the item records. 

Quantity Adjustment Used to adjust item quantities, including damaged quantity, on-hand 
quantity, and quantity on order. 

Quantity Contract A means of tracking customer purchase quantities. Quantity contracts 
do not influence pricing or quantity breaks. You use customer 
quantity contracts when a customer agrees to purchase a given 
quantity of certain items during a specific time frame. 

Quantity UM The unit of measure in which you order and/or sell an item. 

Quote In order entry, a quote allows you to provide customers or prospects 
with pricing and availability information without committing stock or 
generating order entry documents such as pick tickets or packing 
slips. In purchasing, a quote allows you to check a vendor’s cost and 
availability without creating a purchase order. 

R Cost The percentage used to calculate the cost of reordering items in 
stock. 

Ratio Allows you to track and measure your company’s liquidity, leverage, 
resource activity, and profitability. You can then compare your ratios 
to industry standards and recommendations to see how your 
company is performing. 

Reason Codes A/P reason codes allow you to track and analyze the reasons for 
accounts payable adjustments and determine the default general 
ledger account when you enter adjustments. A/R reason codes allow 
you to track and analyze the reasons for accounts receivable 
adjustments, credit memos, and debit memos. Adjustment reason 
codes also determine the default general ledger account when you 
enter adjustments. 

Rebates See Customer Rebates and Vendor Rebates. 

Recurring Journal Entry A journal entry that you make on a regular basis, such as monthly, 
bi-monthly, quarterly, semi-annually, or annually. Each period, 
Enspire automatically records the recurring journal entries in the 
appropriate journal. You can add a recurring journal entry only to 
manual journals. 

Recurring Order An order that is shipped on a regular basis, such as daily, weekly, or 
monthly. Use this order when the same items and quantities are 
shipped for every recurring order. 

Reference Price A price you assign to an item. Some examples of using the reference 
price are as a basis for calculating contract prices or as an 
informational price included on invoices or pick tickets. 

Replenishment Path Identifies the primary source of replenishment for stocked items. 

Reserved Item A special circumstance where a predetermined quantity of a specific 
item is reserved for a specific customer. 

Reserved Journal Reserved for automatic journal entries. They are provided with 
Enspire and cannot be modified or deleted. 
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Restriction Allows you to limit the items your customers purchase based on 
vendor, manufacturer, the actual item, product group, and/or country. 
You can set up restrictions to include or exclude the designated 
items. 

Review Cycle Determines how often Enspire checks an item to see if it should be 
replenished. 

Rework An item sent to a vendor for servicing and received back as a 
different item. Some examples of services a vendor could perform 
are: finishing, coating, milling, and assembling. 

Right Click Pressing and releasing the right mouse button. In most cases, right 
clicking displays a menu. 

RMA Return Merchandise Authorization. A document used when a 
customer returns items to your company. 

Route The shipping route for an internal carrier. 

SAF code Indicates the source from which funds were acquired and how the 
funds were used. 

Safety Stock The quantity that you want to keep on hand as a precaution against 
running out of the item. 

Sales Order A request for goods and/or services that a customer places with your 
company. 

ScratchPad An order entry function that allows you to perform a price and 
availability inquiry without a customer number. You can use a 
ScratchPad entry to create a potential order or create an actual order. 

Service Code Identifies the type of service, such as overnight or next-day air, that a 
carrier provides. 

Ship Complete Order A basic order with an additional requirement that all items on the 
order must ship at the same time. 

Ship-to Locations Defines the location or locations where you deliver items and/or 
services to a customer. 

SIC code Standard Industrial Codes. A standard method of classifying 
industries. 

SKU (stock keeping unit) Typically the lowest unit of measure for the item. Enspire uses it 
when you enter physical counts and to display all inventory 
quantities. Enspire also uses the SKU unit of measure to store all 
costs, prices, and quantities for the item. 

Source Code User-defined method for tracking customer and order information. 
You can use source codes to see how a prospect became a customer 
as well as determine the effectiveness of your advertising. 

Special Order Buy Allows you to create purchase orders for unresolved orders, which 
are non-stocked items and items that have not been assigned a 
purchase order. 
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Standard Cost A cost field in an item record that is typically used to identify what 
the item should cost. It can be used for inventory valuation, costing, 
calculating commissions, and other calculations throughout Enspire. 
Standard cost is a static value that is not updated by purchasing 
activities. 

StockAid Adjustment Used to adjust items in StockAid. 

StockAid A special category of inventory items that helps you maximize the 
return on those items. StockAid items can include one-of-a-kind 
items, special purchases, returned items, close-outs, unsold special 
orders, damaged goods, and refurbished items. The items received 
into StockAid do not fit the typical sales, purchasing, and inventory 
management processes. 

Stocked Item An item that is stocked at at least one of your warehouses. 

Stocked Kit A kit that is assembled from a predefined, fixed set of component 
items and is always priced and sold as a complete kit. However, you 
can sell the components separately. Unlike BTO kits, stocked kits are 
actual inventory items for which Enspire tracks the quantity available 
and order backlog. 

Substitute An alternate item included on an order if the item the customer wants 
is unavailable. See also Automatic Substitution, Blind Substitution, 
and Traditional Substitution. 

Summary Billing Combines all open invoices into one summary invoice for the 
customer. 

Tag & Hold Order An order that will be picked from stock, placed in a staging area, but 
not immediately shipped. 

TagAlong Items or comments that are associated with the selected item. Tag 
Along items appear on the screen when you type the number of the 
item with which they are associated. 

Terms Code Identifies the terms of sale that you have with your customers and 
that your vendors have with your company. Examples of terms of 
sale are installment, proximo, and COD. 

Territory A form of sales analysis that allows you to examine sales by regions 
or territories. 

Traditional Allows you to use a substitute or upgrade item in place of an item on 
an order when the available quantity of that item is insufficient. The 
information for the substitute item, not the original item, appears on 
the order documents. 

Transfer See Warehouse Transfer. 

Turnover Rate The frequency with which you sell your inventory. 

Type Codes Customer codes that you can use for sales analysis. Type codes are 
similar to SIC codes and give you the additional flexibility of being 
able to establish user-defined categories. 

UDF (user defined field) Fields that you define and assign valid options to. 
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Units of Measure (UM) Identifies how an item is stocked, purchased, and sold. See also SKU 
Unit of Measure, Amount Unit of Measure, and Quantity Unit of 
Measure. 

Upgrade A superior, more expensive item included on an order if the item the 
customer wants is unavailable. See also Automatic Substitution, 
Blind Substitution, and Traditional Substitution. 

Usage Adjustment Used to adjust your item usage to provide more accurate purchasing 
information. 

Usage Rate The quantity of the item you used or sold during the period. 

Vendor Cost Contract Defines special costs for any or all of the items that vendor sells. You 
can use a vendor contract to assign pricing to individual items, all 
items within a vendor family, or all items within a product group. 

Vendor Cost Tables Establish different cost levels based on the quantity you purchase 
from a vendor. 

Vendor Direct A purchase order where the vendor will deliver the items on the 
purchase order directly to your customer. 

Vendor Family A collection of items that the vendor has grouped together to 
determine quantity discounts. 

Vendor Rebate An incentive your vendors offer you for purchasing specific items. 

VRA Vendor Return Authorization. A document used when you return 
items to a vendor. 

VRQ Vendor Request for Quotation. Used to request cost quotes from a 
vendor. 

Warehouse Transfer A transaction that initiates and controls the movement of items 
between warehouses. 

Warehouse Identifies your company’s stocking and shipping locations. 

Will Call Order An order that the customer will pick up at your location. 

Work Order See Assembly Order. 

X-Ref See Customer Cross-reference and Item Cross-reference. 
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